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About the Textbook

This textbook introduces students to the essential tools of quality improvement. The
emphasis is placed on health care informatics, as reflected in the several examples con-
tained in the text. The book is written to be accessible to any student in the areas of
health information management, health care informatics, and health care industrial engi-
neering. Although having some statistical background would be a plus, such knowledge
is not a prerequisite to understanding and applying the tools presented here. Several
How-To sections are included to demonstrate the hands-on implementation of the dis-
cussed concepts using software such as Minitab, Visio, and Excel.

The textbook starts with Module 1, which introduces the general concepts of quality
and improvement frameworks. Module 2 discusses tools for identifying opportunities for
improvement. Module 3 reviews tools for collecting and aggregating data. Module 4
discusses statistical and graphical tools for assessing the variability and capability of the
process. Module 5 appraises graphical and analytical tools for evaluating relationships in
the data. Module 6 presents tools for assessing the causes and risks of quality problems.
Module 7 introduces tools for benchmarking quality from different processes. Module 8
reviews tools typically utilized to improve quality. Module 9 considers tools for monitoring
and controlling a process. The Appendix presents factors for constructing variable control
charts.

This textbook is not meant to be a comprehensive manuscript of all aspects of quality
improvement. Instructors and students can supplement the module reading with addi-
tional resources such as those referenced in the bibliography section of this text. The
reader is also encouraged to consult a complementary textbook by the same author,
titled Applications of Control Charts for Quality Improvement in Health Care.
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MODULE 1

Key Concepts of Quality Improvement

In this module, we introduce the general concepts of quality improve-
ment. We start by defining the term "quality" and then examine conven-
tional approaches for assessing and improving the quality of products
and services. We place particular emphasis on the notions of quality
improvement in health care informatics.

Key concepts and tools: Quality; Variability; Health care; Health care informatics;
Donabedian’s model; Quality improvement; PDCA cycle; DMAIC framework; Lean-
six sigma; Statistical process control; Quality costs; Managerial support

Major objectives
After studying this module, you will be able to:

1. Define quality

2. Describe the general dimensions of quality

3. Determine the dimensions of data quality

4. Explain Donabedian’s model of quality

5. Identify the source of quality problems

6. Discuss quality improvement methods

7. Contrast quality and process improvement

8. Appraise quality costs

9. Advocate for managerial support of quality improvement initiatives

10. Explain the history of quality improvement

11



12 1.1. Introduction

1.1 Introduction

We dedicate this module to the discussion of the word “quality”, and attempt to explain
what we mean when say “quality improvement." Here, we present general concepts. In
later modules, we will review specific aspects of quality and will learn to utilize standard
tools of quality improvement.

1.2 What is quality?

The word “quality” is a broad term that carries different meanings depending on the con-
text. We can think of quality as the degree of meeting a particular dimension or stan-
dard, with little variability. We establish the relationship between quality and variability
in Definition 1.1.

Definition 1.1 (Quality)
Quality inversely relates to variability around the standard [43].

1.3 Measuring quality

Following Definition 1.1, we can measure the quality of a product or service on the scale
of meeting the set standards or well-defined dimensions. In general, the more variable a
product or service, the less likely it will be of good quality.

1.3.1 Dimensions of product quality

A “quality product” is expected to be highly rated in all of the dimensions highlighted in
BOX 1.1 [23, 43]:

1.3.2 Dimensions of service quality

The dimensions of “service quality” are not as well defined as those of a quality product.
Box 1.2 delineates general features that we use to judge quality in typical services (e.g.,
retail, banking, etc.).

1.3.3 Dimensions of health care quality

For health care services, we can apply the general dimensions of service quality in BOX
1.2 to evaluate administrative services such as patient registration, billing, bed manage-
ment, and others. But, we cannot easily apply these dimensions to measure the quality
of medical care. For example, we would have difficulties measuring the reliability di-
mension, since, in most cases, we (patients) lack the technical knowledge to determine
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Box 1.1 Dimensions of product quality

1. Performance: Will the product do the intended job?

2. Reliability: How often will the product fail?

3. Durability: How long will the product last?

4. Serviceability: How easily is the product fixed?

5. Aesthetics: What is the visual appeal of the product?

6. Features: What more can the product do?

7. Perceived quality: What is the reputation of the product or the company?

8. Conformance to standards: Is the product made as the designer intended?

the accuracy of care that we receive. This phenomenon is commonly known as infor-
mation asymmetry.1 Even for experts, the task of measuring the quality of health care
is a daunting one given several factors to consider, including social, legal, psychologi-
cal, behavioral, economic, and technological effects on the quality of care [6]. One of
the commonly accepted methods for assessing health care quality is the Donabedian’s
Structure-Process-Outcome model depicted in Figure 1.1.

Figure 1.1: Donabedian’s Structure-Process-Outcome model for measuring health care
quality

Structure Process Outcome

At the structure level of Donabedian’s paradigm, we measure the efficacy of re-
sources and administrative processes used to provide medical care. At the process
level, we evaluate the degree to which the applied medical standards are state-of-the-
art. At the outcome level, we measure the result of care, such as the patient’s health
status and satisfaction [20]. Specific quality measures that relate to different levels of the
Donabedian’s model can be found at the websites of the Joint Commission [18] and the
Centers for Medicare and Medicaid Services (CMS) [17].

1Information asymmetry in health care is the state of knowledge where patients know less about the
medical care they buy than the providers of it [22, 10, 11, 55]
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Box 1.2 Dimensions of service quality [52]

1. Tangibles: How is the physical appearance of the structure used to deliver a
service such as equipment, building, personnel, and communication materi-
als?

2. Reliability: Is the service as advertised, and is it accurate?

3. Responsiveness: Is the service responsive to the immediate needs of the
customers?

4. Assurance: Is the service courteous, and do employees convey a sense of
trust and confidence?

5. Empathy: Does the service exhibit care about the individual needs of the
customer?

1.3.4 Quality in health care informatics

The primary functions of a health care informatician involve the capture, storage, re-
trieval, and analysis of biomedical data [5]. For the reader not familiar with health care
informatics, the following definition applies for general purposes.

Definition 1.2 (Health care informatics)
Health care informatics is an “interdisciplinary field that studies and pursues the
effective uses of biomedical data, information, and knowledge for scientific in-
quiry, problem-solving, and decision making, motivated by efforts to improve human
health [5]."

On the Donabedian’s model, we can classify health care informatics services at the
structure level. To assess the quality of these services, we apply the dimensions in Box
1.2. To evaluate the reliability feature, we, for instance, can measure the degree to which
biomedical data exhibit the following general characteristics of data quality [28, 59]:

1. Uniqueness: data are stored in a database where each entity only exists once.

2. Accuracy: the captured data represent a real-life object according to the data
source authority.

3. Consistency: data about the same objects are consistent across entities. Inheri-
tance rules of super-to-subtypes are also consistently enforced.

4. Completeness: all the required fields are not null.

5. Timeliness: the time from capture to availability for use is minimal. The valid period
of data is given.
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6. Currency: data reflect the current standards of the real-life object.

7. Conformance: data are used according to the specifications in the metadata.

8. Referential integrity: primary to foreign keys constraint rules are enforced, includ-
ing the rules of insertion, deletion, and updates.

1.4 Causes of poor quality

1.4.1 Human error

“To err is human”[21]. Some of the leading causes of human errors that can translate into
poor service quality include:

1. Planning: poor planning leads to poor outcomes [55].

2. Storage: due to a multitude of reasons, a human operator may forget how to carry
out the original plan. Some of the contributing factors to this problem include inter-
ruptions and multi-tasking [55].

3. Execution: in this instance, a human operator is unable to carry out a well-planned
strategy due to the lack of knowledge or other factors [29].

1.4.2 Poor processes

While it is true that, as humans, we are prone to making mistakes, poor processes are
generally to blame. In service, characteristics of poor processes include too many hand-
offs, unnecessary waiting, and setup problems [24]. Deming, one of the pioneers of
quality improvement, has concluded that poor processes are entirely the responsibility of
management, not that of the operator [43]. In Deming’s view, without the commitment
of the executives, poor processes are likely to persist. We will come back to Deming’s
viewpoints later.

1.4.3 Ineffective information system

An ineffective information system can lead to inadequate quality of products and services.
Signs of an ineffective information system include [33, 28]:

1. Poor user interfaces

2. Interoperability problems among computer systems

3. Poor data capture controls

4. Missing or outdated data and information governance policies

5. Legacy systems with accessibility issues
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6. Redundant data storage and inconsistent metadata

7. Lack of controls over external data sources

8. Lack of management commitment to data quality

In health care, an ineffective information system could not only lead to data quality issues
but also poor medical care [61]. In unfortunate situations, patient harm can result [33].

1.5 Quality and variability

The implication of Definition 1.1 is that too much variability is associated with low quality,
whereas little variability relates to high quality.

Definition 1.3 (Quality improvement)
Quality improvement is the reduction of variability around the desired standard
[43].

The practical significance of Definition 1.3 is that we must understand what the cus-
tomer expects, or is willing to pay for, and what the process variability is before we can
improve the quality of a product or service. In medical care, Definition 1.3 requires us to
stay informed about the latest evidence-based standards to improve outcomes of care.
The implication in health care informatics is that we must practice modern standards of
data quality to ensure reliable services.

1.6 Quality vs. process improvement

In this book, we use expressions “quality improvement” and “process improvement” in-
terchangeably to mean the same thing. The justification is that to improve quality, we
must improve the related process. Graphically, the relationship between “quality” and
“process” is portrayed in Figure 1.2.

Figure 1.2: A model of the relationship between process and quality

...

Actions taken

Quality(output)Inputs
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From Figure 1.2, we deduce that “quality,” which is a function of the degree to which
the output meets the standard, is dependent on the actions that are taken in a “process.”
To improve quality, we must improve the process by taking a different set of actions
that lead to little variability in the outputs. In practice, we design experiments and apply
statistical methods to find the best set of actions that minimizes variability. The inputs are
not generally the source of variability, especially in manufacturing, where raw materials
tend to be standardized. In health care, some inputs, such as risk factors of patients, may
affect outcomes of care, thus necessitating adjustments in our quality measures [4].

1.7 Models of quality improvement

The most commonly used models of quality improvement are the Plan, Do, Check, Act
(PDCA) cycle, and the Define, Measure, Analyze, Improve, Control (DMAIC) frame-
work.

1.7.1 PDCA

Figure 1.3 portrays a graphical representation of the PDCA cycle, also called the She-
whart cycle or PDSA (where S stands for Study).

Figure 1.3: The PDCA cycle

Act Plan

Check Do

The arrow on the circle signifies the concept of “continuous” quality improvement. In
the Plan phase of this cycle, we propose changes or experiments to run. In the Do
phase, we carry out our plan, usually on a small scale. In the Check phase, we analyze
the results from the Do phase. In the Act phase, we fully implement changes or abandon
them. The cycle is iterated as many times as necessary to improve quality [43].
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1.7.2 DMAIC

Figure 1.4 shows the basic phases of the DMAIC framework.

Figure 1.4: Phases of the DMAIC framework

Define Measure Analyze ControlImprove

The definition of each one of these phases follows [14, 24, 43].

Define: In this phase, we define opportunities for improvement. Additionally, we create
flow charts, a project charter,2 and a SIPOC3 diagram.

Measure: In this phase, we collect data on key process input variables (KPIV) and key
process output variables (KPOV). We attempt to establish baseline measures for
WIP,4 VOC,5 PCE,6 cycle time, process completion rate, sigma level, and financial
metrics. At the end of the project, we will refer back to these initial measures to
assess how much improvement we have made.

Analyze: In this phase, we try to make sense of the data we collected in the Measure
phase by analyzing root cause, correlation, risk, stability, capability, and hypothesis
tests. One of the tools that we may apply here is the cause-and-effect diagram
to evaluate the causes of the quality problem. Another essential tool that we may
deploy is a preliminary control chart to assess the stability of the process.

Improve: This phase is probably the most difficult since we have to turn our analysis into
actions to improve the process. Creative thinking is imperative. To generate ideas
for improvement, we may have to hold brainstorming sessions, not only with current
process stakeholders but also with experts and the crowd [40]. One particularly
useful statistical tool that we can employ here is DOE7 [43]. For problems related
to efficiency and cycle times, we can employ Lean techniques to eliminate non-
value-added activities from the process. We continue to apply these improvement
tools until control charts signal that the process is stable.

2Project charter: a short document with clear statements about the goal, the business case, the op-
portunity, the project scope, plan, and team for quality improvement [43]

3SIPOC: Suppliers, Inputs, Process, Outputs, and Customers
4WIP: Work-in-Process (e.g., work yet to be finished)
5VOC: Voice of the Customer (e.g., customer feedback)
6PCE: Process Cycle Efficiency
7DOE: Design of Experiments
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Control: In this phase, we implement tools to monitor the process, such as control
charts, run charts, and dashboards. To the extent possible, we should automate
this phase. Otherwise, we must develop a sampling plan to audit and monitor
the new process. Additionally, we must create an out-of-control plan (OCAP) to
prescribe actions to be taken when out-of-control behaviors arise in the improved
process.

1.7.3 Technical aspects of quality improvement

We have previously mentioned that we cannot improve quality if we don’t know the stan-
dard. If the standard is not given, we need to know how to approximate it from the
process samples. Additionally, we must be able to measure variability if we are to reduce
it to improve quality. All these activities require technical skills that, without them, quality
improvement efforts may fail. Indeed, it is believed that the movement of total quality
improvement (TQM) in the 1980s was not overly successful, partly because of the lack
of emphasis on statistical aspects of quality improvement [43]. The strategy that tends
to emphasize technical skills more is Lean Six-Sigma. The Lean part of this strategy
focuses on making processes efficient. The Six-Sigma part utilizes statistical techniques
to reduce variability in the process to reach a performance state of no more than 3.4
defective parts per million (PPM) opportunities (DPMO) in the process [24]. Statistical
process control (SPC) is another strategy that emphasizes the reduction of variability
in the process to achieve stability and capability to meet quality standards. The seven
primary tools of SPC, which are also encountered in the Lean Six-Sigma strategy, are
[43]:

1. Histograms or stem-and-leaf plots to visually assess the distribution of the pro-
cess given the central tendency and variability. These tools may also help evaluate
the process capability to meet the given quality specifications.

2. Checksheets to help collect and tabulate the process data by frequency, time,
location, and cause.

3. Pareto charts to identify the “vital few” factors causing the majority of quality prob-
lems. A common analytical method applied here is the 80/20 rule that implies that
20% of the factors cause 80% of the problems.

4. Cause-and-effect diagrams to help analyze the root causes of the given effect.
The causes are often categorized by factors such as materials, machines, mea-
surement, people, methods, and policy.

5. Defect concentration diagrams to model the spatial distribution of defects on a
particular product.

6. Scatter diagrams to characterize the relationship between two variables in the
process. We often seek to conclude positive correlation, negative correlation, or no
correlation between the variables under study.
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7. Control charts to monitor the process behaviors over time or by the sample num-
ber. Control charts help detect and reduce special cause variation in the process.

We will discuss SPC tools further in later modules.

1.8 Managerial aspects of quality improvement

1.8.1 Managerial support

Successful quality improvement programs require not only the technical know-how but
also the buy-in from executives. Indeed, without a meaningful managerial involvement,
many quality improvement efforts are likely to fail. Deming believed that the success of
any quality improvement program was a direct consequence of the actions of senior man-
agers [43]. Deming often spoke of the following seven deadly diseases of management
[43]:

1. Lack of constancy of purpose

2. Emphasis on short-term profits

3. Evaluation of performance, merit rating, and annual reviews of performance

4. Mobility of top management

5. Running a company of visible figure alone

6. Excessive medical costs

7. Excessive legal damage awards.

Deming recommended that senior managers adopt the following 14 points [43, 44, 25,
45]:

1. Create constancy of purpose to improve the quality of products and services.

2. Adopt a new philosophy that recognizes the state of a new economic era.

3. Do not rely on mass inspection to control quality (e.g., focus on prevention
through process improvement).

4. Do not award business contracts to suppliers by price alone without factoring
in the costs of quality.

5. Focus on continuous improvement of products and services.

6. Practice modern training methods (e.g., everyone needs to be trained to practice
modern quality improvement methods).

7. Improve leadership and supervision methods (e.g., supervisors should focus on
helping operators improve the quality of products and services).
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8. Drive out fear (e.g., let everyone speak out about quality issues)

9. Break down the barriers between functional areas of the business (e.g., en-
courage teamwork).

10. Eliminate targets and slogans for the workforce (e.g., targets and slogans are
meaningless without commitment and a plan to achieve quality excellence).

11. Eliminate numerical quotas and work standards (e.g., quotas and standards
without regard to quality are useless).

12. Remove the barriers that discourage employees from doing their jobs.

13. Institute an ongoing program of education for all employees (e.g., have a contin-
uous education program for all employees to learn how to use quality improvement
tools, including statistical methods).

14. Create a managerial structure on the top that will vigorously support the first 13
points

1.8.2 Quality costs

It is common practice in many organizations that before we can start working on an
expensive quality improvement project, we justify the need for the project and make a
business case of our plan. Depending on the financial return, senior managers may deny
our project. This concept is demonstrated in the next example.

Example 1.1 A proposed quality improvement project is expected to increase the
revenue of Metropolis Hospital by 1%, increase medical expenses by 0.5%, and
add $500,000 in administrative costs. What will be the impact on the hospital’s
net income if its total revenues, total medical expenses, and overall administrative
costs are currently $100,000,000, $70,000,000, and $25,000,000, respectively? A
simplified Profit & Loss (P&L) statement follows.

Table 1.1: A P&L Statement of Metropolis Hospital, 2018

Current Pro-forma

Revenue $100,000,000 $101,000,000
Expenses

Medical $70,000,000 $70,350,000
Administrative $25,000,000 $25,500,000

Total expenses $95,000,000 $95,850,000

Net income $5,000,000 $5,150,000

How is the top management likely to respond to this request? Given the likely
increase of 3% in the net revenue ((5,150,000 - 5,000,000)/5,000,000 = 0.03), the
proposal is likely to be approved.
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An organization committed to quality should consider all aspects of quality costs
when deciding on the merits of an improvement project. Quality costs are typically clas-
sified in the following categories [43]:

1. Prevention costs: costs that go into the efforts of averting defects at the design or
operation level.

2. Appraisal costs: costs associated with auditing and inspecting products and ser-
vices to ensure conformance to standards.

3. Internal failure costs: costs due to discovered defects before products and ser-
vices are delivered to the customer. These costs may result from scraps and re-
work.

4. External failure costs: these are costs that go into the efforts of investigating and
handling substandard products and services that were delivered to the customer.
Examples of such costs include returned products, warranty, liability, bad reputa-
tion, and legal fees.

1.9 A brief history of quality improvement

1.9.1 Manufacturing

Quality improvement in manufacturing can be traced as far back as at the start of the
industrial revolution in the 1700s. From 1700 to 1900, improvement efforts were mostly
decentralized and confined to each manufacturer. By the early 1900s, ideas for improv-
ing manufactured products became well-accepted, and they evolved into modern quality
improvement techniques that we still use today. To name a few examples, between 1922
and 1923, a statistician named Ronald Fisher published the concepts of DOE that we
discussed earlier. In 1924, Walter A. Shewhart introduced control charts for process
monitoring. By the 1930s, Henry Ford had developed practical approaches to mistake-
proofing assembly lines. In the 1940s, W. Edwards Deming was giving lectures on sta-
tistical quality control and quality management. In 1950, Kaoru Ishikawa introduced the
cause-and-effect diagram. In 1951, Armand Feigenbaum published the first edition of his
book on Total Quality Control. Feigenbaum is credited for publicizing the importance of
managerial leadership in quality improvement. By mid-1950s, Joseph Juran, who had
worked for Shewhart, had become a great champion of quality control and was also giv-
ing lectures on quality improvement and management. Juran is also known for the Juran
Trilogy of quality management, which includes: planning, control, and improvement. In
1959, S.W Roberts extended the idea of control charts into exponentially weighted mov-
ing average charts. In 1960, Kaoru Ishikawa introduced the ideas of quality control circles
to encourage workers who were doing the same job to meet regularly to attempt to solve
common problems. By the mid-1970s, the ideas of quality circles had evolved into the
concept of total quality improvement (TQM). In the late 1980s, Motorola publicized its
notion of Six-Sigma quality using the idea of 3.4 DPMO [43]. By the early 2000s, many
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other ideas of quality improvement had flourished, including Lean and Six-Sigma [24].
During this period of the evolution of quality improvement, there were also many govern-
ment and private sector initiatives that were critical in advancing the theory and practice
of quality improvement [43].

1.9.2 Health care

In health care, quality improvement ideas can be traced as far back as the early 1800s
with Dr. Ignaz Semmelweis. Dr. Semmelweis advocated for many ideas of quality, includ-
ing hand washing. By the 1850s, Florence Nightingale was already a champion of quality
of care. Nightingale was known to use many statistical concepts such as polar diagrams
to establish correlations between living conditions and mortality rates [50]. In the 1890s,
John Hopkins introduced hospital quality standards and initiatives for extensive training
of physicians. By the early 1900s, Earnest Godman was a strong advocate of patient
follow-ups and public report cards on quality [55]. In 1966, Avedis Donabedian published
his famous paradigm of structure-process-outcome to measure health care quality. Dur-
ing the period that followed, many government agencies and private organizations were
created to promote the quality of care. Examples of these organizations include the Insti-
tute of Medicine (IOM), Joint Commission, Professional Standards Review Organizations
(PSROs), Agency for Healthcare Research and Quality (AHRQ), National Committee for
Quality Assurance (NCQA), The National Quality Forum (NQF), Surgical Care Improve-
ment Program (SCIP), and several others [39]. Today, many of the quality improvement
techniques that were developed in the manufacturing sector are widely used in health
care to improve the quality of care and administrative services [43, 61].
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1.10 Check your understanding

1. Who introduced control charts?

(a) Ishikawa

(b) Shewhart

(c) Juran

(d) Donabedian

(e) Feigenbaum

2. Who introduced the structure-process-outcome paradigm to measure health care
quality?

(a) Ishikawa

(b) Shewhart

(c) Juran

(d) Donabedian

(e) Feigenbaum

3. Where would you classify health care informatics on the structure-process-outcome
model?

4. Data use according to the specifications in the metadata relates to which dimension
of data quality?

(a) Accuracy

(b) Uniqueness

(c) Conformance

(d) Currency

5. Storing data in a database so that each entity exists only once is an example of
which dimension of data quality?

(a) Accuracy

(b) Uniqueness

(c) Conformance

(d) Currency

6. You have noticed the lack of confidence in your employees. This likely indicates
quality problems in which dimension of service quality?

(a) Tangibles

(b) Reliability
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(c) Responsiveness

(d) Assurance

(e) Empathy

7. What happens to quality when variation increases?

8. What is the basic definition of “quality improvement”?

9. How does quality improvement differ from process improvement?

10. What role does a customer play in quality improvement efforts?

11. What do we do in the Check phase of PDCA?

12. What are the dimensions of service quality in health care informatics?

13. What are the prerequisites of a successful quality improvement program in an or-
ganization?

14. How would you classify costs associated with yield loss due to system downtime?

(a) Internal failure costs

(b) External failure costs

15. How would you classify quality costs associated with the investigation of customer
complaints?

(a) Internal failure costs

(b) External failure costs

16. Who were the first pioneers and champions of quality management?

17. What are the quality ramifications of a poor health information system?

18. How would you go about assessing the quality of health care informatics services?

19. What are the common sources of quality issues?

20. A proposed quality improvement project about data quality at Metropolis Hospital
is expected to increase medical expenses by 0.5%, and add $500,000 in admin-
istrative costs. No change in revenue is expected. What will be the impact on
the hospital’s net income if its total revenues, total medical expenses, and overall
administrative costs are currently $100,000,000, $70,000,000, and $25,000,000,
respectively? How is the hospital likely to prioritize this project request? Justify
your response and discuss the implications of various quality costs.



MODULE 2

Tools for identifying opportunities for improvement

In this module, we explore essential tools for identifying opportunities for
improvement in a process. Among the tools we discuss, include VOC1,
flowcharts, Lean Six-Sigma measures, quality audits, a project charter,
and a SIPOC2 diagram. We employ Microsoft Visio and Excel to imple-
ment these tools.

Key concepts and tools: VOC; Flowchart; Project charter; SIPOC; PCE3; Sigma
level; DPMO4; Efficiency; Variability; Quality audits

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for identifying a quality problem

2. Explain the importance of VOC

3. Promote the need for quality audits

4. Construct a basic flowchart

5. Construct a swim-lane diagram

6. Create a value-stream map

7. Draw a spaghetti diagram

8. Calculate Lean Six-Sigma baseline measures

9. Develop a project charter

10. Create a SIPOC diagram

1VOC: Voice of the customer
2SIPOC: Suppliers, Input, Process, Output, Customer
3PCE: Process cycle efficiency
4DPMO: Defects per million opportunities

26



Module 2. Tools for identifying opportunities for improvement 27

2.1 Introduction

During the Define phase of DMAIC5, we attempt to identify opportunities for quality im-
provement. An important tool that we deploy is this phase is VOC, where we attempt
to find opportunities for improvement from the feedback of the customer. We also cre-
ate flowcharts and conduct quality audits to identify deficient areas in the process.
Once we know an opportunity for improvement exists, we create a project charter and
a SIPOC6 diagram to initiate a quality improvement project. We also establish baseline
measures using various metrics such as the sigma level, DPMO, and PCE.

2.2 Voice of the customer (VOC)

The process of VOC involves obtaining feedback from customers about the quality of
service or product that they’ve received or would desire. The goal is to understand the
priorities and standards of the customers. Typical activities of VOC include interviews,
satisfaction surveys, and focused groups [43]. In the early stages of the design of a prod-
uct or service, we can use VOC for DFSS7 to create a product or service that will need
little to no improvement in the future. In addition to the traditional approaches of VOC,
health care organizations may also acquire feedback from professional, regulatory, and
accrediting agencies. For example, a hospital could use accreditation outcomes or pub-
licly available quality measures [17] to identify potential opportunities for improvement.

Example 2.1 (Pneumonia care)
The Centers for Medicare and Medicaid Services (CMS) recommends that immuno-
competent patients with community-acquired pneumonia receive an antibiotics reg-
imen within 24 hours of admission to the hospital [16]. A hospital could use this
guideline as VOC to improve its pneumonia care.

In health care informatics, the approach of VOC generally entails requesting feed-
back from internal customers (e.g., medical and administrative users) about data quality
and other information system needs.

2.3 Quality audits

Besides VOC surveys, we can also find opportunities for improvement by performing
regular audits or inspections of the process. In health care informatics, audits are a
must to ensure data quality and compliance with standards (e.g., HL78) and regulations
(e.g., HIPAA9). Activities in such audits may include [28]:

5DMAIC: Define, Measure, Analyze, Improve, Control
6SIPOC: Suppliers, Input, Process, Output, Customer
7DFSS: Designing for Six-Sigma
8HL7: Health Level Seven [8]
9HIPAA: Health Insurance Portability and Accountability Act [13]
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1. Data profiling to look for unexpected extreme values or unusual patterns.

2. Comparing data against the business rules.

3. Looking for overwritten warnings.

4. Checking for the validity of data.

5. Looking for duplicated data.

6. Inspecting data entry controls.

7. Examining access and error logs.

Additionally, we should scrutinize the reliability of data entries in our EHRs10 to ensure
[59]:

1. Completeness: did our EHR capture all “truth" about the patient?

2. Correctness: are the data elements in our EHR true about the patient?

3. Concordance: do the data in our EHR agree with other data sources?

4. Plausibility: do our data elements look reasonably true, given the measure of
interest?

5. Currency: how relevant is the data given the time and patient’s state?

It is important to note that Deming has cautioned about relying on mass inspection as a
way to improve quality [43]. We should always carry out audits as a part of a broader
continuous quality improvement program to find and eliminate all sources of variability in
the process.

2.4 Baseline measures

Before we can improve a process, we must be able to measure the gap between the
current and the desired performance. We calculate baseline measures to gauge the
state of the quality in the process and identify opportunities for improvement. The types
of baseline measures depend on the process, but sample statistics such as the mean and
variance are standard measures for processes that generate metric data. Other statistics
that we can apply to establish baseline measures include the sigma level, DPMO, and
PCE. These statistical measures originate from the Lean Six-Sigma quality improvement
strategy, as we discuss next.

10EHR: Electronic Health Record
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2.5 Overview of Lean Six-Sigma

2.5.1 What is Lean?

The Lean part of the Lean Six-Sigma strategy emphasizes efficiency by attempting to
eliminate waste (or muda11) out of the process. More generally, muda is any process
step that the customer would not be willing to pay for. We also refer to this step as
non-value-added (NVA). In service, examples of NVA activities include [24]:

• Overproduction: the production of service beyond what is needed for immediate
use (e.g., excessive reports and paperwork). This activity will likely increase cycle
time12.

• Unnecessary waiting: any extra time between the end of one step and the start
of the next step is NVA (e.g., waiting for signatures or approvals).

• Unnecessary transportation: inefficient transportation methods increase cycle
time. Examples include people always walking around to collect or deliver materi-
als.

• Needless motion: unnecessary motions increase cycle time and the chances for
errors. Examples of such incidents include switching between different computer
desks and performing too many keystrokes to accomplish a simple task.

• Too much inventory: having more than needed inventory increases cycle time,
such as accepting more orders than one can process in time.

• Overprocessing: trying to add more value to service more than the customer
requires (e.g., excessive inspections). Any extra and unnecessary steps in the
process are expensive since they delay the main service.

• Defect: any aspect of service that does not conform to the requirements or stan-
dards of the customer.

We apply Lean tools to strive to have a process with minimal to no NVA activities. By
eliminating NVA steps, the cycle time will decrease, thus making the process more effi-
cient. We can measure the level of efficiency using the following process cycle efficiency
(PCE) formula:

PCE =
VA time

Cycle time
(2.1)

where VA stands for value-added and 0 ≤ 𝑃 𝐶𝐸 ≤ 1. The higher the PCE measure, the
more efficient the process. Given that

cycle time = VA time + NVA time, (2.2)

11Muda: a Japanese word meaning “waste". In Lean terminology, the word muda is commonly used to
indicate non-value-add activities [53]

12Cycle time: The average amount of time it takes to complete a service unit or product [24]
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we can rewrite Equation 2.1 like this:

PCE =
VA time

VA time + NVA time
(2.3)

From Little’s law [38], the following relationship also applies:

Cycle time =
WIP
𝜆

(2.4)

where WIP stands for the work-in-process or the amount of work yet to be completed
[43], and 𝜆 is the completion rate (e.g., productivity rate). By combining Equations 2.1
and 2.4, we observe that:

PCE =
𝑉𝐴×𝜆
𝑊𝐼𝑃

(2.5)

We use the × symbol to indicate multiplication. Since 0 ≤ 𝑃 𝐶𝐸 ≤ 1, Equation 2.5 implies
that:

0 ≤ 𝑉𝐴×𝜆 ≤𝑊𝐼𝑃 (2.6)

From Equations 2.1-2.5, it follows that if we held all other variables constant, we could
increase PCE using one or a combination of the following techniques:

1. Increase the share of VA time by decreasing the share of NVA time (e.g., remove
NVA steps from the process).

2. Increase the completion rate by adding resources (e.g., more employees or com-
puter servers).

3. Decrease 𝑊𝐼𝑃 by having our process operate on a Pull instead of a Push basis,
meaning that before accepting new work, we must first finish existing work [24].

Example 2.2 (PCE measure)
A medical coding and billing company has, on average, 30 claims in the billing
queue and, the average processing time of each claim is 2 hours. Per Equation
2.4, we can obtain the completion rate 𝜆 by:

Cycle time =
WIP
𝜆

= 2 =
30
𝜆

=⇒ 𝜆 =
30
2

= 15 claims per hour (2.7)

Assuming that 30 minutes out of the 2 hours processing time is NVA, we can obtain
VA time as follows by 2 − 0.5 = 1.5 hours, and the PCE measure by Equation 2.5,
as follows:

𝑃 𝐶𝐸 =
𝑉𝐴×𝜆
𝑊𝐼𝑃

=
1.5× 15

30
= 75% (2.8)

Similarly, we can obtain the same measure using Equation 2.1 like this:

𝑃 𝐶𝐸 =
VA time

Cycle time
=
1.5
2

= 75% (2.9)
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The manager of this process can increase the PCE measure by attempting to
eliminate NVA activities from the process, or by increasing the completion rate
by increasing resources. The choice of decreasing WIP (e.g., limiting customer
requests) makes business sense only if the marginal cost of an additional unit of
resource is more than the corresponding marginal revenue rate.

2.5.2 What is Six-Sigma?

The Six-Sigma part of the Lean Six-Sigma strategy focuses on eliminating opportunities
for defects and reducing variation in products.

Theoretical Six-Sigma level

The word “Six-Sigma” typically signifies 6 standard deviations (6𝜎 ) away from the mean
(𝜇), and this is denoted as 𝜇 ± 6𝜎 . In normally distributed data, we expect 68.27% of
the data to fall within 𝜇 ± 1𝜎 , 95.45% to fall within 𝜇 ± 2𝜎 , 99.73% to fall within 𝜇 ± 3𝜎 ,
99.9937% to fall within 𝜇±4𝜎 , 99.999943% to fall within 𝜇±5𝜎 , and 99.9999998% to fall
within 𝜇± 6𝜎 . Theoretically, a Six-Sigma process should only have 0.002 defective parts
per million (PPM) opportunities (DPMO), which translates into 99.9999998% defect-free
parts. In other words, the probability of observing a defective part (or a nonconforming
step in the process) is 0.002/1,000,000 = 0.0000002%.

Approximating DPMO

Let’s assume that the probability of a nonconforming step in the process is 𝑝. We can
calculate 𝑝 this way:

𝑝 =
𝐷

𝑇𝑂𝑃
(2.10)

where 𝐷 is the total number of nonconforming steps, and 𝑇𝑂𝑃 is the total number of
opportunities for nonconformity given by:

𝑇𝑂𝑃 =𝑈 ×𝑂𝑃 (2.11)

Here, 𝑂𝑃 is the number of opportunities per step, and 𝑈 is the total number of the
process steps [14]. Using 𝑝, we can estimate DMPO this way:

𝐷𝑃𝑀𝑂 = 𝑝 × 1,000,000 (2.12)

Yield in the process

The ratio of the total number of defective units 𝑈𝐷 and the total number of units 𝑈 quan-
tifies the percent of defective units. From this ratio, we can estimate the process yield 𝑌
as follows:

𝑌 = 1− 𝑈𝐷

𝑈
(2.13)
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Equation 2.13, which ignores opportunities of more than one defect per unit, is a simplistic
way of determining the accuracy or success rate in typical processes.

Example 2.3 (Sigma level)
A health care informatics process requires 20 steps, and each step is considered
an opportunity for a mistake. If the accuracy rate in each step is 95%, it follows that
the probability of delivering a service unit with no mistake, or the yield, is given by:

0.9520 = 35.85% (2.14)

In other words, Equation 2.14 indicates that about 64.15% (1-35.85%) of the deliv-
ered services are likely to have at least one mistake. So, out of 1,000,000 services,
641,500 of them will be nonconforming. If the goal was to have a yield of 95%, then
the accuracy level in each (1− 𝑝) must be:

(1− 𝑝)20 = 0.95 (2.15)
= 0.951/20 (2.16)
= 0.997439 (2.17)
= 99.74% (2.18)

So, the probability of a step in the process being defective is 𝑝 = 1 − 99.74% =
0.26%, which is equivalent to a theoretical 3𝜎 performance level. We can already
appreciate that a 6𝜎 performance level practically means no errors in any step of
the process.

Motorola Six-Sigma level

In practice, we rarely apply the theoretical Six-Sigma concept, but instead, use the idea of
Six-Sigma that Motorola introduced in the 1980s. From Motorola’s experience, a product
could drift by as much as ±1.5𝜎 from the target and yet remained acceptable. After
accounting for such drift, Motorola developed a measure of Six-Sigma based on 3.4
DPMO instead of the theoretical 0.002 DPMO discussed earlier [43]. We denote Motorola
Six-Sigma metric as 6𝜎𝑀 and calculate it as follows [14]:

6𝜎𝑀 = 0.8406+
√︀
29.37− 2.221 * ln(𝐷𝑃𝑀𝑂) (2.19)

Here, ln() symbolizes the natural logarithm. We can also obtain the 6𝜎𝑀 measure using
Excel as we demonstrate in How-To 2.1.

How-To 2.1 (Calculating 6𝜎𝑀 in Excel 2013)
To calculate 6𝜎𝑀 in Excel, use

= 𝐴𝐵𝑆(𝑁𝑂𝑅𝑀𝑆𝐼𝑁𝑉 (𝑝)) + 1.5𝜎 (2.20)

where +1.5𝜎 is the drift, 𝐴𝐵𝑆() is the absolute value function, and 𝑁𝑂𝑅𝑀𝑆𝐼𝑁𝑉 ()
is an Excel function to calculate the inverse of a standard normal.
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Example 2.4 (6𝜎𝑀 )
We use the formula in Equation 2.20 to verify that 3.4 defects in a million opportu-
nities translate into 6𝜎𝑀 . First, we obtain 𝑝 by:

𝑝 =
3.4

1,000,000
(2.21)

We open Excel and type into cell A1 this formula:

= 𝐴𝐵𝑆
(︂
𝑁𝑂𝑅𝑀𝑆𝐼𝑁𝑉

(︂ 3.4
1000000

)︂)︂
+1.5 (2.22)

which yields 5.999854 ≈ 6.

Figure 2.1: A snapshot of Excel to show the calculation of 6𝜎𝑀

Example 2.5 (6𝜎𝑀 and DPMO)
As the manager of the revenue cycle at Metropolis Hospital, your team performs
monthly random audits on 100 claims. You classify a claim as defective or noncon-
forming if you find a mistake in any of the following categories:

1. Diagnosis-related group (DRG)

2. Primary insurance name

3. Attending physician name

So, the process has three opportunities for a defect per claim. Last year, your team
audited 1,200 claims and found 60 mistakes in the DRG category, 36 mistakes in
the primary insurance names category, and 84 mistakes in the attending physician
names category. Overall, there are 60 + 36 + 84 = 180 total defects out of 3 ×
1,200 = 3,600 opportunities, which means that the probability 𝑝 of a mistake can
be obtained by:

𝑝 =
D

TOP
=

180
3,600

= 0.05 (2.23)

Using Excel, you can find the 6𝜎𝑀 measure by:

= 𝐴𝐵𝑆(𝑁𝑂𝑅𝑀𝑆𝐼𝑁𝑉 (0.05)) + 1.5 (2.24)
= 3.145 (2.25)
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By Equation 2.12, the DPMO measure in this scenario is estimated by:

𝑃 𝑃𝑀𝑂 = 0.05× 1,000,000 = 50,000 (2.26)

Example 2.6 (Yield)
Following from Example 2.5, let’s assume that your team found defects on different
claims (so no claim had more than one defect). From this assumption, you can
estimate the process yield (Y) as follows:

𝑌 = 1− Number of defective claims
Total number of claims

= 1− 180
1,200

= 1− 0.15 = 85% (2.27)

Since, in general, a claim can only have one DRG, one primary health insurance
name, and one attending physician, you can also estimate the yield from each
category this way:

Yield of DRGs = 1− 60
1,200

= 95% (2.28)

Yield of insurance names = 1− 36
1,200

= 97% (2.29)

Yield of attending physician names = 1− 84
1,200

= 93% (2.30)

The product of these rates produces a measure known as the Rolled Throughput
Yield (RTY)[53]. The RTY measure is normally obtained by multiplying yields from
independent steps in the process. So, in this case, RTY is given by:

𝑅𝑇 𝑌 = 0.95× 0.97× 0.93 ≈ 85.7%. (2.31)

So, what can you conclude?

1. One conclusion is that up to 15% (1-85%) of the claims could potentially be
rejected for having the wrong billing information. In practice, rejected claims
create rework and increase the average cycle time of the claims process as
a result. We recall that any rework is muda and potentially expensive. In this
example, Metropolis Hospital may not only have to pay someone to fix the
rejected claims but also may incur additional costs of financing receivablesa.

2. Another conclusion is that the RTY measure provides a high-level view of
the overall claims process. At the sub-process level, one does not see the
whole picture. Let’s assume that the claims process herein involves three
different departments: Health Information Management (HIM) that assigns
DRGs, Registration that selects attending physicians’ names, and Billing that
chooses the primary insurance names. At the department level, the HIM
manager may be happy with a yield of 95%, and so would be the Registration
manager with a yield of 93%. The Billing manager may even be happier with
a yield of 97%. But, observe that collectively, only about 85.7% of the claims
are clean, and this is not good.
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aReceivables: most health care providers don’t receive payments as soon as they render a
medical service. The payment or reimbursement could take weeks depending on how soon the
organization submits a clean claim and the turn-around time of the third-party payers. We refer to
unpaid claims as receivables. It is not uncommon for health care providers to finance their receiv-
ables in return for operating cash [22].

DFSS

DFSS13 is a variation of the Six-Sigma strategy that involves designing products and ser-
vices at the Six-Sigma level quality form the get-go. In other words, the process will have
little to no need for rework or improvement since it was designed at the desired standard.
It is possible to accomplish this goal by involving customers in the design process or by
simply inquiring about the customers’ needs via surveys and focused groups [43].

2.6 Flowcharts

Flowcharts are graphical tools that we generally deploy during the Define phase of DMAIC
to model the chronology of steps in a process. The types of flowcharts that we consider
here include the basic flowchart, the swim-lane diagram, the workflow diagram, and
value-stream maps.

2.6.1 A Basic flowchart

A basic flowchart depicts the chronology of steps in the process. Typical geometric
shapes that we utilize for this purpose include a rectangle to suggest processing, a dia-
mond (or a rhombus) to indicate a decision node, and a D-looking shape to show delay.
We connect sequential steps with an arrow to suggest the direction of the flow of work.
We show an example of a basic flowchart in Figure 2.2.

2.6.2 A swim-lane diagram

A swim-lane diagram, also known as a cross-functional flowchart, is similar to a basic
flowchart, and we typically use the same geometric shapes. The only difference is that
in the former, we attempt to group the steps by the function or the responsible person,
whereas in the latter, we sequence the steps in the chronological order. Figure 2.3 shows
an example of a swim-lane diagram that we adapted from the basic flowchart in Figure
2.2.

2.6.3 A workflow diagram

A workflow diagram is another type of flowchart that we consider. We use this diagram
to illustrate the physical flow of work and transportation in a process. When drawing a

13DFSS: Design for Six Sigma
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Figure 2.2: A basic flowchart for a discharge-to-billing process in a hospital that still uses
paper records to document inpatient care services. All decision steps that suggest rework
or going back to any of the previous steps should be examined for potential improvement.
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workflow diagram, we attempt to represent the steps in the process using the shapes of
physical objects (e.g., workstations, people, etc.). In Figure 2.4, we portray a type of a
workflow diagram known as spaghetti14. From this chart, we appreciate that the denser
the lines, the more traffic. For example, we can visually see that there is too much traffic
between the front-desk clerk and the printer. Additionally, the workstations of coding
and analysis seem to be physically far from the front-desk workstation, a setup that
likely increases transportation. From the Lean strategy, all unnecessary transportation
and movements are NVA [24]. In Figure 2.5, we portray a different type of a workflow
diagram that indirectly relates to the same billing-to-discharge process that we initially
illustrated in Figure 2.3. In this new representation, we attempt to portray the flow of work
using physical objects that are typical in HIM operations. We draw the bolt-shaped lines
to represent electronic communication. Regular straight lines imply the physical transfer
of work.

2.6.4 Value-stream map

In a value-stream map, we model the sequence and the processing time (PT) of VA15

steps. All unnecessary waiting between two successive steps is considered muda 16. We
denote the overall cycle time as the lead time (LT). From this model, we can determine

14The name of spaghetti diagram comes from the observation that the lines in this diagram look like
spaghetti noodles [14]

15VA: value-added
16Muda: a Japanese word used in Lean terminology to mean waste or NVA [53]
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Figure 2.3: A swim-lane diagram adapted from the flowchart in Figure 2.2. As before, all
steps that suggest rework are potential opportunities for improvement.
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the PCE17 baseline measure this way [43]:

𝑃 𝐶𝐸 =
𝑃 𝑇
𝐿𝑇

(2.32)

Figure 2.6 shows an example of a value-stream map for the same discharge-to-billing
process under discussion.

17PCE: Process Cycle Efficiency
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Figure 2.4: A Spaghetti diagram depicting the workflow related to the functions of as-
sembly, analysis, and coding initially portrayed in the swim-lane plot in Figure 2.3

Figure 2.6: An example of a value-stream map for the discharge-to-billing process in
Figure 2.2. The PCE measure is given by 𝑃 𝑇 /𝐿𝑇 = 25.75/121.75 = 21%, which implies
that about 80% of the discharge-to-billing cycle time is NVA. To improve the process, the
lead time has to be decreased by removing all muda activities from the process. A good
start would be the elimination of all causes of rework and unnecessary waiting.
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Figure 2.5: A workflow diagram related to the discharge-to-billing process that is depicted
in Figure 2.2.
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How-To 2.2 (Drawing flowcharts in Microsoft Visio 2013)
To draw flowcharts, click on File > New > search for or click on Flowchart > choose
the diagram of interest. See a snapshot of Visio 2013 in Figure 2.7.

Figure 2.7: Flowchart options in Microsoft Visio 2013

To draw a floor plan for a spaghetti diagram, click on File > New > search for Maps
and Floor Plans.
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2.7 A project charter and a SIPOC diagram

After identifying opportunities for improvement, we have to devise an improvement strat-
egy and make a business case defending the needs for investing scarce resources into
our project. For this purpose, we employ tools such as a project charter and a SIPOC18

diagram to organize our project plan.

2.7.1 A project charter

We use a project charter to define an opportunity for improvement and to make a busi-
ness case for the project. In this document, we also include the goal, the plan, the scope,
and the team to carry out the project. A project goal should be specific, measurable,
attainable, reasonable, and time-sensitive (SMART) [50]. In Figure 2.8, we present an
example of a project charter to make a case for improving quality in the discharge-to-
billing process that we have previously plotted in Figures 2.2 - 2.6.

Figure 2.8: A project charter for improving the discharge-to-billing process in Figures2.2
- 2.6

Business Case
This project is consistent with the 
goal of the finance department to 
reduce  account receivables by 25% 
in the next 12 months.

Goal Statement
Increasing the PCE measure of the  
discharge-to-billing process from 
21% to 75% over the next 12 months

Opportunity Statement
Opportunity exists to streamline 
the discharge-to-billing process 
by eliminating NVA time related 
to medical query, analysis, and 
record preprocessing. The current 
PCE measure is 21%

Plan
   Define: 2 weeks
   Measure: 12 weeks
   Analyze: 6 weeks
   Improve: 12 weeks
   Control: 20 weeks

Team
Revenue cycle manager, billing 
manager, medical coding manager, 
quality specialist

Scope
Medical coding and billing processes 
are mapped and the lead and 
processing times are measured using 
electronic time stamps in the 
hospital’s main computer 
information system. NVA steps are 
reduced using Lean techniques. 
Variability is controlled using   
statistical process control tools 

18SIPOC: suppliers, inputs, process, output, customers [43]



Module 2. Tools for identifying opportunities for improvement 41

Example 2.7 (A SMART goal)
Working with the revenue cycle team, we will increase the PCE measure of the
discharge-to-billing process from 21% to 75% over the next 12 months.

S: Specifics of the project are provided, including the focus, and who will be
involved.

M: The outcome is measurable ( 21% to 75% of the PCE measure).

A: The stated goal seems attainable given the time frame provided.

R: The goal of achieving 75% of the PCE measure is reasonable. For exam-
ple, the goal of reaching the PCE measure of 100% would be considered
unreasonable.

T: The time frame of 12 months is reasonable and is not overly too long or too
short.

2.7.2 SIPOC diagram

We create a SIPOC diagram to illustrate a high-level view of the suppliers, inputs, pro-
cess, output, and customer in the main process. In the supplier section, we list major
suppliers of materials and information that we use in the process. In the inputs sec-
tion, we document the materials and information that are critical for the process. In the
process section, we display a general flowchart of major steps in the process. In the
output section, we record outputs of the process that the customer cares about. In the
customer section, we list relevant customers of the outputs of the process. Figure 2.9
portrays an example of a SIPOC diagram related to the project charter in Figure 2.8.

Figure 2.9: An example of a SIPOC diagram for improving the discharge-to-billing pro-
cess in Figures 2.2 - 2.6
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2.8 Check your understanding

1. Give an example of two techniques that we utilize to identify opportunities for quality
improvement in a process?

2. How does VOC relate to DFSS?

3. What are the typical activities of VOC?

4. A flowchart that shows the chronology of cross-functional steps in a process is
referred to as:

(a) a basic flowchart.

(b) a swim-lane diagram.

(c) a value-stream map.

(d) a spaghetti diagram.

5. We typically represent a decision step in a flowchart using which of the following
geometric shapes?

(a) ♦

(b) △
(c) �

(d) D

6. Which of the following flowcharts tell us something about the physical workspace?

(a) A basic flowchart

(b) A swim-lane diagram

(c) A value-stream map

(d) A spaghetti diagram

7. What software would you recommend to draw a swim-lane diagram?

(a) Excel

(b) Visio

(c) Minitab

(d) PowerPoint

8. We can classify the time between any successive VA steps of a value-stream
map as

(a) Non-value-added

(b) Value-added
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(c) Lead time

(d) Processing time

9. Data profiling is likely to be an activity that we perform during which of the following
activities:

(a) Customer surveys

(b) Quality audits

(c) Process mappings

(d) PCE calculations

10. Where would you classify a Xerox copier on a SIPOC diagram?

(a) S

(b) I

(c) P

(d) O

(e) C

11. What happens to the process cycle efficiency when WIP is decreased?

12. How is a process that operates on a Push, instead of a Pull, basis likely to measure
on the efficiency scale? Explain.

13. How did Motorola define the concept of Six-Sigma quality?

14. Given that VA time = 10 hours and NVA time = 20 hours, what is the estimated
cycle time?

15. Given that VA time = 10 hours, NVA time = 20 hours, and the completion rate = 2
units per hour, what is WIP in this process?

16. A process has four independent steps, each having a yield of 95%. What is the
RTY measure of this process? Interpret your results.

17. The probability of a defect in a process is 0.04. Estimate DPMO and 𝜎𝑀 rounded
to the nearest hundredth.

18. The integration of information technology (IT) in clinical care has many benefits,
including streamlined workflows and efficient clinical decision making [12]. But, the
increase in the use of IT in clinical care has also come with significant managerial
challenges related to hardware, software, and network issues. Indeed, some pa-
tient adverse events such as injuries and near misses have been attributed to IT
processes [33]. As the new chief information officer (CIO) at Metropolis Hospital,
create a hypothetical project charter to reduce IT-related adverse by 25% over a
reasonable amount of time. Also, create a corresponding SIPOC. You can consult
external resources as necessary.
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19. Recreate the swim-lane diagram in Figure 2.3. In your new diagram, create a
separate lane for the physician. Feel free to add more steps to the process.

20. Redesign the office layout in Figure 2.4 to minimize transportation. Why is your
new layout better than then initial design? Explain your rationale in terms of the
PCE measure.



MODULE 3

Tools for collecting and presenting the data

In this module, we review tools for collecting and aggregating data for
quality improvement. The tools we consider include checksheets, pie
charts, bar charts, Pareto charts, radar charts, and defect concentration
diagrams. We implement these tools using Microsoft Excel and Minitab.

Key concepts and tools: Data needs; Data collection; Data presentation; Pivot
tables; Checksheets; Pie charts, Bar charts; Pareto charts; Radar charts; Defect
concentration diagram

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for collecting and presenting the data

2. Identify the type of data to collect

3. Apply Pivot Tables in Excel

4. Implement checksheets

5. Implement pie charts

6. Implement bar charts

7. Implement Pareto charts

8. Implement radar charts

9. Implement defect concentration diagrams

10. Survey other data collection and presentation tools

45
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3.1 Introduction

After we have defined an opportunity for improvement, we proceed to the Measure phase
of DMAIC to collect data about the key inputs and output variables. We can query histor-
ical data if available. Otherwise, we need to gather new data.

3.2 The need for new data

During a quality improvement project, we may have to collect new data if [24]:

1. The required data have never been collected before.

2. The necessary data exist, but they do not answer the right question.

3. The needed data are available but not accessible.

4. The required data are available, but not well-organized.

One natural approach to collecting new data is work sampling, where we observe a
process at random times and record performance indicators of interest [43]. Typically, we
need at least 25 samples to determine the stability of the process [7, 43].

3.3 The types of data to collect

The types of data we collect depend on the nature of the project. At the minimum, the
data we collect should allow us to determine the following baseline measures [24]:

1. WIP1 to quantify the average amount of work in the system yet to be completed.

2. The average completion rate to capture the average number of items or service
units that are completed per given time interval.

3. The lead time or cycle time to obtain the average amount of time that an item or a
service unit spends in the system.

4. The first-pass yield to measure the percent of work that makes it through the
system without rework.

5. Time trap events to help identify possible NVA activities such as the distance from
the last step, the wait time, the number of approvals and handoffs, the setup time,
the levels of learning curves, and reworks activities [24].

6. Defects count to help quantify any aspect of a product or service that is not con-
forming to the standard or the expectation of the customer.

7. Descriptive statistics such as the mean, median, variance, and standard devia-
tion to gauge central tendencies and variability in the process.

1WIP: Work-in-process
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3.4 Tools for collecting and organizing data

Spreadsheet software, such as Excel, are effective mediums for collecting and storing
the process data. To facilitate the application of analytic tools such as Pivot Tables, we
should organize our data in the first normal form by eliminating repeating groups or
multivalued attributes, and ensuring that each row is unique [28]. We exemplify how to
create a first normal form in How-To 3.1.

How-To 3.1 (The first normal form) Table 3.1 depicts data that are not in the first
normal form since attributes have repeating groups. For example, we can see that
the ticket number, the location, and dates are omitted when their values are similar
to those recorded in the previous row. One major problem with storing data in this
manner is that we cannot easily aggregate, filter, or sort them.

Table 3.1: An example of data with repeating groups

Ticket# Location Date Event

1001 PACU 1/2/2018 Software
Data storage/backup
User Interface
Computer virus

1002 ER 1/17/2018 Hardware
Network/server

1003 HIM 2/9/2018 System Configuration
Hardware
Record migration

In Table 3.2, we demonstrate how to reorganize the dataset in Table 3.1 into the
first normal form.

Table 3.2: Data with no repeating groups (first normal form)

Ticket# Location Date Event

1001 PACU 1/2/2018 Software
1001 PACU 1/2/2018 Data storage/backup
1001 PACU 1/2/2018 User Interface
1001 PACU 1/2/2018 Computer virus

1002 ER 1/17/2018 Hardware
1002 ER 1/17/2018 Network/server

1003 HIM 2/9/2018 System Configuration
1003 HIM 2/9/2018 Hardware
1003 HIM 2/9/2018 Record migration
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Remark: Continuous quality improvement efforts require continuous data collection. To the
extent possible, we should attempt to automate the data collection process, and consider storing
our data in a relational database, instead of spreadsheets, to minimize data redundancy and
update anomalies [28].

3.5 Tools for presenting the data

In this section, we introduce essential graphical tools to help summarize and present
data. The specific instruments we consider are checksheets, pie charts, bar charts,
Pareto charts, concentration diagrams, and radar charts. We will review other tools, such
as histograms and control charts, in later modules.

3.5.1 Checksheets

Checksheets are SPC2 tools that we primarily use to summarize defects by their fre-
quency and the time of occurrence. While it is fairly easy to create checksheets man-
ually, we recommend using software such as Excel, as we exemplify next.

Example 3.1 (Checksheets using Excel)
As a health informatics intern at Metropolis Hospital, you were asked to create a
checksheet of information technology (IT) events by month. To accomplish this task,
you decided to use Pivot Tables in Excel to produce a summary shown in Figure
3.1

Figure 3.1: A checksheet of IT events by month, Metropolis Hospital, 2018

Count of Event Column Labels

Row Labels January February March April May June July August September October November December Grand Total

Network/server 14 14 16 9 9 9 9 12 12 9 17 5 135

System Configuration 10 14 23 7 9 9 10 6 8 10 6 13 125

Data storage/backup 10 14 6 4 5 5 3 4 6 4 3 5 69

Computer virus 14 7 5 2 4 3 5 5 1 3 2 51

Interface 6 1 5 3 3 1 5 2 5 2 33

Record migration 1 7 4 2 1 2 3 5 1 3 29

Hardware 3 2 1 1 1 1 9

Software 1 1 1 2 1 6

Power failure 1 1 1 3

Grand Total 58 57 57 31 33 32 31 32 32 33 32 32 460

How-To 3.2 (Pivot Table in Excel 2013) To create a pivot table in Excel 2013:

1. Click on INSERT > Pivot Table (see Figure 3.2)

2SPC: Statistical Process Control
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Figure 3.2: Insert a Pivot Table in Excel 2013

2. Click OK on the Create PivotTable window that pops up (see Figure 3.3)

Figure 3.3: The Create PivotTable window in Excel 2013
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3. Drag the fields of interest into the pan of PivotTable Fields. For example, to
create the checksheet shown in Figure 3.1:

(a) Drag and drop Event into ROWS

(b) Drag and drop Event into VALUES

(c) Drag and drop Month into COLUMNS

See the snapshot in Figure 3.4.

Figure 3.4: The pan of PivotTable Fields in Excel 2013

3.5.2 Pie Charts

Pie charts are graphical tools that we typically use to compare the proportions of different
categories of the same attribute. To create a pie chart, we draw a circle and divide it into
sectors that we call pie slices. The size of each slice is proportional to the share or count
of the respective category. The bigger the slice, the more frequent the category.
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How-To 3.3 (Creating a pie chart in Minitab 18) To create a pie chart in Minitab 18,
click on Graph > Pie Chart > Chart values from table. Upload your data and click
OK. See the screenshot in Figure 3.5.

Figure 3.5: A screenshot of Minitab 18 with a pie chart based on the checksheet
data in Figure 3.1

How-To 3.4 (Creating a pie chart in Excel 2013) To create a pie chart in Excel 2013,
click on INSERT > Pie Chart. Several pie chart layouts are available. See an
example in the screenshot depicted in Figure 3.6.
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Figure 3.6: A snapshot of Excel 2013 with a pie chart based on the checksheet
data in Figure 3.1.

The pie chart in this example reveals that the biggest slice is Network/Server (29%).
The second biggest slice is System Configuration (27%), which is followed by Data
storage/backup slice in the third place of frequency (15%). These three slices con-
stitute about 71% of all IT events.

3.5.3 Bar charts

Bar charts are graphical tools that we use to model categorical and continuous data.
We create bar charts by plotting a series of columns or rows of bars. The height or
the width of each bar is proportional to the frequency of the corresponding category.
In typical applications, we have to arrange bars in some logical order to allow for easy
interpretation. One such arrangement is called Pareto, where bars are arranged in the
descending order of frequency. For continuous data, we bin the data and arrange bars
in the ascending order of the bin index. To show subcategories of major categories, we
arrange bars in a clustered or stacked layout. For time series, we arrange bars in the
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chronological order to time. Alternatively, we could use line charts to model time series.

How-To 3.5 (Creating bar charts in Excel 2013) To create a bar chart in Excel, click
on the INSERT tab > Bar Charts > More Column Charts. Several bar chart layouts
are available. In Figure 3.7a, we show an example of a clustered bar chart. In
Figure 3.7a, we portray a pie-like bar chart, which, in Excel 2013, is Layout 8. We
show an example of a stacked bar chart in Figure 3.13.

Figure 3.7: Bar charts based on the data pictured in Figure 3.1

(a) A clustered column bar chart in Excel 2013 (b) Layout 8 of a bar chart in Excel 2013

How-To 3.6 (Line charts in Excel 2013)
To create a line chart in Excel 2013, select your data > click on INSERT > Line
charts. See the snapshot in Figure 3.8.

Figure 3.8: Options for line charts in Excel 2013

3.5.4 Pareto charts

Pareto charts, also called histograms for attribute data, are primary tools of SPC that
we use to isolate the vital few factors that cause the majority of defects [24]. We often
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associate the 80/20 rule with Pareto charts. This rule generally implies that 20% of the
process steps cause 80% of defects. We can create a Pareto chart by first generating a
bar chart and then arranging the blocks in descending order of the size of the bars.

How-To 3.7 (Creating a Pareto chart in Excel 2013)
To create a Pareto chart in Excel 2013:

1. First, determine the frequency of each category using Pivot Tables or the
COUNTIF () function as follows:

(a) Click on Advanced Filter as shown in Figure 3.9.

Figure 3.9: Advanced Filter in Excel 2013

Figure 3.10: A snapshot of options of bar charts in Excel 2013

(b) On the box that pops up,

i. Select a column for the List range,
ii. Click on Copy to another location,
iii. In Copy to:, choose a cell,
iv. Check the box of Unique records only.
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(c) Now you can apply the COUNTIF() function to tally occurrences of each
event (see Example 3.2).

(d) Sort your results in descending order of frequency.

2. After sorting the frequency of categories, create a Pareto chart by inserting a
bar chart or combo chart (see the snapshot in Figure 3.10).

How-To 3.8 (Creating a Pareto chart in Minitab 18)
To create a Pareto chart in Minitab 18, click on Stat >Quality Tools >Pareto Chart.
In the Defects or attribute data in, select your categories. In the Frequencies in,
select the count of your categories. See the screenshot in Figure 3.11.

Figure 3.11: Pareto chart in Minitab 18 using the checksheet data in Figure 3.1

Example 3.2 (Pareto charts)
In Figure 3.12, we demonstrate how to apply the COUNTIF() function to generate
the frequency of IT events.

Figure 3.12: An example of how to apply the COUNTIF() function in Excel 2013

After counting and sorting the data, we follow instructions in How-To 3.7 to create
one Pareto chart using stacked bars (see Figure 3.13a) and another Pareto chart
using a combo of bars and a line chart of cumulative percents (see Figure 3.13b).
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Figure 3.13: Pareto charts created using Excel 2013.

(a) A stacked Pareto chart (b) A Combo Pareto chart

From the cumulative percent line in the combo chart, we notice that the bars of
Network/server, System Configuration, and Data storage/backup make up about
71% of the events. Figure 3.14 portrays a similar Pareto chart that we created
using Minitab 18.

Figure 3.14: A Pareto chart created using Minitab 18 and the checksheet data in
Figure 3.1
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3.5.5 Defect concentration diagram

A defect concentration diagram is another primary tool of SPC that we commonly use
to visually study the spatial distribution of defects on a physical product or model [43].
We can create this diagram by marking the locations of defects, as we demonstrate in
the next example.

Example 3.3 (Defect concentration diagram)
We are interested in evaluating the quality of the cuboid widget in Figure 3.15 and
make improvements as necessary. From internal inspections and customer com-
plaints, we have marked locations of defects using red color, as shown in Figure
3.15. To improve this widget, we need to investigate all processes associated with
the sites of defects and make appropriate improvements.

Figure 3.15: An example of a concentration diagram

3.5.6 Radar charts

Radar charts that we also call spider charts are graphical tools that we use to compare
categorical data of the same attribute and scale. Structurally, radar charts look like spider
webs with circular lines and axes, hence the name of spider charts. Each axis represents
a distinct category.

How-To 3.9 (Creating a radar chart in Excel 2013)
To create a radar chart in Excel, click on INSERT > Radar chart. See Example 3.4.

Example 3.4 (A radar chart)
A health informatics manager at Metropolis Hospital would like to evaluate the qual-
ity yield of coders’ in the area of inpatient and outpatient. The target is both areas
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is 90%. For this purpose, the manager created a radar chart portrayed in Figure
3.16.

Figure 3.16: An example of a radar chart comparing medical coding yield against
the target

From this chart, we appreciate that Coder4 and Coder6 fail to meet the target in
both areas of coding. Coder3 seems to be the most proficient in both areas of
coding.
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3.6 Check Your Understanding

1. When is it necessary to collect new data for a quality improvement project?

2. What does work sampling entail?

3. What are the benefits of organizing the data in the first normal form?

4. What are the time traps?

5. The amount of time that work spends in the system is captured using which of the
following metrics?

(a) WIP

(b) Lead time

(c) First-pass yield

(d) Time trap

6. What advantages do bar charts have over pie charts?

7. We can create checksheets in Excel by using which menu option?

(a) PivotTable

(b) DataAnalysis add-in

(c) Insert Charts

(d) Create Checksheet

8. If you wanted to create a summary of the count of defects by month, using Piv-
otTable in Excel, you would drag and drop —- (check all that apply).

(a) the field of defects into ROWS

(b) the field of month into VALUES

(c) the field of defects into VALUES

(d) the field of the month into COLUMNS

(e) the field of the month into ROWS

(f) the field of defects into FILTERS

9. What is the ideal tool for comparing the proportions of categories in a dataset?

(a) Pie chart

(b) First normal form

(c) Defect concentration diagram

(d) Line chart
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10. Which chart option in Excel is applicable when constructing histograms?

(a) Bar chart

(b) Pie chart

(c) Scatter plot

(d) Radar chart

11. The 80/20 rule relates to which of the following charts:

(a) Line chart

(b) Pie chart

(c) Pareto chart

(d) Radar chart

12. What is the best tool for representing the frequencies of data entry errors by De-
partment and Work-shift?

(a) Bar chart

(b) Pie chart

(c) Scatter plot

(d) Control chart

13. What tool looks like a bar chart arranged in descending order of frequency?

(a) Pareto chart

(b) Run chart

(c) Control chart

(d) Cause-and-effect diagram

14. You would like to compare the yield of each employee against the target. What
tools can you use for this purpose? (Select all that apply)

(a) Pie chart

(b) Bar chart

(c) Radar chart

(d) Histogram

15. Which of the following tools is preferred for assessing the spatial distribution of
defects on a product?

(a) Defect concentration diagram

(b) Pie diagram

(c) Radar chart
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(d) Checksheet

16. Use the given IT event dataset to create a checksheet.

17. Recreate the pie chart in Figure 3.6 using Excel or Minitab.

18. Recreate the Pareto chart in Figure 3.14 using Minitab. What events constitute
about 80% of the count?

19. Recreate the radar chart in Figure 3.16. Using the same data, also create a corre-
sponding stacked bar chart. Which data presentation chart do you prefer? Justify
your answer

20. How would you go about converting the results from a defect concentration diagram
into numerical values, and what would the benefits of doing so?



MODULE 4

Tools for assessing the process variability and capability

In this module, we review statistical and graphical tools for assessing
process variability and capability. Some of the graphical tools we dis-
cuss include histograms, stem-and-leaf diagrams, box plots, and control
charts. We also demonstrate how to calculate statistical ratios for eval-
uating the capability of the process. For software, we use Minitab and
Excel.

Key concepts and tools: Random sampling; Sample statistics; Variability; Proba-
bility distributions; Central limit theorem; Point estimators; Potential capability; Actual
capability; PCR1; Histograms; Stem-and-leaf diagrams; Box plots; Control charts

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for assessing variability and capability

2. Appraise the implication of variability on quality

3. Compute sample statistics

4. Explain the basic notion of the central limit theorem

5. Master statistical measures of variability

6. Create histograms

7. Examine stem-and-leaf diagrams

8. Implement box plots

9. Analyze capability ratios

10. Interpret probability plots

1PCR: Process capability ratio

62
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4.1 Introduction

In this module, we discuss statistical and graphical tools for assessing variability and
capability in the process. We recall that to improve quality, we must be able to evaluate
and reduce variability in the process. Additionally, our process must be capable of
meeting the specifications of the customer. The methods we consider include various
statistical measures and graphical tools. For software, we use Minitab and Microsoft
Excel.

4.2 Statistical background

4.2.1 Process sampling

Sample

In most quality improvement projects, it is not practical to observe and record everything
that is happening in the process at all times. Even if such efforts were practical, they
would likely be prohibitively expensive and time-consuming. A simplified approach is to
use portions of the process to infer the performance of the entire process.

Definition 4.1 A sample, also referred to as subgroup, is a smaller set of mea-
surements that we take from a larger set of the population measurements.

Terminology

We use the word population to suggest the entire process and the term statistic to
indicate a statistical measure of the process, such as the mean (or the average) and the
variance. The words infer and inference imply that we are making conclusions about
the population using sample statistics. We will frequently use the expression sampling
distribution to refer to the probability distribution of any sample statistic, most often the
sample mean. We use letter 𝑛 to denote the sample size (e.g., number of features) and
letter 𝑚 to symbolize the total number of samples that we call sample number (e.g.,
number of training examples).

Sampling techniques

Several sampling techniques apply to quality improvement, such as random sampling,
where each item in the process has an equal chance of being selected. In systematic
sampling, we set conditions for including an item in the sample (e.g., selecting every item
in a prescribed position). In stratified sampling, we create distinct strata (e.g., groups)
and choose an item from each stratum randomly or systematically. In cluster sampling,
we group the population into naturally occurring clusters (e.g., geographical regions) and
then sample from each cluster randomly or systematically. Both the stratified and cluster
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sampling techniques tend to reduce bias by representing all relevant segments of the
population [37].

Sampling musts

We must choose the proper sample size and the frequency of sampling to allow for
more accurate inferential conclusions about our process. This requirement is particularly
important for successful deployments of control charts to monitor the stability of the pro-
cess. One rule of thumb is to take at least 25 samples before drawing any conclusions
about the stability of a process [43]. In general, the larger the sample size, the more
likely we are to detect unstable instances or out-of-control behaviors in the process. But,
the practicality of large samples is not always feasible. Instead, we try to take smaller
samples, but more frequently [43].

It is also imperative that when sampling, we ensure rational subgroups to promote
the independence of the samples. By this, we imply that we should seek to maximize the
difference between the samples while minimizing the difference within each sample. A
natural approach to obtaining rational subgroups is sampling from units produced dur-
ing the same time interval (e.g., same day). Another approach is sampling only from
units produced since the last subgroup [43]. Without rational subgroups, erroneous
conclusions about the stability of the process are likely, especially when samples were
initially assumed to be independent.

4.2.2 Sample statistics

Typical sample statistics include the mean 𝑥, the variance 𝑠2, and the standard devia-
tion 𝑠 =

√
𝑠2. Given a sample of size 𝑛, say (𝑥1,𝑥2, . . . ,𝑥𝑛), we calculate the statistics 𝑥,

𝑠2, and 𝑠, as follows:

𝑥 =
1
𝑛

𝑛∑︁
𝑖=1

𝑥𝑖 (4.1)

𝑠2 =
1

𝑛− 1

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (4.2)

𝑠 =

⎯⎷
1

𝑛− 1

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (4.3)

We commonly refer to
∑︀𝑛

𝑖=1(𝑥𝑖 − 𝑥)2 as the sum of squares (SS) and 1
𝑛−1

∑︀𝑛
𝑖=1(𝑥𝑖 − 𝑥)2

as the mean square (MS). Here, 𝑛 − 1 signifies the degrees of freedom or simply the
number of independent values in a statistic [36]. We use the sample mean to estimate
the average behavior of the process. Both the variance and standard deviation are non-
negative measures of variability in the process. The bigger these quantities, the more
variable the process and thus the inferior the quality. Unlike the variance which expresses
squared variation measures, the standard deviation quantifies the process variability in
the original units.
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How-To 4.1 (Sample statistics in Excel 2013)

1. To calculate the sample mean, use the 𝐴𝑉𝐸𝑅𝐴𝐺𝐸() function.

2. To calculate the sample variance, use the 𝑉𝐴𝑅.𝑆() function.

3. To calculate the sample standard deviation, use the 𝑆𝑇𝐷𝐸𝑉 .𝑆() function.

You can also calculate sample statistics via the Data Analysis add-in > Descriptive
Statistics > select your input range > check the option of Statistics summary > OK.

If the Data Analysis add-in is not loaded in your Excel spreadsheet, you can
add it by clicking on File >Options > Add-ins > Analysis ToolPak > Manage: Excel
Add-in > Check the box of Analysis ToolPak >OK.

How-To 4.2 (Sample statistics in Minitab 18)
To calculate the sample mean, variance, and standard deviation in Minitab 18, click
on Stat > Basic Statistics > Display Descriptive Statistic > load your data into Vari-
ables >OK.

Example 4.1 (Basic Statistics)
The manager of Metropolis Clinic has received several patient complaints about
long waiting times. To investigate the matter, the manager performed a retrospec-
tive audit of 5 random visits each day for the last 25 days. The manager collected
data in Excel, as displayed in Table 4.1.
From Table 4.1, we can deduce the following:

1. The sample size n = 5, since on each day, the manager selected five random
visits.

2. The sample number m = 25 since overall, there are 25 samples.

3. The manager calculated the sample mean 𝑥 and the sample variance 𝑠2

using Excel. For example, the manager calculated the mean of the sample
on day # 1 as = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵3 : 𝐹3), which equals 1.32. To determine the
variance of this sample, the manager used = 𝑉𝐴𝑅.𝑆($𝐵$3 : $𝐹$3), which
resulted in 0.16075. To obtain the standard deviation of the same sample,
the manager used = 𝑆𝑇𝐷𝐸𝑉 .𝑆($𝐵$3 : $𝐹$3). Alternatively, the manager
could have determined the standard deviation using = 𝑆𝑄𝑅𝑇 ($𝐻$3). By
inserting the $ sign in the formulas, the manager was able to populate the
rest of the values by dragging down the formulas.

4. To ensure rational subgroups, the manager took one sample each day with
the assumption that waiting times were relatively the same on each day, and
daily visits were independent.
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Table 4.1: A random sample of waiting times in hours, Metropolis Clinic

A B C D E F G H I

1
Day #

Sample size
𝑥 𝑠2 𝑠2 1 2 3 4 5

3 1 1.1 1.5 1.25 0.85 1.9 1.32 0.16 0.4
4 2 2.6 2.6 2.1 2.8 2.95 2.61 0.1 0.32
5 3 2.05 2.8 1.15 1 1.6 1.72 0.53 0.73
6 4 2.4 1.3 2.95 2.9 3 2.51 0.52 0.72
7 5 1.15 2.4 1.4 2.05 1.75 1.75 0.25 0.5
8 6 1.95 2.45 0.55 2.35 2.4 1.94 0.64 0.8
9 7 0.95 1.3 1.2 1.1 1.6 1.23 0.06 0.24

10 8 2.55 1.3 2.5 2.45 2.15 2.19 0.27 0.52
11 9 2.05 1.5 0.9 2.25 1.45 1.63 0.29 0.54
12 10 1.5 1.25 2.35 2 0.75 1.57 0.39 0.62
13 11 2 3 3 1.1 1.95 2.21 0.65 0.81
14 12 0.6 2.4 2.2 0.65 2.75 1.72 1.04 1.02
15 13 2 2.15 1.9 2.2 1.2 1.89 0.16 0.4
16 14 1.65 0.5 2.2 1.95 1.1 1.48 0.47 0.69
17 15 1 2.8 1.85 0.8 2.8 1.85 0.91 0.95
18 16 2.55 2.95 1.25 0.95 1.9 1.92 0.71 0.84
19 17 1.2 0.55 1.25 2.9 0.7 1.32 0.87 0.93
20 18 3 1.35 1.05 2.25 1.95 1.92 0.59 0.77
21 19 1 1.45 0.95 3 1.35 1.55 0.7 0.84
22 20 1.25 2.95 1.7 1.7 1.15 1.75 0.51 0.71
23 21 1.85 2.55 0.55 0.95 1.8 1.54 0.63 0.79
24 22 2.75 2.25 1 1 2.8 1.96 0.81 0.9
25 23 0.65 0.9 0.55 2.3 3 1.48 1.22 1.1
26 24 2.35 1.3 1.8 2.25 2.05 1.95 0.18 0.42
27 25 0.5 2.35 0.7 3 2.55 1.82 1.3 1.14

¯̄𝑥 𝑠2 𝑠

1.79 0.56 0.71
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4.2.3 Probability distributions

Several probability distributions apply for quality improvement in health care informatics.

Definition 4.2 (Probability distribution)
A probability distribution is a mathematical function that relates each value of a
random variable to a real number between 0 and 1 to express the relative chances
of that value occurring.

In Box 4.1, we grouped the most common probability distributions into classes of dis-
crete and continuous. We apply discrete distributions to model processes that generate
random attribute data (e.g., number of data entry errors), whereas we use continuous
distributions to model processes that generate random variable data (e.g., duration of
system downtime).

Box 4.1 Common Probability Distributions

Type Name
Probability
Distribution

Mean
𝜇 =

Variance
𝜎2 =

Discrete

Bernoulli 𝑝(𝑥) =

⎧⎪⎪⎨⎪⎪⎩𝑝 𝑥 = 1
1− 𝑝 𝑥 = 0

𝑝 𝑝(1− 𝑝)

Binomial
𝑝(𝑥) =

(︃
𝑛
𝑥

)︃
𝑝𝑥(1− 𝑝)𝑛−𝑥

𝑥 = 0,1, . . . ,𝑛
𝑛𝑝 𝑛𝑝(1− 𝑝)

Geometric 𝑝(𝑥) = (1− 𝑝)𝑥−1𝑝
𝑥 = 1,2, . . .

1
𝑝

1− 𝑝
𝑝2

Poisson 𝑝(𝑥) =
𝑒−𝜆𝜆𝑥

𝑥!
𝑥 = 0,1, . . . ;𝜆 > 0

𝜆 𝜆

Continuous
Normal

𝑓 (𝑥) =
1

𝜎
√
2𝜋

𝑒−
1
2(

𝑥−𝜇
𝜎 )2

−∞ < 𝑥 <∞
−∞ < 𝜇 <∞,𝜎 > 0

𝜇 𝜎2

Exponential 𝑓 (𝑥) = 𝜆𝑒−𝜆𝑥

𝑥 ≥ 0;𝜆 ≥ 0
1
𝜆

1
𝜆2

It follows that for discrete distributions, 0 ≤ 𝑝(𝑥) ≤ 1 and
∑︀

𝑥 𝑝(𝑥) = 1. For continu-

ous random variables, 0 ≤ 𝑝(𝑎 ≤ 𝑥 ≤ 𝑏) =
∫︀ 𝑏

𝑎
𝑓 (𝑥)𝑑𝑥 ≤ 1 and

∫︀∞
−∞ 𝑓 (𝑥)𝑑𝑥 = 1.
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Example 4.2 (Applying probability distributions to model data quality)
As a health care informatician at Metropolis Hospital, you are charged with assur-

ing data quality in the electronic health record system. In your work, you classify a
record as deficient when it has at least one data quality issue. If you were interested
in modeling the probability of a deficient record, you would apply the Bernoulli ran-
dom variable. If you were interested in the probability of the number of records with
data quality issues, you would utilize the binomial random variable. You would use
the Geometric random variable to model the number of discharges until a record
has a data quality issue. To model the count of data quality issues per record, you
would use the Poisson random variable. You would use the exponential random
variable to model the time until a data quality problem occurs. To model the aver-
age amount of time required to fix a data quality issue, you would use the normal
random variable. In all these scenarios, quality issues are assumed to occur inde-
pendently. Additional assumptions may apply depending on the chosen distribution.

4.2.4 Normal distribution

During quality improvement projects, we tend to assume that our samples were drawn
from a normally distributed process. This common assumption is the result of the
central limit theorem (CLT).

CLT

Definition 4.3 (CLT and the sample mean)
Regardless of the population probability distribution, the sampling distribution of the
sample mean 𝑥 with size 𝑛, drawn from a population with mean 𝜇 and variance 𝜎2,
is about normally distributed and can be modeled as follows [43].

𝑥 ∼𝑁𝑜𝑟𝑚𝑎𝑙

(︃
𝜇,

𝜎2

𝑛

)︃
(4.4)

It follows that as 𝑛→∞,

𝑍 =
𝑥 −𝜇
𝜎/
√
𝑛
∼𝑁𝑜𝑟𝑚𝑎𝑙(0,1) (4.5)

We commonly refer to the 𝑍 statistic in Definition 4.3 as the Z-score. The numerator
of this statistic, 𝑥 − 𝜇, is known as the sampling error whereas its denominator, 𝜎/

√
𝑛,

is referred to as the standard error [36]. By mapping 𝑍 into a probability space, as
Φ(𝑍), we obtain the probability 𝑝 of a given standard value being less than 𝑍. To find the
probability of a standard value being greater than Z, we calculate 1−Φ(𝑍). It follows that
𝑍 = Φ−1(𝑝).
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How-To 4.3 (Φ(𝑍) in Minitab 18)
Store your Z-score value in a given column then click on Calc > Probability Distri-
butions > Normal > Input column >OK.

How-To 4.4 (Φ(𝑍) in Excel 2013)
To calculate Φ(𝑍) in Excel 2013, use this cumulative distribution function: =
𝑁𝑂𝑅𝑀.𝑆.𝐷𝐼𝑆𝑇 (𝑍,1).

Example 4.3 (Z-score)
The expected mean and standard deviation of your process include 𝜇 = 30 and
𝜎 = 4, respectively. If you drew a sample of size 10 records and found the mean to
be 32, what would be the probability of observing a sample mean less than 32? To
solve this problem, proceed as follows:

𝑍 =
𝑥 −𝜇
𝜎/
√
𝑛
=
32− 30
4/
√
10

= 1.58 (4.6)

You can find the probability of interest in Excel by = 𝑁𝑂𝑅𝑀.𝑆.𝐷𝐼𝑆𝑇 (1.581,1) =
0.943. To calculate the probability of observing a sample mean greater than 32,
use 1−Φ(𝑍) = 1− 0.943 = 0.057.

Sampling distributions related to Normal

Typical sampling distributions that relate to Normal are Chi-square ( 𝜒2), t-distribution,
and F-distribution. We characterize these distributions as follows:

1. Given independent and normally distributed sample data points 𝑥1,𝑥2, . . . ,𝑥𝑛, where
𝜎 is known, 𝑦 = 𝑥21 +𝑥22 + · · ·+𝑥2𝑛 is distributed according to 𝜒2 with 𝑛−1 degrees of
freedom (𝜒2

𝑛−1). We can express 𝑦 as follows [43]:

𝑦 =
1
𝜎2

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (4.7)

≡ (𝑛− 1)𝑠2

𝜎2 ∼ 𝜒2
𝑛−1 (4.8)

2. If 𝜎 is unknown, if follows that:

𝑥 −𝜇
𝑠/
√
𝑛
∼𝑁 (0,1)

⧸︃√︃
𝜒2
𝑛−1

𝑛− 1
(4.9)

We refer to Equation 4.9 as the t-distribution, or Student’s t-distribution, with
𝑛 − 1 degrees of freedom [43]. We typically use this distribution to compare the
means between two small samples, where we don’t know the population standard
deviation.
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3. The ratio between two independent Chi-square random variables 𝑤 and 𝑦 with
respective degrees of freedom 𝑢 and 𝑣, is distributed according to F-distribution,
as follows [43]:

𝐹𝑢,𝑣 =
𝑤/𝑢
𝑦/𝑣

(4.10)

We often use the F-distribution in the analysis of variance (ANOVA) to test the
equality of the means from independent samples drawn from normally distributed
populations with equal variances.

4.2.5 Probability plots

A probability plot is a visual statistical tool that we can employ to validate our assumptions
regarding the probability distribution of our process. We can approximate a probability
plot by fitting a line to data (e,g., data that fall between the 25th and the 75th percentiles)
[43]. If the hypothesized probability distribution were reasonable, points would fall along
the fitted line. We will often use this technique to verify the normality assumption.

How-To 4.5 (Normal probability plot in Excel 2013)
There is no dedicated option in Excel 2013 to create a probability plot unless one fits
a regression model. But, we can approximate this plot manually, as we demonstrate
in Example 4.4.

How-To 4.6 (Normal probability plot in Minitab 18)
Click on Graph > Probability Plot > Single >Select your data > OK. To change the
type of distribution, click on the Distribution tab. See the snapshot in Figure 4.1.
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Figure 4.1: Options for a normal probability plot in Minitab 18

Example 4.4 (Estimating the normal probability plot in Excel 2013)
Table 4.2 presents random samples of operating room times of twenty random la-
paroscopic herniorrhaphy cases at Metropolis Hospital. The first column 𝑖 enumer-
ates the samples. The second column depicts operating room times in minutes
𝑥(𝑖). The third column presents the cumulative frequencies given by 𝑖 − 0.5/𝑛. All
columns are arranged in ascending order.

Table 4.2: Operating room times in minutes 𝑥(𝑖), laparoscopic herniorrhaphy,
Metropolis Hospital, January 2019

𝑖 𝑥(𝑖) (𝑖 − 0.5)/𝑛 𝑖 𝑥(𝑖) (𝑖 − 0.5)/𝑛

1 50.46 0.025 11 54.92 0.525
2 50.69 0.075 12 56.31 0.575
3 50.69 0.125 13 57.39 0.625
4 51.26 0.175 14 57.82 0.675
5 51.91 0.225 15 58.18 0.725
6 52.03 0.275 16 58.62 0.775
7 52.11 0.325 17 58.81 0.825
8 52.29 0.375 18 60.15 0.875
9 53.5 0.425 19 60.92 0.925
10 54.78 0.475 20 60.94 0.975
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Figure 4.2 shows the setup of Excel for approximating a normal probability plot of
the data in Table 4.2. The first step is creating a scatter plot between 𝑥(𝑖) and
(𝑖 −0.5)/𝑛. The second step is right-clicking on any data point and adding a linear
trend line.

Figure 4.2: Approximating a normal probability plot of the data in Table 4.2

A B C

1 i x(i) (i-0.5)/n

2 1 50.46 0.025

3 2 50.69 0.075

4 3 50.69 0.125

5 4 51.26 0.175

6 5 51.91 0.225

7 6 52.03 0.275

8 7 52.11 0.325

9 8 52.29 0.375

10 9 53.5 0.425

11 10 54.78 0.475

12 11 54.92 0.525

13 12 56.31 0.575

14 13 57.39 0.625

15 14 57.82 0.675

16 15 58.18 0.725

17 16 58.62 0.775

18 17 58.81 0.825

19 18 60.15 0.875

20 19 60.92 0.925

21 20 60.94 0.975
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From the probability plot in Figure 4.2, we notice that the points tend to fall along
the fitted line. Thus, we conclude that the data in Table 4.2 are about normally
distributed.

We reproduced a similar plot using Minitab 18, as portrayed in Figure 4.3.
Minitab results also show the p-value that we can use to make a conclusion about
a hypothesis that the data in Table 4.2 are normally distributed. The given p-value
is 0.074, which is greater than 1 − 95% = 0.05. Accordingly, we fail to reject the
null hypothesis that the data in Table 4.2 are normally distributed at the 95%
confidence level. We will discuss more about p-values in Module 7.
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Figure 4.3: A normal probability plot of the data in Table 4.2 created using Minitab

4.2.6 Point estimators

In this subsection, we review the point estimation methods for the population mean and
standard deviation parameters.

Definition 4.4 A point estimator is a statistic that we calculate from the process
samples to estimate the population parameter [43].

The sample mean 𝑥 and variance 𝑠2 are unbiased point estimators of the correspond-
ing population mean 𝜇 and variance 𝜎2 since

𝐸(𝑥) = 𝜇 (4.11)
𝐸(𝑠2) = 𝜎2 (4.12)

Here, 𝐸 symbolizes expectation. But, the sample standard deviation is a biased point
estimator of the population standard deviation 𝜎 , since

𝐸(𝑠) , 𝜎 (4.13)
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Continuous process

For continuous processes with the sample size 𝑛 > 10, we can approximate the unbiased
estimator of 𝜎 this way:

𝜎 ≈ 𝑠
𝑐4

(4.14)

where 𝑠 is the mean of the sample standard deviations and 𝑐4 is a constant that varies
with 𝑛, as indicated in Appendix Table 1. When the sample size 𝑛 ≤ 10, we approximate
the unbiased estimator of 𝜎 as follows:

𝜎 ≈ �̄�
𝑑2

(4.15)

where �̄� is the mean of sample ranges and 𝑑2 is a constant that also varies with 𝑛, as
indicated in Appendix Table 1 [43].

Discrete processes

For processes that generate attribute data, we can approximate the mean 𝜇 like this:

𝜇 ≈ �̄� (4.16)

where �̄� is the mean of the corresponding Bernoulli distribution. We apply the following
approximation for the standard deviation 𝜎 :

𝜎 ≈ 𝜎 =

√︂
�̄�(1− �̄�)

𝑛
(4.17)

where 𝑛 denotes sample size as before.

Example 4.5 (Point estimation)
This example is a follow-up to Example 4.1 and demonstrates how to calculate point
estimators using the data in Table 4.1.

1. The manager determined the average of all sample means as ¯̄𝑥 =
1
25

∑︀25
𝑖=1𝑥𝑖 = 1.7932. This value is the unbiased estimator of the un-

known process mean 𝜇. The manager obtained this value in Excel using
= 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐺3 : 𝐺27).

2. The manager took the average of all sample variances 𝑠2 = 1
25

∑︀25
𝑖=1 𝑠

2
𝑖 =

0.55877. This value is the unbiased estimator of the unknown pro-
cess variance. In Excel, the manager programmed this formula as =
𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐻3 :𝐻27).

3. The manager obtained the average of the standard deviations like this:
𝑠 = 1

25
∑︀25

𝑖=1 𝑠𝑖 . In Excel, the manager programmed this formula as
𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐼3 : 𝐼27), which resulted in 0.708911687. To determine the unbi-
ased estimator of the unknown process standard deviation, the manager
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used Equation 4.14 as 𝑠
𝑐4

= 0.708911687
0.94 = 0.75416137. The value of 𝑐4 was

obtained from Appendix Table 1 when 𝑛 = 5.

4.3 Process variability

In typical quality improvement projects, we use the sample variance or standard deviation
to assess variability. If the quality metric of interest, say the process mean, is close to
target, we can infer that the process has little variability. In other words, the process
is stable. In contrast, a sample statistic that is further from the target is indicative of a
process with high variability.

4.3.1 Control charts

We can conduct a hypothesis test of whether the process is stable. This test is implied
in control charts when monitoring variability in the process. When a sample statistic falls
outside of the control limits, we reject the null hypothesis that the process is stable. See
an example of a control chart in Figure 4.4. As it is evident in this figure, sample 5 falls
outside of the lower limit, which points to an unstable process. We will return the topics
of hypothesis tests and control charts in later modules.

Figure 4.4: An example of a control chart
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4.3.2 Histograms

A histogram is a type of bar chart that we use to asses variability in processes that
generate continuous data.
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Constructing a histogram

To construct a histogram, we first group data into bins, also called intervals or classes.
We must choose an appropriate binning strategy for a histogram to be informative. Given
the lack of a universal agreement about how to structure the bins, one common rule of
thumb to select the number of bins 𝑘 such that:

𝑘 =
⌈︂√

𝑛
⌉︂

(4.18)

where 𝑛 is the number of observations in the data and the ceiling symbols ⌈.⌉ signify
rounding up. Another formula that we can use follows from Sturges’ rule and looks like
this [43]:

𝑘 = 1+ log2𝑛 (4.19)

where log is a mathematical symbol for logarithm. After deciding on the number of bins,
we calculate the width of each bin ℎ like this:

ℎ =
max(𝑥)−min(𝑥)

𝑘
(4.20)

where 𝑥 represents the sample data. Subsequently, we determine the range of the bins
as follows:

𝑏𝑖𝑛1 = [min(𝑥), min(𝑥) + ℎ+1) (4.21)
𝑏𝑖𝑛2 = [min(𝑥) + ℎ+1, 𝑚𝑖𝑛(𝑥) + 2ℎ+1) (4.22)

...

𝑏𝑖𝑛𝑘 = [min(𝑥) + (𝑘 − 1)ℎ+1, min(𝑥) + 𝑘ℎ+1) (4.23)

Finally, we throw each observation into the bin with a suitable range, and construct a
histogram by graphing a bar chart in ascending order of the bin index (e.g., 𝑏𝑖𝑛1, . . . , 𝑏𝑖𝑛𝑘).

Interpreting a histogram

By visually examining the shape of a histogram, we can make inferences about the pro-
cess variability regarding the skewness, kurtosis, modality, and the likely probability distri-
bution. We can also learn about other characteristics of the process, such as the central
tendency (e.g., mean or median) and outliers. We show examples of typical histograms
in Figure 4.5.
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Figure 4.5: Examples of histograms

(a) Unimodal (b) Multimodal

(c) Left skewed (d) Right skewed

Figure 4.5a shows a bell-shaped unimodal (one peak) histogram suggesting a normal
distribution with the mean around 100. Figure 4.5b shows a multimodal histogram that
suggests a mixture of probability distributions. Figure 4.5c shows a histogram with a
left-skewed distribution. Figure 4.5d displays a histogram with a right-skewed distribution
and a possible outlier in bin 100. Histograms with fewer outliers will generally have a
low kurtosis measure. The latter quantity describes the degree of the peakedness and
flatness (e.g., heavy-tail or light-tail) of the given distribution as compared to the normal
distribution [19].

How-To 4.7 (Creating a histogram in Excel 2013)
To construct a histogram in Excel, follow these steps:

1. First, load the Data Analysis Tools add-in. In Excel 2013, you should see
this add-in by clicking on the Data tab and looking under Analysis, as we
illustrate in Figure 4.6.

Figure 4.6: Data Analysis add-in in Excel 213
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If the add-in is not loaded, you can load it by clicking on File >Options > Add-
ins > Analysis ToolPak > Manage: Excel Add-in > Check the box of Analysis
ToolPak >OK.

2. Input all your data into one column

3. Determine the range of each bin (see Equations 4.21 - 4.23).

4. Next, click on Data Analysis > Histogram > select your sample data for Input
Range >select 𝐵𝑖𝑛_𝑚𝑎𝑥 data for Bin Range > check Chart Output. See the
snapshot in Figure 4.7.

Figure 4.7: Histogram options in Excel 2013

5. Instead of the Data Analysis add-in, you can also use the COUNTIFS() func-
tion to tally observation in each bin. For example, in reference to Figure 4.7,
you can count the number of observations that fall in the range of cells C2
and D2, as follows: =COUNTIFS(𝐵1:𝐵65,">="&C2,𝐵1:𝐵65,"<"&D2)

How-To 4.8 (Creating a histogram in Minitab 18)
To construct a histogram in Minitab, follow these steps:

1. Click on Graph > Histogram > Simple > Select your data > OK.

2. To change the number of bins, double-click on any bar in the histogram >
Binning tab> select the Number of Intervals> input the desired number > Ok.

3. To create a cumulative histogram, click on Graph > Histogram > Simple >
Select your data > Scale > Y-Scale Type > check Percent and Accumulative
values across bins > OK.
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Remark: We recommend using Minitab to create histograms instead of Excel since the former
gives the user more control to change the inputs. Minitab also allows for fitting distributions to
data, an option that Excel 2013 does not have.

4.3.3 Stem-and-leaf diagrams

Just like histograms, we use stem-and-leaf diagrams to asses variability in continuous
data.

Constructing a stem-and-leaf diagram

To create a stem-and-leaf diagram, we first generate the stems and then match the lead-
ing digit(s) of our observations to the appropriate stem. The remaining digits constitute
leaves that we arrange in ascending order. We typically create stems using numbers
between 0 and 9. For example, if we had an observation 76, 7 would be matched to
the stem of 7 and 6 would be part of the leaf. Stems with no leaves are deleted. In a
full-stem, all numbers with the same stem create one leaf. In a half-stem, two leaves
result from a single stem. Half-stem-and-leaf diagrams tend to exhibit flatter distributions
as compared to the diagrams of full-stems.

Example 4.6 (Half-stem vs. Full-stem) In a full-stem, observations 76, 70, 73, and
79 create one leaf as follows: 7 0369. In a half-stem, we would have two leaves
that split at 75. One leaf would look like this 7 03, and the other would be as follows
7 69.

Interpreting a stem-and-leaf diagram

Just like in histograms, the shape of a stem-and-leaf diagram informs us about the pro-
cess central tendency, skewness, outliers, and the likely probability distribution. By the
central tendency here, we are generally referring to the median or the 50th percentile of
the data. To find the position of a given percentile, we use the following formula [36]:

𝑝𝑜𝑠𝑖𝑡𝑖𝑜𝑛 = (𝑝𝑒𝑟𝑐𝑒𝑛𝑡𝑖𝑙𝑒) * (𝑛+1) (4.24)

where 𝑛 is the number of observations.

How-To 4.9 (Creating a steam-and-leaf diagram in Minitab 18)
To create a stem-and-leaf diagram in Minitab 18:

1. Click on Graph > Stem-and-Leaf > select your data >OK.

2. To change the number of stems, enter the increment number of 5 or 10 in the
increment box. The increment of 10 is for creating full-stems, whereas the
increment of 5 is for creating half-stems.
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Example 4.7 (Stem-and-leaf diagram) The data in Table 4.3 shows a sample of
days in accounts receivable at Metropolis Clinic. We will help the manager assess
variability in this dataset.

Table 4.3: Days in Patient Accounts Receivable at Metropolis Clinic

38 47 30 22 32 51 40 32 31 36 24 26 57 14 38 26
15 31 20 26 41 28 40 37 48 28 32 44 39 45 33 20
47 32 26 32 27 38 28 34 27 37 28 11 42 25 33 23
59 14 50 28 24 17 21 38 28 14 30 34 11 36 41 34

In Figure 4.8, we show two types of histograms that we created using Minitab 18.
We used Equation 4.18 to change the number of bins to 8. Concerning Figure 4.8a,
we can infer that the data are about normally distributed with the central tendency of
about 32 days on average. We fitted a normal distribution to the data, which agrees
with the apparent normality of the dataset. In Figure 4.8b, we present a cumulative
histogram that we can use to infer probabilities of interest. For example, we can
conclude that about 86% of the claims have about 40 or fewer days in accounts
receivable.

Figure 4.8: Histograms created in Minitab 18 using the data in Table 4.3

(a) A bell-shaped histogram (b) A cumulative histogram

Using the same data, we created two stem-and-leaf diagrams, as portrayed in Fig-
ure 4.9.
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Figure 4.9: Stem-and-leaf diagrams created in Minitab 18 using data in Table 4.3

(a) A half-stem diagram (increment 5) (b) A full-stem diagram (increment 10)

The first column of the stem-and-leaf diagrams in Figure 4.9 portrays the cumu-
lative count of leaves from both ends until we reach the median. Minitab uses
parentheses () to show a leaf that contains the median. If the median results from
two leaves, Minitab does not display the parentheses. Using Equation 4.24, we can
find the position of the median, of the 50th percentile, as follows:

𝑝𝑜𝑠𝑖𝑡𝑖𝑜𝑛 = (𝑝𝑒𝑟𝑐𝑒𝑛𝑡𝑖𝑙𝑒) * (𝑛+1)
= 0.50 * (64+ 1)
= 32.5

If we were interested in the position of the 90th percentile, we would find it like this:

𝑝𝑜𝑠𝑖𝑡𝑖𝑜𝑛 = (𝑝𝑒𝑟𝑐𝑒𝑛𝑡𝑖𝑙𝑒) * (𝑛+1)
= 0.90 * (64+ 1)
= 58.5

We should note that the position of a percentile is different than the actual value of
the percentile. For example, to determine the actual value of the 50th percentile in
this example, we first have to find the difference between the values in the 32nd and
33rd positions and then multiply that difference with the decimal in the percentile
position (0.5 in this example). We then add the result to the value in the 32nd
position. In our example, the values in the 32nd and 33rd positions are 32 and 32,
respectively. So, the value of the 50th percentile is 0.5*(32-32) + 32 = 32.
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4.3.4 Box plots

We use box plots, also called box and whisker diagrams, to assess variability in the
process in terms of the skewness, symmetry, and potential outliers in the data. We also
can use box plots to estimate the central tendency of the process using the mean or
median statistics.

Constructing a box plot

To construct a box plot, we connect a rectangular box in the middle of two opposing
straight lines that we call whiskers. The outer end of a whisker represents the minimum
or maximum value of the data. The inner ends that connect to the box coincide with the
first quartile (Q1) or the third quartile (Q3). We also draw a perpendicular line inside the
box to represent the second quartile (Q2) or the median of the data. Figure 4.10 portrays
two typical representations of box plots.

Figure 4.10: Horizontal and vertical representations of box plots

(a) Vertical representation (b) Horizantal representation

We refer to the difference between Q3 and Q1 as the interquartile range (IQR).
We use the latter quantity to characterize the amount of variability in the data [43]. The
bigger the IQR, the more variability in the process. The asymmetry of whiskers implies
skewness toward the longer whisker. In some statistical software such as Minitab, the
whiskers only have a length of 1.5*IQR. We consider any data point that falls beyond this
length, an outlier.

How-To 4.10 (Creating a box plot in Minitab 18)
To create a box plot in Minitab, click on Graph > Boxplot > select the type of boxplot>
select your data >>OK .

How-To 4.11 (Finding quartiles in Excel 2013)
To find quartiles in Excel 2013, use this function: =
𝑄𝑈𝐴𝑅𝑇 𝐼𝐿𝐸.𝐼𝑁𝐶(𝑦𝑜𝑢𝑟𝑑𝑎𝑡𝑎,𝑞𝑢𝑎𝑟𝑡𝑖𝑙𝑒_𝑛𝑢𝑚𝑏𝑒𝑟)
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Example 4.8 (Box plot)
Using the data in Table 4.3, we drew a box plot that we portray in Figure 4.11.

Figure 4.11: A box plot drawn using the Python software and the data in Table 4.3
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We determined the quartiles to be Q1 = 26, Q2 = 32, and Q3 = 38. This meant
that IQR = 38 - 26 = 12. We drew the whiskers with a length of 1.5*IQR = 12*1.5
= 18. As a result, we appreciated two potential outliers, which suggest slight right
skewness. Without these outliers, the data would be symmetric around the median.
We used Seaborn, a module for the Python software, to draw the box plot in Figure
4.11, which allowed us not only to show outliers but also the swam points [58].
Figure 4.12 portrays a box plot drawn using Minitab, which also shows the outlier
points. Excel does not have convenient options to draw box plots.

Figure 4.12: A box plot drawn using Minitab based on the data in Table 4.3
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4.4 Process capability

During quality improvement efforts, we conduct capability analysis to help answer the
question of whether our process is capable of meeting the customer’s specification limits
or standards. For example, in health care, we want to know whether our process can meet
various guidelines from regulating and accrediting agencies. An important pre-requisite
to capability analysis is the stability of the process.

Definition 4.5 Capability analysis is a technique that involves measuring the uni-
formity of the process, given the specification limits and variability in the process
[43].

Several techniques for conducting capability analysis exist. Here, we emphasize the
use of graphical techniques such as histograms and process capability ratios (PCRs) like
𝐶𝑝.

4.4.1 The 𝐶𝑝 ratio

Given the customer’s upper specification limit (USL) and lower specification limit (LSL),
we utilize the 𝐶𝑝 ratio to measure the potential capability of a process. We formulate this
ratio as follows:

𝐶𝑝 =
𝑈𝑆𝐿−𝐿𝑆𝐿

6𝜎
(4.25)

where 𝜎 represents the process variability in standard deviation units. We obtain 6𝜎
from the sum of 3𝜎 below the mean 𝜇 and 3𝜎 above the mean. We recall that 99.73% of
the normally distributed process falls within 𝜇 ± 3𝜎 . Since 𝜇 is not part of the formula in
Equation 4.25, we cannot conclude anything about the process mean using the 𝐶𝑝 ratio.
To make such a conclusion, we apply other PCRs such as 𝐶𝑝𝑢, 𝐶𝑝𝑙 , and 𝐶𝑝𝑘.

4.4.2 The 𝐶𝑝𝑢, 𝐶𝑝𝑙, and 𝐶𝑝𝑘 ratios

Like the 𝐶𝑝 ratio, the 𝐶𝑝𝑢, 𝐶𝑝𝑙 , and 𝐶𝑝𝑘 ratios also allow us to measure the capability of
the process. But unlike the 𝐶𝑝 ratio, these new ratios account for the process mean 𝜇.

1. The 𝐶𝑝𝑢 ratio, formulated as

𝐶𝑝𝑢 =
𝑈𝑆𝐿−𝜇

3𝜎
, (4.26)

measures the process capability of satisfying the USL given the mean 𝜇 and 3𝜎 .

2. The 𝐶𝑝𝑙 ratio, formulated as

𝐶𝑝𝑙 =
𝜇−𝐿𝑆𝐿

3𝜎
, (4.27)

measures the process capability of meeting the LSL given the mean 𝜇 and 3𝜎 .
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3. The 𝐶𝑝𝑘 ratio, computed as

𝐶𝑝𝑘 =min
(︁
𝐶𝑝𝑢 ,𝐶𝑝𝑙

)︁
, (4.28)

measures the actual capability of the process. Here, min() symbolizes the mini-
mum function.

When 𝐶𝑝𝑘 = 𝐶𝑝, we deduce that the process mean 𝜇 is about centered between 𝑈𝑆𝐿
and 𝐿𝐶𝐿. When 𝐶𝑝𝑘 < 𝐶𝑝, the process is off-center. For cases of 𝐶𝑝𝑘 < 0, the process is
completely outside of the specification limits.

4.4.3 Implementing PCRs

Before we can implement PCRs, we must be given the process standard deviation 𝜎 or
be able to estimate this statistic from the process sample. We also may need to know the
process mean 𝜇. We can estimate both of these parameters, as previously discussed in
Subsection 4.2.6.

Interpretation

In general, any PCR greater than 1 implies that the process is capable of meeting the
given standard. Otherwise, to improve the capability measure of interest, we must de-
crease the variability in the process given by 𝜎 . For an existing process, it is recom-
mended that a PCR measure be at least 1.33 in a two-sided measure or 1.25 in a one-
sided measure. For a new process, the recommended PCR values are 1.50 for a two-
sided measure and 1.45 for a one-sided measure. In a two-sided, centered, and normally
distributed process, a 𝐶𝑝 of 0.25 implies 453,255 ppm2, a 𝐶𝑝 of 1 implies 2,700 ppm, and
a 𝐶𝑝 of 2 signifies about 0.0018 ppm [43]. Another practical interpretation of the 𝐶𝑝 ratio
follows from:

𝑃 =
(︃
1
𝐶𝑝

)︃
(4.29)

where 𝑃 is the percentage of the specification bandwidth being used by the process.

1. If 𝑃 ≤ 1: the process is capable of meeting the specification limits.

2. If 𝑃 > 1: the process is using more than the allowed bandwidth and is therefore not
capable of meeting the specification limits.

Besides measuring the process capability, the 𝐶𝑝 ratio can also be utilized to evaluate
the acceptability of the 𝑔𝑎𝑢𝑔𝑒 instrument, as we discuss further in Module 7.

Remark: When a process is not in control, performance indices like 𝑃𝑝, 𝑃𝑝𝑢 , 𝑃𝑝𝑙 , and 𝑃𝑝𝑘 are
sometimes used to measure the capability. These indices are essentially similar to the PCRs

2ppm: defective parts per million
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discussed earlier except that 𝜎 is replaced with the process standard deviation 𝑠. These ratios
should be applied with caution, or not be used at all, due to possible misleading conclusions that
may result when the process is not stable [43].

How-To 4.12 (PCRs in Minitab 18) Click on Stat > Quality Tools > Capability Analy-
sis > Normal > upload your data. See the snapshot in Figure 4.14. You can change
the distribution as necessary.

Figure 4.13: Capability analysis options in Minitab 18

For additional graphical results, click on Stat > Quality Tools > Capability Sixpack
> select the appropriate distribution > upload your data > OK. To change the 𝜎
estimation method, click on Estimate > Select the preferred technique (see the
snapshot in Figure 4.14)
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Figure 4.14: 𝜎 estimation options in Minitab 18

Example 4.9 (Capability analysis)
For the past 40 days, the medical coding manager at Metro City Hospital has been
sampling five inpatient records daily (𝑥1, . . . ,𝑥5) to track the processing times in
minutes (mins). The manager would like to test the process capability to meet the
rate of USL = 45 minutes and LSL = 15 minutes. The process is statistically stable.
Table 4.4 shows the data collected so far.
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Table 4.4: Processing times of inpatient records at Metro City Hospital in 2018

Sample 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5 Sample 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5

1 32 25 23 37 30 21 27 23 33 24 32
2 37 31 35 36 33 22 31 33 37 30 32
3 37 27 30 33 26 23 30 36 31 26 25
4 36 32 27 21 31 24 36 28 30 26 30
5 34 40 40 26 30 25 23 22 28 17 32
6 32 33 38 30 29 26 30 26 37 32 23
7 20 35 34 28 22 27 32 30 31 28 34
8 35 21 35 33 25 28 29 36 30 25 27
9 36 29 41 27 26 29 27 32 27 32 30
10 33 27 35 31 20 30 29 24 23 26 29
11 30 29 33 24 31 31 28 30 25 27 31
12 31 27 27 32 35 32 31 31 28 30 31
13 26 24 38 32 25 33 24 26 37 30 35
14 37 26 21 41 31 34 26 31 30 25 28
15 33 24 31 33 29 35 28 26 25 38 26
16 26 30 35 32 22 36 30 29 30 30 28
17 29 37 34 34 24 37 32 33 28 25 35
18 33 34 25 33 31 38 21 38 32 30 30
19 26 30 29 26 41 39 35 27 31 34 37
20 33 24 33 32 35 40 33 45 23 28 39

To help the manager analyze the capability of this process, we start by estimating
parameters 𝜎 and 𝜇. We approximate 𝜇 using ¯̄𝑥, which is the average of all sample
averages. To approximate 𝜎 , we utilize Equation 4.15 since 𝑛 ≤ 10. Using Excel,
we obtain the range by 𝑀𝐴𝑋(𝑠𝑎𝑚𝑝𝑙𝑒)−𝑀𝐼𝑁 (𝑠𝑎𝑚𝑝𝑙𝑒). We calculate the average
of each sample using the 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝑠𝑎𝑚𝑝𝑙𝑒) function. We illustrate the setup of
our spreadsheet in Figure 4.15.

Figure 4.15: A spreadsheet setup for calculating the ranges and averages of the
data in Table 4.4

.
A B C D E F G H

1 Sample x1 x2 x3 x4 x5 Range Mean

2 1 32 25 23 37 30 14 29.4

3 2 37 31 35 36 33 6 34.4

4 3 37 27 30 33 26 11 30.6

… … … … … … … …

40 39 35 27 31 34 37 10 32.8

41 40 33 45 23 28 39 22 33.6

11.15 30.115

About Figure 4.15, we obtained the range of sample 1 by = 𝑀𝐴𝑋(𝐵2 : 𝐹2) −
𝑀𝐼𝑁 (𝐵2 : 𝐹2) = 14. We obtained the average of sample 1 by = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵2 :
𝐹2) = 29.4. We applied the same formulas to other samples. In the end, we cal-
culated �̄� using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐺2 : 𝐺41) = 11.15 and ¯̄𝑥 using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐻2 :
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𝐻41) = 30.115. To approximate 𝜎 , we proceeded as follows:

𝜎 ≈ 𝜎 =
�̄�
𝑑2

=
11.15
2.326

= 4.80 (4.30)

We obtained the value of 𝑑2 = 2.326 from Appendix Table 1 when 𝑛 = 5. We
proceeded to calculate the PCRs of interest as follows:

𝐶𝑝 =
𝑈𝑆𝐿−𝐿𝑆𝐿

6𝜎
=
45− 15
6(4.80)

= 1.043 (4.31)

𝐶𝑝𝑢 =
𝑈𝑆𝐿−𝜇

3𝜎
=
45− 30.115
3(4.80)

= 1.035 (4.32)

𝐶𝑝𝑙 =
𝜇−𝐿𝑆𝐿

3𝜎
=
30.115− 15
3(4.80)

= 1.051 (4.33)

𝐶𝑝𝑘 = min
(︁
𝐶𝑝𝑢 ,𝐶𝑝𝑙

)︁
=min(1.035,1.051) = 1.035 (4.34)

Given that all ratios are greater than 1, the process is capable. Furthermore, we
can deduce that the process mean is about centered between USL and LSL, since
𝐶𝑝 ≈ 𝐶𝑝𝑘. We estimate the amount of the bandwidth that the process is utilizing
this way:

𝑃 =
(︃
1
𝐶𝑝

)︃
100 =

(︂ 1
1.043

)︂
100 = 96%. (4.35)

The 96% utilization rate of the allowed bandwidth is not desirable since it leaves
little to no room for error. To improve the capability, the process variability must
be decreased. Figure 4.16 portrays a Minitab capability report. The histogram in
this figure confirms that the process is about centered, but is using almost all of
the allowed bandwidth between LSL and USL. The Capability Plot substantiates
this claim. The intervals in this plot portray different estimations of the spread in
the process. The within interval follows from the unbiased estimation of 𝜎 using
sample data.
Figure 4.17 depicts additional Minitab results related to the sixpack report. The
Xbar and R charts in Figure 4.17 indicate that the process is stable since points
move randomly around the centerline, and no point falls outside of the control limits.
The Last 25 Subgroups chart validates the conclusion about the random behavior
of the sample mean since no clear pattern is discernible. But, we do notice that
sample 40 seems to show more variability than other points. The Normal Prob-
ability Plot portrays points falling alongside the fitted line, an indication that the
process is about normally distributed.
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Figure 4.16: Process capability report in Minitab 18 based on the data in Table 4.4

Figure 4.17: Process capability sixpack report in Minitab 18 based on the data in
Table 4.4
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4.5 Check your understanding

1. What software would you recommend to create histograms for continuous data?

2. Justify the need for assessing the variability and capability of the process.

3. What is the position of the 50th percentile when we have 91 data points?

4. What is the position of the 90th percentile when we have 91 data points? If the
values in the 82nd and 83rd positions are 31 and 56, what is the actual value of
the 90th percentile?

5. In Minitab, what is the difference between an increment of 10 and an increment
of 5 when creating a stem-and-leaf diagram?

6. You are comparing the process of the release of information (ROI) between two
comparable hospitals. In hospital A, you found IQR of 50. In hospital B, you found
IQR of 100. What can you conclude about the quality of ROI in these hospitals?

7. What is the significance of a whisker that is 1.5*IQR long?

8. What rule of thumb can you apply to determine the number of bins in a histogram?

9. What is the consequence of having too many or too few bins in a histogram?

10. What conclusion can you generally draw if you had a histogram with two modes?

11. Which sample statistic that considers the peakedness and tailedness of the pro-
cess?

(a) Skewness

(b) Kurtosis

(c) Mean

(d) Variance

12. We determine IQR in a box plot using:

(a) Q2 - Q1

(b) Q3 - Q2

(c) Q4 - Q3

(d) Q4 - Q1

13. What statistical analysis can you perform to validate whether your process can
meet the specifications of the customer?

14. From 25 samples, each with size 10, you estimated that the hospital’s EHR down-
time average time was 30 minutes with the standard deviation of 2 minutes. Your
process is assumed stable and normally distributed.
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(a) What is the potential capability of the system to meet the specifications of
𝐿𝑆𝐿 = 10 minutes and 𝑈𝑆𝐿 = 45 minutes?

(b) What is the actual capability of the system to meet the specifications of 𝐿𝑆𝐿 =
10 minutes and 𝑈𝑆𝐿 = 45 minutes?

(c) What is the percentage of the allowed bandwidth is the process using?

(d) What is the probability of observing a downtime period longer than 45 min-
utes?

15. Using Minitab, conduct the capability analysis of the data given Example 4.9, given
LSL = 20 and USL = 50. Attach your Minitab results, including the interpretation
of all relevant findings. What additional insights can you obtain from the capability
sixpack report?

16. When a process is in control, we apply the following ratio to measure the actual
capability.

(a) 𝐶𝑝

(b) 𝑃𝑝

(c) 𝐶𝑝𝑘

(d) 𝑃𝑝𝑘

17. If 𝐶𝑝 is greater than 1:

(a) The process is capable

(b) The process is not capable

18. We use min
(︁
𝐶𝑝𝑢 ,𝐶𝑝𝑙

)︁
to calculate:

(a) 𝐶𝑝

(b) 𝐶𝑝𝑘

(c) 𝐶𝑝𝑢

(d) 𝐶𝑝𝑙

19. Given the 6,210 ppm value obtained during the capability analysis in Minitab, what
is the estimated Motorola sigma level of this process?

(a) 1

(b) 2

(c) 3

(d) 4

(e) 5

(f) 6
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20. From an audit of 30 orders for the diagnostic test Z, you found the average entry
time in the CPOE system to be 7 minutes with �̄� = 3. Given LSL = 5 minutes and
USL = 10 minutes, what is the capability of this process? What can you conclude
about the central tendency of this process?

21. Name one sample statistic that we can employ to measure variability in the pro-
cess?

22. The term subgroup has the same meaning as

(a) sample

(b) number

(c) population

(d) variance

23. The manager of Metropolis Clinic has received several patient complaints about
excessive waiting times. To investigate the matter, the manager performed a ret-
rospective audit of 5 random visits each day for 25 days. From this scenario, the
sample size is:

(a) 1

(b) 5

(c) 12

(d) 60

24. Which of the following is an example of a statistic measure of a process:

(a) a sample mean

(b) a sample size

(c) a sample number

(d) a random sample

25. In ——— sampling, each item in the process has an equal chance of being se-
lected:

(a) random

(b) systematic

(c) stratified

(d) cluster

26. We use this formula 1
𝑛−1

∑︀𝑛
𝑖=1(𝑥𝑖 − 𝑥)2 to calculate the sample:

(a) mean

(b) variance
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(c) standard deviation

(d) median

27. Your population has a mean 𝜇 = 50 and 𝜎 = 10. If you took a sample of size 7 and
observed a mean of 55, what is your sampling error?

(a) 5

(b) 7

(c) 10

(d) 40

28. Your population has a mean 𝜇 = 50 and 𝜎 = 10. If you took a sample of size 7 and
observed a mean of 55, what is your standard error?

(a) 3.8

(b) 7.0

(c) 11.9

(d) 17.6

29. The ratio between the two sample variances is likely to follow which distribution?

(a) normal distribution

(b) t-distribution

(c) F-distribution

(d) Chi-square distribution

30. When sampling your process, you should seek to —— within subgroup differences

(a) maximize

(b) minimize

31. Which of the following sample statistic is a biased estimator of the related popula-
tion parameter?

(a) Mean

(b) Variance

(c) Standard deviation

(d) Sum of Squares

32. Which of the following distribution has the mean and variance parameters that are
equal?

(a) Geometric

(b) Poisson
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(c) Normal

(d) Bernoulli

33. Which statistic do you need to create a confidence interval for your population
mean?

(a) Standard error

(b) Sampling error

(c) Regression error

(d) Statistic error

34. Why are we likely to assume normal distribution during quality improvement projects?

35. What graphical technique can we use to verify the normality assumption?



MODULE 5

Tools for evaluating relationships in data

In this module, we review graphical and statistical tools for evaluating
relationships in the process data. The visual tools we discuss include
scatter and marginal plots. The statistical measures we consider include
the Pearson and Spearman correlation coefficients. We also discuss lin-
ear regression models and goodness-of-fit measures. For software, we
use Minitab and Excel.

Key concepts and tools: Relationship in data; Correlation; Scatter plots; Marginal
plots; Pearson coefficient; Spearman coefficient; Dependent variable; Independent
variables; Linear regression model; Hypothesis testing; Residuals plots; 𝑅2; 𝑅2

𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 ;
P-value

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for assessing the relationship in data

2. Explain the concept of correlation analysis

3. Contrast scatter plots to marginal plots

4. Implement the Pearson correlation coefficient

5. Calculate the Spearman correlation coefficient

6. Justify the need for regression modeling

7. Fit a linear regression model to data

8. Interpret residual plots for the goodness-of-fit

9. Differentiate between 𝑅2 and 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑

10. Conduct hypothesis tests

96
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5.1 Introduction

We dedicate this module to the review of tools for evaluating relationships in data. We
start with a discussion about scatter and marginal plots. We demonstrate how to create
these plots using Excel and Minitab. Next, we expand our discussion to include correla-
tion measures such as the Pearson and Spearman coefficients. We end the module with
an overview of regression techniques.

5.2 Visual tools

5.2.1 Scatter diagrams

A scatter diagram is one of the major tools of statistical process control (SPC) that we
use in the Analyze phase of DMAIC to evaluate the correlation between two variables.

Constructing a scatter diagram

To create a scatter diagram, we start by organizing the data in the table format by storing
each variable in a separate column. Each row constitutes an ordered pair of observations.
To create a scatter plot, we simply graph a 2-dimensional chart of the variables in the
Cartesian coordinates system.

How-To 5.1 (Creating a scatter plot in Excel 2013)
To create a scatter diagram in Excel 2013, click on INSERT > Scatter Charts. See
the snapshot in Figure 5.1.

Figure 5.1: Options for a scatter plot in Excel 2013

How-To 5.2 (Creating a scatter plot in Minitab 18)
To create a scatter diagram in Minitab 18, click on Graph >Scatterplot . See the
snapshot in Figure 5.2).

Figure 5.2: Options for a scatter plot in Minitab 18
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Interpreting a scatter diagram

We characterize the relationship in a scatter plot as follows:

1. Positive correlation (or direct relationship) when two variables increase together.

2. Negative correlation (or inverse relationship) when one variable increases as the
other one decreases.

3. No correlation (or no relationship) when two variables do not vary together.

We can further differentiate the strength of the relationship by using terms such as
strong, moderate, or weak. For example, we can describe two variables as being
strongly and positively correlated. It is also common to fit a line on the scatter data to
evaluate the linearity or non-linearity of the relationship. Figure 5.3 portrays examples
of scatter plots. In Subfigure 5.3a, strong positive and linear relationship exists between
variables X and Y. This association implies that as X increases, Y tends to increase too.
In Subfigure 5.3b, we observe a strong negative and linear relationship between X and
Y, implying that as X increases, Y tends to decrease. In Subfigure 5.3c, no obvious rela-
tionship is discernible, meaning that X and Y are likely independent variables. Subfigure
5.3a shows a non-linear relationship between X and Y, which, after fitting a line, seems
quadratic.

Remark: Scatter diagrams do not suggest that one variable causes another, rather imply that a
potential relationship exists. Other statistical tools, such as the design of experiments (DOE),
are best suited for entertaining the causality issue [43].

5.2.2 Marginal plots

Marginal plots are scatter diagrams that, in addition to portraying the relationship in the
data, depict the distributions of the variables under study. Minitab 18 provides options for
displaying marginal plots using box plots, histograms, or dot plots. Dot plots are similar
to stem-and-leaf diagrams, except that in the former leaves are made of dots instead of
numbers.

How-To 5.3 (Creating a marginal plot in Minitab 18)
To create a marginal plot in Minitab 18, click on Graph > Marginal Plot. See the
screenshot in Figure 5.4.



Module 5. Tools for evaluating relationships in data 99

Figure 5.3: Examples of scatter diagrams

(a) Strong positive and linear (Direct) relationship
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(b) Strong negative and linear (Inverse) relationship
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(c) No relationship
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(d) Quadratic relationship
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Figure 5.4: Options for a marginal plot in Minitab 18

Example 5.1 (Marginal plots)
Table 5.1 shows audit results from an informatics process at Metropolis Hospital.
Using these data and Minitab 18, we created a marginal plot with a box-plot as
portrayed in Figure 5.5a. Figure 5.5b shows a marginal plot of histograms. In both
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of these plots, we appreciate that the marginal distribution of X is somewhat right-
skewed, whereas the marginal distribution of Y is about symmetric with slight lower
skewness.

Table 5.1: Audit results from an informatics process at Metropolis Hospital

Sample X Y Sample X Y

1 53.11 5 16 26 64
2 51.82 7.46 17 33.9 100
3 53 21.67 18 25.06 101
4 51 42.22 19 29.43 60
5 49.29 65.66 20 50 26.99
6 45 88.18 21 23.97 80
7 49.29 106.72 22 21.82 40
8 39.63 119.43 23 27.24 80
9 30.17 125.7 24 23.97 62.3

10 44.37 123.89 25 20.75 50
11 40.8 121 26 16.5 6
12 41.98 100.32 27 20.75 72
13 37.32 101.18 28 20 45
14 30.54 88.8 29 16.5 5
15 35 76.16 30 19.68 20

Figure 5.5: Marginal plots created using Minitab 18 and the data in Table 5.1

(a) A box plot marginal plot (b) A histogram marginal plot

5.3 Statistical measures

Besides visual tools, we can also use statistical measures to establish the degree of the
relationship between two variables. Common statistical measures for this purpose are
the Pearson and Spearman correlation coefficients. In addition, we can use regression
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models to evaluate the relationship between the dependent and independent variables in
the process.

5.3.1 Correlation analysis

We conduct a correlation analysis to evaluate the relationship between two variables.
Here, we show how to achieve this goal using the Pearson and Spearman correlation
coefficients. Another similar technique that we do not cover in this section is the Kendall
rank correlation coefficient [2].

Pearson correlation coefficient

The Pearson correlation coefficient is a parametric technique that we use to quantify the
degree of the relationship between two continuous variables. We calculate this coeffi-
cient by taking the ratio between the corresponding covariance and standard deviations
statistics. To demonstrate, let’s assume that we have two samples 𝑋 and 𝑌 , each with
size 𝑛, and means of 𝑋 and 𝑌 , respectively. The covariance of 𝑋 and 𝑌 , 𝑐𝑜𝑣(𝑋,𝑌 ) is
given by:

𝑐𝑜𝑣(𝑋,𝑌 ) =
∑︀
(𝑋 −𝑋)(𝑌 −𝑌 )

𝑛− 1
(5.1)

where 𝑛−1 represents the degrees of freedom. We obtain the Pearson correlation coef-
ficient 𝜌(𝑋,𝑌 ), sometimes denoted as 𝑟, this way:

𝜌(𝑋,𝑌 ) ≡ 𝑟 =
𝑐𝑜𝑣(𝑋,𝑌 )

𝑠𝑋𝑠𝑌
(5.2)

Here, 𝑠𝑋 is the standard deviation of variable 𝑋 and 𝑠𝑌 is the standard deviation of vari-
able 𝑌 . It follows that [37]:

−1 ≤ 𝑟 ≤ 1 (5.3)

The more 𝑟 is close to −1, the more 𝑋 and 𝑌 are negatively correlated. The more 𝑟 is
close to 1, the more 𝑋 and 𝑌 are positively correlated. When 𝑟 is around 0, the two
variables have little to no correlation.

Spearman coefficient

The Spearman correlation coefficient is a non-parametric technique that uses ranks in-
stead of the actual values of the variables under study. Given two variables 𝑋 and 𝑌 , we
replace a given value of 𝑥 in 𝑋 by its rank 𝑅(𝑥) and a given value of 𝑦 in 𝑌 by its rank
𝑅(𝑦). We denote the Spearman coefficient as 𝑟𝑆 and compute it this way:

𝑟𝑆 =
𝑐𝑜𝑣(𝑅(𝑋),𝑅(𝑌 ))

𝑠𝑅(𝑋)𝑠𝑅(𝑌 )
(5.4)
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where −1 ≤ 𝑟𝑆 ≤ 1. In the simplified case of no ties in ranks, we compute 𝑟𝑆 as follows:

𝑟𝑆 = 1−
6
∑︀𝑛

𝑖=1𝑑
2
𝑖

𝑛(𝑛2 − 1)
(5.5)

where 𝑑𝑖 = 𝑅(𝑥𝑖) −𝑅(𝑦𝑖) [57]. We typically use the Spearman coefficient to assess the
degree of a monotonic relationship between two variables. Just like in Pearson’s case,
the more 𝑟𝑆 is close to −1, the more 𝑋 and 𝑌 are negatively correlated. The more 𝑟𝑆 is
close to 1, the more 𝑋 and 𝑌 are positively correlated. When 𝑟𝑆 is around 0, the two
variables are likely not to be correlated.

How-To 5.4 (Covariance and Correlation in Excel 2013) To calculate 𝑐𝑜𝑣(𝑋,𝑌 ) in
Excel, use this function = 𝐶𝑂𝑉𝐴𝑅𝐼𝐴𝑁𝐶𝐸.𝑆(𝑋,𝑌 ). To calculate 𝜌(𝑋,𝑌 ), use this
function = 𝐶𝑂𝑅𝑅𝐸𝐿(𝑋,𝑌 ).

How-To 5.5 (Covariance and Correlation in Minitab 18) In Minitab, you can calculate
the covariance and correlation between two variables by clicking on Stat > Basic
Statistics > chose Correlation... or Covariance... > select your data > OK.

5.3.2 Regression

We use regression techniques to create a mathematical model of the relationship be-
tween dependent and independent variables. Here, we only consider a linear regres-
sion model with one dependent variable.

One dependent variable and one independent variable

Let’s assume that we have two variables 𝑋 and 𝑌 , where 𝑌 is the dependent variable
and 𝑋 the independent variable. The corresponding linear regression model follows.

𝑌 = 𝛽0 + 𝛽1𝑋 + 𝜖 (5.6)

Both 𝛽0 and 𝛽1 are regression coefficients. The 𝜖 term denotes the regression error that
we refer to as residuals. We estimate 𝛽1 using 𝛽1, as follows:

𝛽1 = 𝑟
𝑠𝑌
𝑠𝑋
≡ 𝑐𝑜𝑣(𝑋,𝑌 )

𝑣𝑎𝑟(𝑋)
(5.7)

where 𝑣𝑎𝑟(𝑋) is the variance of 𝑋 and 𝑟 is the Pearson correlation coefficient between 𝑋
and 𝑌 . We calculate 𝛽0 to approximate 𝛽0 this way:

𝛽0 = 𝑌 − 𝛽1𝑋 (5.8)

where 𝑌 is the mean of 𝑌 and 𝑋 is the mean of 𝑋 [37]. We can predict the values of 𝑌
using 𝑌 , as follows:

𝑌 = 𝛽0 + 𝛽1𝑋 (5.9)
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The coefficient 𝛽1 represents the expected change in 𝑌 per unit change in 𝑋. We can
think of 𝛽0 as the intercept of the line 𝑌 . We obtain the error term this way:

𝜖 = 𝑌 −𝑌 (5.10)

The sum of squares of the error 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 is given by 𝜖2 as follows:

𝜖2 = (𝑌 −𝑌 )2 (5.11)
≡ 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (5.12)

We assume 𝜖 to be a normally distributed random vector with mean zero and variance
𝜎2. The unbiased estimator of 𝜎2 is given by 𝜎2 and is calculated as follows:

𝜎2 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑛− 𝑝

(5.13)

where 𝑛 − 𝑝 represents the degrees of freedom. Here, 𝑛 is the size of Y and 𝑝 is the
number of independent variables 𝑘 plus one for the intercept. That is, 𝑝 = 𝑘 +1 [43].

One dependent variable and multiple independent variables

When we have more than one independent variable, say 𝑘, we create a multiple linear
regression model as follows:

𝑌 = 𝛽0 + 𝛽1𝑋1 + 𝛽2𝑋2 + · · ·+ 𝛽𝑘𝑋𝑘 + 𝜖 (5.14)

where 𝑋1, 𝑋2, . . . ,𝑋𝑘 are independent variables, 𝛽0, 𝛽1, . . . ,𝛽𝑘 are regression coefficients,
and 𝜖 is the error term. From the least-squares method, we obtain the 𝛽 coefficients as
follows:

𝛽 = (𝑋 ′𝑋)−1𝑋 ′𝑌 (5.15)

where ′ symbol indicates transpose. Here, 𝑋 is a matrix of size 𝑛×𝑝, 𝑌 is a vector of size
𝑛× 1, and 𝛽 is a vector of size 𝑝 × 1. Our 𝑌 model looks as follows:

𝑌 = 𝛽0 + 𝛽1𝑋1 + 𝛽2𝑋2 + · · ·+ 𝛽𝑘𝑋𝑘 (5.16)

The coefficient 𝛽𝑗 (for 𝑗 : 0,1, . . . , 𝑘) represents the expected change in 𝑌 per unit
change in 𝑋𝑗 while holding all other independent variables constant. If all inde-
pendent variables were zero, 𝑌 would equal 𝛽0. As before, 𝜖 = 𝑌 −𝑌 and 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 = 𝜖2

5.3.3 Goodness-of-fit

The techniques that we utilize to assess the goodness-of-fit of a linear regression model
are the coefficient of determination, residual plots, and hypothesis testing.
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Coefficient of determination

We denote the coefficient of determination using 𝑅2 to represent the percent of the vari-
ation in 𝑌 that is explained by the variation in independent variables. We recall that:

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 = (𝑌 −𝑌 )2 (5.17)

Additionally, it follows that [36]:

𝑆𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛 = (𝑌 −𝑌 )2 (5.18)

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = (𝑌 −𝑌 )2 (5.19)

We calculate 𝑅2 as follows:

𝑅2 =
𝑆𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛
𝑆𝑆𝑡𝑜𝑡𝑎𝑙

≡ 1− 𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑆𝑆𝑡𝑜𝑡𝑎𝑙

(5.20)

where 0 ≤ 𝑅2 ≤ 1. The higher the value of 𝑅2, the better the goodness-of-fit of our model.

Remark: If we added more variables, necessary or unnecessary, to our regression model, 𝑆𝑆𝑒𝑟𝑟𝑜𝑟
would decrease per Equation 5.13, which would in turn increase 𝑅2 per Equation 5.20. Accord-
ingly, we must be careful when interpreting 𝑅2. We recommend using 𝑅2

𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , instead of 𝑅2, to

determine the goodness-of-fit of a regression model. We find 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 this way:

𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 = 1−

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 /(𝑛− 𝑝)
𝑆𝑆𝑡𝑜𝑡𝑎𝑙/(𝑛− 1)

(5.21)

where 𝑛− 1 is the degrees of freedom of 𝑌 and 𝑛− 𝑝 is the degrees of freedom of the residuals
[43].

Residual plots

Besides 𝑅2 and 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , we can also use residual plots to assess the goodness-of-fit

of our linear regression model. If a model is a good fit, we expect the residuals to be
normally distributed with mean zero and a constant variance. So, the normal plot of
the residuals should indicate that the points fall alongside the fitted line. Furthermore,
we expect to see random behavior around a horizontal line when we plot 𝜖 versus 𝑌 .
Any non-random behavior indicates poor fit, which suggests non-linear behaviors [37].
Statistical packages such as Minitab also include p-values to facilitate the interpretation
of the residual plots.

Hypothesis testing of regression models

In addition to the coefficient of determination and residual plots, we can also employ
hypothesis testing to assess the goodness-of-fit of our regression model. In this test, we
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conjecture that the partial regression coefficients of the model are zero, as follows:

𝐻0 : 𝛽1 = 𝛽2 = · · · = 𝛽𝑘 = 0 (5.22)
𝐻1 : At least one 𝛽𝑗 , 0, for j:1,2,...,k (5.23)

Using the analysis of variance (ANOVA) technique, we obtain the test statistic as follows:

𝐹0 =
𝑀𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛
𝑀𝑆𝑒𝑟𝑟𝑜𝑟

(5.24)

The critical value is given by:

𝐹𝛼, 𝑘, 𝑛−𝑘−1 (5.25)

where 𝛼 is the significance level, 𝑛 is the size of 𝑌 , and 𝑘 is the number of independent
variables. A good-fit model will have at least one non-zero coefficient. That is, the test
statistic will be greater than the critical value or the p-value less 𝛼. We could also test the
hypothesis that the coefficient 𝛽𝑗 (for 𝑗 : 1, . . . , 𝑘) is zero using the t-test, as follows [36]:

𝐻0 : 𝛽𝑗 = 0 (5.26)
𝐻1 : 𝛽𝑗 , 0 (5.27)

We obtain the test statistic this way [36]:

𝑡 =
𝛽𝑗 − 0
𝑆𝛽𝑗

(5.28)

where the 𝑧𝑒𝑟𝑜 in the Equation 5.28 comes from the null hypothesis and 𝑆𝛽𝑖 is the stan-
dard error of the coefficient 𝛽𝑗 . The degrees of freedom for this test are given by 𝑛 − 𝑝,
where 𝑛 is the number of observations and 𝑝 = 𝑘 + 1, as before. We obtain the p-value
for this test, as illustrated in How-To 5.7.

How-To 5.6 (Linear Regression in Excel 2013)
Open the Data Analysis add-in > Regression > Input Y Range for dependent vari-
able > Input X Range for independent variables > Check Labels if you want to
include the column headings > Check the boxes of Residuals plots to check for the
model goodness-of-fit. See the snapshot in Figure 5.6.
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Figure 5.6: Regression using the Data Analysis add-in, Excel 2013

How-To 5.7 (The p-value of the t-test in Excel 2013)
To obtain the p-value of the t-test in Excel 2013, use this equation: =
𝑇 .𝐷𝐼𝑆𝑇 .2𝑇 (𝐴𝐵𝑆(𝑡),𝑛− 𝑝)

How-To 5.8 (Linear Regression in Minitab 18)
Click on Stat > Regression > Regression > Fit Regression Model...On the screen
that pops up, input your Y data in the Responses and your X data in the Continuous
predictors > On the same screen, click on Graphs > Check the boxes for Normal
probability plot of residuals and Residuals versus fits >OK > OK. See the snapshot
in Figure 5.7.

Figure 5.7: Options for fitting a regression model, Minitab 18
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Example 5.2 (Multiple linear regression) Table 5.2 presents data from a health
informatics process at Central City Hospital, where 𝑌 is the dependent variable,
and 𝑋1 and 𝑋2 are the independent variables. We fit a multiple linear regression
model using Excel, and the results are displayed in Table 5.3. From these results,
we construct the following model:

𝑌 = 112.1+1.152𝑋1+2.324𝑋2 (5.29)

We can interpret this model by saying that for each unit increase in X1, Y increases
by 1.152. Likewise, for each unit increase in X2, Y increases by 2.324. Given that
𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 = 87.80%, we can conclude that this model is a good fit. Additionally,

given that the p-values of all coefficients are less than 0.05, we can infer that, at
the 95% confidence level, all the model coefficients are non-zero. We should note
that the p-values of the coefficients were obtained per How-To 5.7. For example,
the p-value for X1 was obtained by = 𝑇 .𝐷𝐼𝑆𝑇 .2𝑇 (2.578985,17) = 0.019508977.
All plots in Figure 5.8 suggest a good fit model, since residuals seem random and
normally distributed. In the Normal probability plot, points fall along the fitted line,
indicating the normality of the residuals. The Histogram plot also suggests the nor-
mal distribution, although this plot is not as informative since we need a lot of points
to observe the bell shape, and here we only have 20 observations. The Residuals
Versus Fits plot exhibits randomly scattered points, which is what is expected in
a good fit model. The Residuals Versus Order plot also shows random behaviors
since no particular pattern or trend is noticeable in the order of points.
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Table 5.2: Data from a health informatics process at Central City Hospital

Y X1 X2

87 1 11
293 72 41
394 116 59
277 71 39
185 28 19
353 50 51
151 30 19
268 61 36
296 82 40
262 56 30
195 49 30
471 136 81
239 43 29
481 72 87
377 101 57
313 93 34
203 49 21
481 145 129
490 139 89
218 36 21

Table 5.3: Excel Regression results for the data in Table 5.2

SUMMARY OUTPUT

Regression Statistics

Multiple R 0.943824
R Square 0.890803
Adjusted R Square 0.877957
Standard Error 41.12373
Observations 20

ANOVA

df SS MS F Significance F

Regression 2 234534.5 117267.2 69.34127 6.68E-09
Residual 17 28749.73 1691.161
Total 19 263284.2

Coefficients Standard Error t Stat P-value Lower 95% Upper 95% Lower 95.0% Upper 95.0%

Intercept 112.0812 19.30276 5.806487 2.1E-05 71.35597 152.8065 71.35597 152.8065
X1 1.152057 0.446709 2.578985 0.019509 0.209582 2.094531 0.209582 2.094531
X2 2.323872 0.592855 3.919801 0.001103 1.073058 3.574686 1.073058 3.574686



Module 5. Tools for evaluating relationships in data 109

Figure 5.8: Minitab graphical results for the regression of the data in Table 5.2
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5.4 Check your understanding

1. What is the primary difference between marginal and scatter plots?

2. How do the Pearson and Spearman correlation coefficients differ?

3. From performing the correlation analysis between X and Y, you found 𝜌 = 0.6. What
can you conclude about the relationship between these variables?

4. Consider these two datasets: 𝐴 = {7,30,25,18,13,28,1} and 𝐵 = {28,3,4,15,26,25,40}.
What can you conclude regarding the relationship between 𝐴 and 𝐵?

5. You have taken two samples from your process. Suppose that you have found the
sample covariance of 10 and the standard deviation of 10 in each sample. What
can you conclude concerning correlation in your samples?

6. Which chart option in Excel is applicable when constructing histograms?

(a) Bar chart

(b) Pie chart

(c) Scatter plot

(d) Radar chart

7. What analytical tool is best suited for establishing causality?

(a) Scatter Plots

(b) Control charts

(c) DOE

(d) Regression models

8. What visual tool can you use to evaluate the potential relationship between two
variables?

(a) Scatter plot

(b) Cause-and-effect diagram

(c) Box plot

(d) Stem-and-leaf diagram

9. How can you state the null hypothesis about the coefficients of a multiple regression
model?

10. Why do we have to adjust the coefficient of determination?

11. Given the response 𝑌 and the fitted response 𝑌 , how would you obtain the sum of
squares of the residuals of your model?
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12. How does the coefficient of correlation differ from the coefficient of determination?

13. Given the dependent variable Y and the independent variable X, how would you
obtain the intercept of the corresponding linear regression model?

14. Given the residual plot from a regression model, how would you determine the
goodness-of-fit?

15. Consider the following multiple linear regression model 𝑌 = 𝛽0+𝛽1𝑋1+𝛽2𝑋2+ · · ·+
𝛽𝑘𝑋𝑘 + 𝜖. How can you interpret 𝛽2 concerning 𝑌 ?

16. You have created a regression model from your sample data. How can you use
the total sum of squares and the error sum of squares to obtain the coefficient of
determination?

17. From fitting a multiple regression model in Excel, with 20 observations, you ob-
tained the results in the following table:

Coefficients Standard Error t Stat

Intercept 89.75368 7.970321 11.26099
X1 1.7707 0.318356 5.562016
X2 1.669831 0.556528 3.000446

(a) Write down the regression equation for this case

(b) What can you conclude about the significance of the coefficient of your re-
gression model? Justify your answer using p-values

18. Consider the following dataset in Table 5.4.

Table 5.4

X 20 55 27 41 29 29 27 25 55 33 29 51 52 27 31 48 38 60 22 20 52 49 52 41 50 57 56 20 42 54

Y 17 63 27 37 37 35 33 26 52 38 29 49 58 30 26 44 41 64 29 25 55 59 54 50 60 55 51 20 42 58

(a) Input the data in Excel or Minitab

(b) Fit a linear regression model

(c) Generate the plots of the residuals

(d) What can you conclude about your model in terms of:

i. 𝑅2 or 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑

ii. P-value
iii. The coefficients of the model
iv. Residual plots

19. Consider the following linear model:

𝑌 = 100+9𝑋 − 3𝑍 (5.30)
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(a) How would you interpret the coefficients of this model?

(b) What information do you need to calculate the p-values of this model?

20. Fit a linear regression model to the data in Table 5.5, where 𝑌 is the dependent
variable, and the rest of the variables are independent. What can you conclude
from your results?

Table 5.5: Data from a health informatics process

Y X1 X2 X3

250 35 3 0
360 29 4 1
165 36 7 0
43 60 6 0
92 65 5 0
200 30 5 0
355 10 6 1
290 7 10 1
230 21 9 0
120 55 2 0
73 54 12 0
205 48 5 1
400 20 5 1
320 39 4 1
72 60 8 0
272 20 5 1
94 58 7 0
190 40 8 1
235 27 9 0
139 30 7 0



MODULE 6

Tools for root cause and risk analysis

In this module, we review tools for evaluating the causes and risks of
quality problems in the process. The tools and techniques that we cover
include cause-and-effect diagrams, NGT1 Q-sort, force-field analysis, FMEA2,
Is-Is Not matrix, and Why diagrams. For software, we use Minitab, Excel,
and Visio.

Key concepts and tools: Brainstorming; Affinity grouping; Root cause analysis;
Risk analysis; Cause-and-effect diagrams; Crowdsourcing; Force-field analysis; Vot-
ing techniques; Prioritization; NGT; FMEA; Why diagrams; Is-Is Not matrix

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for cause and risk analysis

2. Justify the need for root cause analysis

3. Justify the need for risk analysis

4. Implement brainstorming techniques

5. Implement cause-and-effect diagrams

6. Implement risk analysis techniques

7. Apply affinity grouping techniques

8. Implement a force-field analysis

9. Survey prioritization techniques for causes and risks of quality problems

10. Articulate examples of risks of quality problems in health care

1NGT: Nominal Group Technique
2FMEA: Failure Modes and Effects Analysis

113
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6.1 Introduction

Root cause and risk analysis are major activities of quality improvement that we typically
implement during the Analyze phase of DMAIC to attempt to identify potential causes
and risks of quality problems.

6.2 A general procedure

The approach that one takes to conduct root cause and risk analysis varies by the situa-
tion, but the following procedure applies in typical processes:

1. Generate ideas about the causes and risks of the effect

2. Organize ideas into classes or themes using graphical or tabular tools

3. Rank and prioritize ideas

6.3 Generating ideas

We can generate ideas about the root causes and risks of quality problems by talking
to the stakeholders of the process or by involving experts. Traditional techniques for this
purpose include:

• Brainstorming sessions where we create a team of stakeholders to generate ideas
about the likely causes and possible solutions to a given quality problem [49].

• Delphi surveys, where we involve a panel of experts and request their feedback
about possible root causes and feasible solutions to a particular quality issue [43].

A more recent technique for generating ideas about root causes, risks, and potential
solutions to quality problems is crowdsourcing, where we involve the general public via
the web. In many cases, respondents participate for free and may not possess traditional
credentials in the fields of interest. Yet, this new way of generating ideas has proven to
be very effective [40].

6.4 Organizing ideas

In this section, we discuss techniques for organizing ideas about root causes, risks, and
potential solutions to a quality problem.
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6.4.1 Affinity grouping

Affinity grouping is an organizational technique for classifying similar ideas into major
themes [49]. The same team that proposed original ideas could help with the classifica-
tion task. For the case of a large number of suggestions, we could initially utilize machine
learning algorithms to conduct sentiment analysis using embedding methods and other
topic modeling techniques such as the Latent Dirichlet Allocation method [9].

6.4.2 Cause-and-effect diagrams

A cause-and-effect diagram is one of the primary tools of SPC3 that we utilize to orga-
nize potential causes by the major process inputs such as people, policy, methods, and
materials [50]. Other names of this diagram are Ishikawa (the name of an individual who
first introduced it [43]), and fishbone (since the diagram looks like the skeleton of a fish)
[43]. A basic algorithm for creating a cause-and-effect diagram follows.

Step 1: Draw a horizontal arrow from left to right and connect it to a box of the effect.
This line will serve as the main branch.

Effect

Step 2: Draw boxes for the process key inputs and connect them to the main branch
using right-slanted arrows. We refer to these secondary arrows as sub-branches.

Effect

Step 3: Write down key process inputs in the boxes that you drew in Step 2.

3SPC: Statistical Process Control
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Effect

People Policy

Step 4: From each sub-branch, draw horizontal arrows for the causes. Sub-causes can
be added as necessary.

Effect

People Policy

causecause

cause

cause

cause

cause

cause

cause

How-To 6.1 (Creating a cause-and-effect diagram in Microsoft Visio 2013)
Open Microsoft Visio and click on File > New > Business > Cause and Effect Dia-
gram. You can also access the cause-and-effect diagram option by clicking on File
> New > type cause and effect in the search box for templates. See the snapshot
in Figure 6.1 for illustration. Change the default labels as necessary.
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Figure 6.1: Options for a cause-and-effect diagram in Microsoft Visio 2013

How-To 6.2 (Creating a cause-and-effect diagram in Minitab 18)
Open Minitab and click on Stat > Quality Tools > Cause-and-Effect. See the snap-
shot in Figure 6.2.

Figure 6.2: Options for a cause-and-effect diagram in Minitab 18

6.4.3 5Whys diagram

A 5Whys diagram, as illustrated in Figure 6.3, is a graphical tool that conceptually ac-
complishes the same goal as the cause-and-effect diagram. One difference is that, unlike
in the latter, in the former, we have to keep asking why (e.g., 5 times) until we have iden-
tified the atomic cause of the problem. Another difference is that in a 5Whys diagram, we
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don’t have to organize causes by particular inputs.

Figure 6.3: A general structure of a 5Whys diagram
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See an example of the application of a 5Whys diagram in [32].

6.4.4 Why-why diagram

A Why-Why diagram is a variation of the 5Whys diagram that we can use to analyze
the risk of an adverse event. Unlike the 5Whys diagram, where we ask the causes of an
effect, in the Why-Why diagram, we inquire about how an adverse event could happen
[55]. The setup of this diagram looks like that of a 5Whys diagram portrayed in Figure
6.3.

How-To 6.3 (Creating a Why diagrams in Microsoft Visio 2013)
To draw a 5Whys diagram, use the basic shapes in Visio and connect boxes using
arrows.

6.4.5 Is-Is Not matrix

An Is-Is Not matrix, as illustrated in Table 6.1, is a tabular tool that we can employ to
evaluate the risks of quality problems by contrasting favorable and unfavorable conditions
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of an adverse event [31, 55]. A careful analysis of the differences between the Is and the
Is Not columns can help reveal potential high-risk areas in the process.

Table 6.1: A basic setup of the Is-Is Not matrix

Adverse event (specify) Is Is Not Difference

Where did the
event happen?

Specify the location
where the event oc-
curred

Specify a compara-
ble location where the
event did not occur

What is the differ-
ence? State a
plausible hypothe-
sis.

Who was affected
by the event?

Specify the type
of the customer
affected

Specify the type of the
customer not affected

. . .

How did the event
happen?

Specify how the
event happened

Specify how the event
did not happen (e.g.,
prevented)

. . .

When did the
event happen?

Specify the time,
shift, and date of
occurrence

Specify when the
event did not happen

. . .

. . . . . . . . . . . .

6.5 Prioritizing ideas

6.5.1 Voting techniques

After organizing ideas into major themes or classes, we need to find a way of prioritizing
them. Some of the voting techniques that we can apply include:

• Nominal Group Technique (NGT), where the team ranks and prioritizes ideas
from the most to the least important [49].

• Multivoting Technique, which is a version of NGT where instead of ranking ideas,
the team rates them [49]. In practice, multivoting is an iterative process where
the team continues to eliminate low rated ideas until only a few useful suggestions
remain [55].

• Q-sort method, which is another version of NGT where the team ranks and sorts
ideas in descending order of importance [55]. A simple algorithm of this technique
follows:

Step 1: Have each team member (voter) rank ideas

Step 2: Organize the rankings by idea and voter.

Step 3: Sum or average the rankings of each idea.

Step 4: Sort ideas in descending order of magnitude.
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We demonstrate how to implement the Q-sort method in Example 6.1.

Example 6.1 (Q-sort method)
The manager of health informatics at Starling City Hospital has requested ideas
about how to improve the turn-around-time of record requests. Six ideas (𝐴, . . . ,𝐹)
were generated, and three voters were recruited (𝑉 𝑜𝑡𝑒𝑟#1,𝑉 𝑜𝑡𝑒𝑟#2, and 𝑉 𝑜𝑡𝑒𝑟#3)
to help rank these ideas. The Q-sort algorithm was implemented, as follows:

Rank Voter #1 Voter #2 Voter #3 Idea Voter #1 Voter #2 Voter #3

6 F E D A 5 3 4

5 A B E B 2 5 1

4 C C A C 4 4 3

3 E A C D 1 2 6

2 B D F E 3 6 5

1 D F B F 6 1 2

Idea Voter #1 Voter #2 Voter #3 Sum Idea Voter #1 Voter #2 Voter #3 Sum

A 5 3 4 12 E 3 6 5 14

B 2 5 1 8 A 5 3 4 12

C 4 4 3 11 C 4 4 3 11

D 1 2 6 9 D 1 2 6 9

E 3 6 5 14 F 6 1 2 9

F 6 1 2 9 B 2 5 1 8

Step 3 Step 4

Step 1 Step 2

In this case, idea E has the highest rank and should, therefore, be prioritized for
quality improvement efforts of the record request process.

6.5.2 Failure Modes and Effects Analysis (FMEA)

FMEA is a technique that we employ to quantify risk in terms of the factors of the likeli-
hood, detectability, and severity of the failure [43]. We typically rate each factor on a
scale of 1 to 5 [55] or 1 to 10 [43]. The implementation of the scale of 1 to 10 looks like
this:

1. The likelihood of the failure (rated on 1 to 10 scale with 1=not likely and 10 =
almost certain)

2. The detectability of the failure (rated on 1 to 10 scale with 1 = very likely to detect
and 10 = very unlikely to detect).

3. The severity of the failure (rated on a 1 to 10 scale with 1 = little impact and 10 =
catastrophic impact)

To measure the risk of each potential problem, we calculate its risk priority number
(RPN), as follows:

𝑅𝑃𝑁 = 𝑙𝑖𝑘𝑒𝑙𝑖ℎ𝑜𝑜𝑑 × 𝑑𝑒𝑡𝑒𝑐𝑡𝑎𝑏𝑖𝑙𝑖𝑡𝑦 × 𝑠𝑒𝑣𝑒𝑟𝑖𝑡𝑦 (6.1)
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The problem with the highest RPN should be prioritized for improvement or prevention
efforts.

Example 6.2 (FMEA)
Metropolis Hospital would like to quantify the risk of potential patient care problems
using the FMEA tool. The issues of concern are:

1. The wrong site of surgery

2. Medication error

3. Nosocomial infection

4. Injury

After an in-depth discussion with medical providers and an extensive analysis of
historical data, the quality team rated each adverse effect on a scale of 1 to 10, as
portrayed in Table 6.2.

Table 6.2: Potential quality risks in patient care

Severity Likelihood Detectability

The Wrong site of surgery 10 1 2

Medication error 8 3 4

Nosocomial infection 6 4 1

Injury 7 5 1

Subsequently, the RPN measure of each event was determined as summarized in
Table 6.3.

Table 6.3: RPN measures

Severity Likelihood Detectability RPN

Medication error 8 3 4 96

Injury 7 5 1 35

Nosocomial infection 6 4 1 24

The Wrong site of surgery 10 1 2 20

Based on the RPN results in Table 6.3, Metropolis Hospital should prioritize the
prevention efforts of medication errors.
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6.5.3 Force-field analysis

Force-field analysis is a technique that is broadly used to evaluate driving and restraining
forces of a particular event. In the context of quality improvement, we could apply this
tool in the Analyze and Improve phases of DMAIC to identify potential risks and hindering
forces to the proposed solutions. We illustrate how to create a force-field plot in Example
6.3.

Example 6.3 (Force-Field Analysis)
After conducting several data quality audits, the new manager of health informatics
at Metropolis Hospital has determined that nearly 80% of all data quality prob-
lems are the result of entry errors. The manager believes that strong data integrity
controls and friendlier user interfaces could fix the problem. So, the manager is
suggesting automating many data entry tasks, creating drop-down menus of op-
tions, instituting immediate validation of entered data, and enforcing all referential
and domain integrity rules. Before implementing these solutions, the manager held
brainstorming sessions with employees and experts to request feedback about the
proposed changes. Subsequently, the manager organized the received ideas in a
force-field analysis plot, as depicted in Figure 6.4.

Figure 6.4: A force-field analysis of data quality problems at Metropolis Hospital

Lack of experience in data 
entry skill sets due to high 

turn-over rate

Proposed solution: implementing data 
integrity controls

Employees’ resistance due to 
increased data entry time 

from new integrity controls

Lack of in-hospital experts to 
create data quality controls

Patient complains about 
wrong demographic data

Driving forces Restraining forces

Potential for medical error 
due to wrong data

Potential for data reporting 
and billing errors

Lack of control  and 
resources to manage 
external data sources
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The manager will use the results from this analysis to refine and implement feasible
solutions. A pilot implementation, on a small scale, is recommended.
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6.6 Check your understanding

1. What visual tool can we use to evaluate a potential relationship between two
variables?

(a) Scatter plot

(b) Cause-and-effect diagram

(c) Box plot

(d) Stem-and-leaf diagram

2. Which tool can we apply to group similar ideas?

(a) Q-sort

(b) Affinity

(c) Failure mode

(d) Marginal plots

3. When we specify the type of customer who was affected vs. the type of customer
who was not affected, we are likely performing

(a) an is-is not analysis

(b) a cause-and-effect analysis

(c) force-field analysis

(d) failure mode and effect analysis

4. Restraining forces are often discussed in which type of analysis?

(a) Cause-and-effect

(b) Force-field

(c) Failure mode

(d) Scatter

5. From a brainstorming session, you have generated the following potential causes
of IT events.
recent changes in network/server vendor to save money; some workstations don’t
have updated anti-virus programs; network switch configuration; bandwidth con-
gestion; shortage of IT staff by 2 programmers; lack of software maintenance by
vendor; users lack training/skills to use software properly; lack of data governance
policies and procedures; lack of communication among IT staff; some hardware in
unsafe locations; legacy computer system; lack of integrity control on data entry;
password sharing among users; dependence on technology; no plan B for power
failures; outdated business rules.

Organize these ideas on a fishbone diagram. What can you conclude?
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6. Following from the previous question, organize the potential causes into, at most,
four significant classes using affinity grouping? Justify your classification and dis-
cuss the significance of the resulting groups.

7. Consider the problem of medication errors. Consult external sources and organize
potential causes using a 5Whys diagram. Explain your work and cite your sources.

8. Following from the previous question, suppose you have concluded that a CPOE
system could help mitigate medication errors. Construct a force-field analysis and
identity driving and potential hindering forces to your solution.

9. The manager of Health Informatics at Metropolis Hospital has rated potential risks
of data quality problems, as illustrated in Table 6.4. What issue should be priori-
tized, given the risk?

Table 6.4: Potential risks of data quality problems at Metropolis Hospital

Severity Likelihood Detectability

Non-unique entities 6 1 1
Information from the wrong patient 10 3 9
Incomplete non-full fields 9 1 1
Outdated security standards 8 2 6
Inconsistent metadata 3 7 4
Downtime of the EHR system 4 10 1
Typos in the free text fields 7 9 5

10. You have consulted a team of 4 experts to help vote on the best idea for improving
the problem of inconsistency of medical information in the EHR system of your
hospital. There are 8 possible solutions (A,..., H), and each expert ranked them
from best to least, as follows:

(a) Expert_1: [H, B, G, F, D, C, A, E]

(b) Expert_2: [C, B, H, G, F, D, A, E]

(c) Expert_3: [E, A, D, H, C, B, G, F]

(d) Expert_4: [E, F, G, H, A, B, C, D]

Rank the solutions using the Q-sort technique. Discuss your results.



MODULE 7

Tools for benchmarking quality

In this module, we review techniques for benchmarking quality by com-
paring sample or population statistics from different sources in the pro-
cess. The statistical concepts that we apply include hypothesis testing,
the analysis of variance (ANOVA), and the chi-square test. Other tools
we discuss include league tables, the analysis of means (ANOM), and
funnel charts.

Key concepts and tools: Benchmarking quality; Measuring a process; Gauge anal-
ysis; Repeatability & Reproducibility (R&R) study; ANOVA; ANOM; Chi-square test;
League tables; Contingency tables; Contingency tables; Report cards; Funnel charts

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools of benchmarking quality

2. Understand the need for measuring and benchmarking quality

3. Discuss the use of quality report cards in health care

4. Identify common statistical tools for comparing sample or population statistics

5. Apply hypothesis testing techniques

6. Implement funnel charts

7. Implement ANOM charts

8. Apply the ANOVA test to analyze the R&R study

9. Compute and interpret Chi-square tests

10. Advocate for benchmarking methods to improve quality in health care

126
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7.1 Introduction

In this module, we review techniques for “benchmarking quality” by comparing sample
or population statistics from different sources in the process. The tools that we discuss
include hypothesis tests that, ANOVA, Chi-square tests, ANOM, and funnel charts.

7.2 Statistical background

7.2.1 Confidence interval

In Module 4, we briefly discussed the concepts of sample statistics and point estimators.
In this subsection, we extend these ideas into the related topic of confidence interval.

Definition 7.1 A confidence interval is a range constructed from sample statistics
to estimate a probabilistic interval that covers a given population parameter [36]

We create a confidence interval by setting lower and upper confidence limits of a param-
eter of interest. Here, we only review how to generate the confidence intervals of the
population mean 𝜇 and variance 𝜎2 when the population is normally distributed.

Given a lower confidence limit 𝐴 and an upper confidence limit 𝐵, we denote the
probability of the population mean 𝜇 falling between 𝐴 and 𝐵 as follows:

𝑃 {𝐴 ≤ 𝜇 ≤ 𝐵} = 1−𝛼 (7.1)

where 𝛼 is the significance level or the error that we are willing to commit. Using 𝛼, we
calculate the percentage of our confidence level this way: 100(1-𝛼)%. Equation 7.1
reflects a two-sided confidence interval. A one-sided confidence interval looks like this:

𝑃 {𝐴 ≤ 𝜇} = 1−𝛼 or 𝑃 {𝜇 ≤ 𝐵} = 1−𝛼 (7.2)

The confidence interval of the population mean 𝜇

Assuming normally distributed population, we construct a confidence interval of 𝜇 by
considering the following two cases:

Case 1: a confidence interval of 𝜇 when 𝜎 is known
From the notion of CLT in Definition 4.3, we use the standardized value 𝑍 to con-
struct the confidence interval of 𝜇 this way:

𝜇 = 𝑥 ±𝑍𝛼/2
𝜎
√
𝑛

(7.3)

where 𝛼/2 signifies a two-sided confidence interval. In a one-sided confidence
interval, we replace 𝛼/2 with 𝛼. We typically construct this confidence interval
when the sample size 𝑛 is large enough to allow for a good point estimation of the
population standard deviation (e.g., 𝑛 ≥ 30 [36]).
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Case 2: a confidence interval of 𝜇 when 𝜎 is unknown
In this case, we use the t-distribution to determine the confidence interval of 𝜇.
Using Equation 4.9, we proceed as follows:

𝜇 = 𝑥 ± 𝑡𝛼/2,𝑛−1
𝑠
√
𝑛

(7.4)

where 𝑠 is the sample standard deviation, and 𝑛 − 1 represents the degrees of
freedom. In a one-sided confidence interval, we replace 𝛼/2 with 𝛼. We typically
employ this confidence interval technique for smaller sampler sizes (e.g., 𝑛 < 30
[36])

The confidence interval of the population variance 𝜎2

When the population is normally distributed, and we know neither the mean 𝜇 nor the
variance 𝜎2, we use sample statistics and the Chi-square distribution 𝜒2 to create a two-
sided confidence interval for 𝜎2, as follows [43]:

(𝑛− 1)𝑠2

𝜒2
𝛼/2,𝑛−1

≤ 𝜎2 ≤ (𝑛− 1)𝑠2

𝜒2
1−𝛼/2,𝑛−1

(7.5)

Here, 𝑠2 is the sample variance, and 𝑛 − 1 represents the degrees of freedom. We
determine a one-sided confidence interval this way:

𝜎2 ≤ (𝑛− 1)𝑠2

𝜒2
1−𝛼,𝑛−1

(7.6)

How-To 7.1 (Confidence intervals of 𝜇 and 𝜎2 in Minitab 18)
Click on Stats > Basic Statistics. For the confidence interval of 𝜇 when 𝜎 is known,
choose 1-Sample Z. For the confidence interval of 𝜇 when 𝜎 is unknown, choose
1-Sample t. For the confidence interval of 𝜎2, choose 1 Variance. Note: Minitab
may give you the confidence interval of the standard deviation, instead of that of
the variance. Simply square the given limits to obtain the confidence interval of the
variance. See the snapshot in Figure 7.1.
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Figure 7.1: Options for the confidence intervals of 𝜇 and 𝜎2 in Minitab 18

How-To 7.2 (Confidence intervals of 𝜇 and 𝜎2 in Excel 2013)
There is no special option in Excel to calculate confidence intervals, but we can use
the built-in functions to estimate the interval of interest. For example, we estimate
the confidence interval for the population mean like this:

1. When 𝜎 is known, we use the function = −𝑁𝑂𝑅𝑀.𝑆.𝐼𝑁𝑉 (𝛼/2) to de-
termine 𝑍𝛼/2. For example, when 𝛼 = 0.05, we find 𝑍0.05/2 = 𝑍0.025 by
= −𝑁𝑂𝑅𝑀.𝑆.𝐼𝑁𝑉 (0.025) = 1.96.

2. When 𝜎 is unknown, we use the function = −𝑇 .𝐼𝑁𝑉 (𝛼/2,𝑛−1) to obtain the
critical value of the t-distribution. For example, when 𝛼 = 0.05, and 𝑛 = 10, we
find the critical value by = −𝑇 .𝐼𝑁𝑉 (𝛼/2,𝑛− 1) = −𝑇 .𝐼𝑁𝑉 (0.025,9) = 2.262.

We can use Excel to construct the confidence interval for the population variance
𝜎2 by first determining the pertaining values of the Chi-square distribution. For
example, we determine 𝜒2

1−𝛼/2,𝑛−1 as = 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (1−𝛼/2,𝑛−1). To obtain
𝜒2
𝛼/2,𝑛−1, we use this function: = 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (𝛼/2,𝑛− 1).

Example 7.1 (Confidence Interval in Excel 2013)
Following from Example 4.1, we show how to determine a two-sided 95% confi-
dence interval of 𝜇 for the sample on day #1. Given 𝜎 is unknown, we determine
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the confidence interval this way:

𝜇 = 1.32± 2.77645(0.4/
√
5) (7.7)

= (0.82,1.82) (7.8)

The value 2.77645 is the critical value that we obtained by = 𝑇 .𝐼𝑁𝑉 (0.025,4),
where 𝛼/2 = 0.025 and 𝑛− 1 = 5− 1 = 4 are degrees of freedom.

7.2.2 Hypothesis testing

We conduct a hypothesis test to evaluate the likelihood of our belief about the value of
the population parameter. During hypothesis testing, we make two statements. Our first
statement that we call the null hypothesis or 𝐻0 expresses our belief that the population
parameter equals a particular value or falls within a given range. Our second statement
that we call an alternative hypothesis or 𝐻1, opposes the first statement. We reject 𝐻0,
when a derived test statistic is greater than a given critical value or when the 𝑝-𝑣𝑎𝑙𝑢𝑒
< 𝛼. Otherwise, we fail to reject 𝐻0. As before, 𝛼 is the significance level, or simply the
error that we are willing to commit.

Hypothesis test for the process mean

We start by assuming that 𝜇 = 𝜇0, where 𝜇0 is the conjectured value. We formulate a
two-tailed or two-sided hypothesis test as follows:

𝐻0 : 𝜇 = 𝜇0 (7.9)
𝐻1 : 𝜇 , 𝜇0 (7.10)

Alternatively, we can create a one-tailed or one-sided test this way:

𝐻0 : 𝜇 = 𝜇0 (7.11)
𝐻1 : 𝜇 < 𝜇0 (7.12)

or as:

𝐻0 : 𝜇 = 𝜇0 (7.13)
𝐻1 : 𝜇 > 𝜇0 (7.14)

Next, we find and compare the test statistic 𝑍0 to the corresponding critical value 𝑍𝛼.
In a normally distributed process where 𝜎 is known, we refer to our hypothesis test as
the Z-test. We obtain the test statistic 𝑍0 as follows:

𝑍0 =
𝑥 −𝜇
𝜎/
√
𝑛

(7.15)

The critical value is given by 𝑍𝛼/2 in a two-sided test or 𝑍𝛼 in a one-sided test. We reject
𝐻0 when |𝑍0| > 𝑍𝛼/2 in a two-sided test or when |𝑍0| > 𝑍𝛼 in a one-sided test. We use |.|
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symbols to denote the absolute value function. When the population standard deviation
𝜎 is unknown, we conduct a t-test, instead of a Z-test, and obtain the test statistic 𝑡0
this way:

𝑡0 =
𝑥 −𝜇
𝑠/
√
𝑛

(7.16)

Given the degrees of freedom 𝑛−1, the critical value is obtained by 𝑡𝛼/2,𝑛−1 in a two-sided
test or 𝑡𝛼,𝑛−1 in a one-sided test. In a two-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼/2,𝑛−1. In
a one-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼,𝑛−1.

Hypothesis test for the process variance

We structure a hypothesis test for the process variance like this:

𝐻0 : 𝜎
2 = 𝜎2

0 (7.17)
𝐻1 : 𝜎

2 , 𝜎2
0 (7.18)

where 𝜎2
0 is the variance that we have conjectured. Alternatively, we could set 𝐻1 : 𝜎2 >

𝜎2
0 or 𝐻1 : 𝜎2 < 𝜎2

0 . Assuming normal distribution and unknown population mean and
variance, we use the Chi-square distribution to obtain the test statistic, 𝜒2

0 , as follows:

𝜒2
0 =

(𝑛− 1)𝑠2

𝜎2
0

(7.19)

We recall that 𝑠2 is the sample variance, and 𝑛 − 1 represents the degrees of freedom.
The two-sided critical value is given by 𝜒2

𝛼/2,𝑛−1. We reject the null hypothesis when
𝜒2
0 > 𝜒2

𝛼/2,𝑛−1 or 𝜒2
0 < 𝜒2

1−𝛼/2,𝑛−1. The critical value in a one-sided test is 𝜒2
𝛼,𝑛−1. For

𝐻1 : 𝜎2 > 𝜎2
0 , we reject the null hypothesis when 𝜒2

0 > 𝜒2
𝛼,𝑛−1. For 𝐻1 : 𝜎2 < 𝜎2

0 , we reject
the null hypothesis when 𝜒2

0 < 𝜒2
1−𝛼,𝑛−1 [43].

7.2.3 P-value

We have briefly introduced p-value before as a probability measure of a hypothesis test.
We formally define this quantity next.

Definition 7.2 (P-value)
𝑝-𝑣𝑎𝑙𝑢𝑒 is the probability that one would observe a test statistic that was greater or
equal to the given critical value, if the null hypothesis were true [36]

We recall that the critical value is a statistic that we construct using the confidence
level 𝛼. When 𝑝-𝑣𝑎𝑙𝑢𝑒 < 𝛼, we reject the null hypothesis. Most statistical packages,
such as Minitab, provide us with p-values automatically when we run hypothesis tests. In
a normal distribution, we calculate p-values as follows [43]:

1. 𝐻1 : 𝜇 , 𝜇0, p-value = 2(1−Φ(|𝑍0|))
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2. 𝐻1 : 𝜇 > 𝜇0, p-value = 1−Φ(𝑍0)

3. 𝐻1 : 𝜇 < 𝜇0, p-value = Φ(𝑍0)

𝑍0 is the test statistic that we obtain per Equation 7.15.

7.2.4 The type of error

While testing our hypothesis, we are likely to make two types of errors:

Type I error (𝛼): we reject 𝐻0 when 𝐻0 is true.

Type II error (𝛽): we fail to reject 𝐻0 when 𝐻0 is false.

Operationally speaking, the 𝛼 error is equivalent to erroneously rejecting the quality of a
good product or service. In control chart applications, this type of error is also referred to
as false alarm and signifies the chances of observing erroneous out-of-control signals.
The 𝛽 error is equivalent to mistakenly delivering a bad product or service to the customer
[43]. We choose 𝛼 to indicate the error probability that we are willing to tolerate. When
our process is normally distributed, we typically set 𝛼 = 0.05 and determine 𝛽 this way
[43]:

𝛽 = Φ

(︃
𝑍𝛼/2 −

𝛿
√
𝑛

𝜎

)︃
−Φ

(︃
−𝑍𝛼/2 −

𝛿
√
𝑛

𝜎

)︃
(7.20)

Here, 𝛿 is the difference between the true process parameter and the hypothesized pa-
rameter. For example in the context of the mean, 𝛿 = 𝜇1 − 𝜇0, where 𝜇1 is the true
mean and 𝜇0 is the hypothesized mean. From the 𝛽 error, we obtain the power of our
statistical test as like this:

𝑃 𝑜𝑤𝑒𝑟 = 1− 𝛽 (7.21)

This power test expresses the probability of rejecting the null hypothesis correctly. To
increase the power test, we increase the sample size 𝑛, which in turn decreases 𝛽 per
Equation 7.20. The operating-characteristic (OC) curves can help us choose the proper
sample size to satisfy a particular value of 𝛽 [43]. Minitab has an option for obtaining the
appropriate sample size 𝑛 when the desired power test is provided. Minitab instructions
for the power of 1-sample Z test are shown in 7.3.

How-To 7.3 (Power for 1-sample Z test in Minitab 18)
Click on Stat > Power and Sample Size > select the test of interest. For example,
to determine the sample size in 1-Sample Z Test, leave the sample size field blank,
and specify the difference that you want to detect 𝛿. You also need to specify the
population standard deviation and the desired power value. See the snapshot in
Figure 7.2.
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Figure 7.2: Power and Sample Size for 1-Sample Z Test in Minitab 18

7.3 Comparing the means of two independent samples

We can use hypothesis testing to check whether the means of two independent samples
were drawn from the same population or two similarly distributed populations. To test
whether the population means, 𝜇1 and 𝜇2, are equal, we obtain two samples of sizes 𝑛1
and 𝑛2 and means 𝑥1 and 𝑥2, respectively. We formulate the null hypothesis like this:

𝐻0 : 𝜇1 = 𝜇2 (7.22)

We frame alternative hypotheses as 𝐻1 : 𝜇1 , 𝜇2, 𝐻1 : 𝜇1 > 𝜇2, or 𝐻1 : 𝜇1 < 𝜇2. Assuming
a normally distributed population with the known variance 𝜎2, we apply the Z-test and
obtain the test statistic as follows:

𝑍0 =
𝑥1 − 𝑥2

𝜎
√︁

1
𝑛1

+ 1
𝑛2

(7.23)

If the variance is unknown, we apply the t-test and obtain the test statistic like this:

𝑡0 =
𝑥1 − 𝑥2

𝑠𝑝
√︁

1
𝑛1

+ 1
𝑛2

(7.24)

Here, 𝑠𝑝 is the square root of the pooled variance 𝑠2𝑝 that is computed this way:

𝑠2𝑝 =
(𝑛1 − 1)𝑠21 + (𝑛2 − 1)𝑠22

𝑛1 +𝑛2 − 2
(7.25)
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where 𝑛1 + 𝑛2 − 2 represents the degrees of freedom from two samples [36]. We obtain
critical values and conclude about the null hypothesis as before.

7.4 Comparing the means of more than two independent
samples

Under the assumptions of the normal distribution, independence, and equal variances,
we can test the following hypothesis [36]:

𝐻0 : 𝜇1 = 𝜇2 = · · · = 𝜇𝑚 (7.26)
𝐻1 : the means are not all equal (7.27)

Here, 𝑚 is the index of the samples. Using the Analysis of Variance (ANOVA) test, we
obtain the following test statistic:

𝐹0 =
𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟
(7.28)

where 𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 symbolizes independent samples, 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 is the mean square of
treatments, and 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 is the mean square of the error. Our critical value originates
from the F-distribution and looks like this:

𝐹𝛼,𝑚−1,𝑚(𝑛−1) (7.29)

If 𝐹0 > 𝐹𝛼,𝑚−1,𝑚(𝑛−1), we reject the null hypothesis. We will return to the topic of ANOVA
in Section 7.8.

7.5 Comparing the means of two dependent samples

When two samples are dependent, we conduct hypothesis testing using the paired t-
test. Our test statistic looks like this:

𝑡0 =
𝑑

𝑠𝑑/
√
𝑛

(7.30)

where 𝑑, the mean of the difference between two samples (each with size 𝑛), is given by:

𝑑 =
1
𝑛

𝑛∑︁
𝑗=1

𝑑𝑗 (7.31)

From Equation 7.30, 𝑠𝑑 is the standard deviation of the differences, which is obtained by
taking the square root of the variance 𝑠2𝑑 , given by:

𝑠2𝑑 =
1

𝑛− 1

𝑛∑︁
𝑗=1

(𝑑𝑗 − 𝑑)2 (7.32)

As before, the critical value is given by 𝑡𝛼/2,𝑛−1 in a two-sided test or 𝑡𝛼,𝑛−1 in a one-sided
test. In a two-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼/2,𝑛−1. In the one-sided test, we reject
𝐻0 when |𝑡0| > 𝑡𝛼,𝑛−1.
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7.6 Comparing the means of more than two dependent sam-
ples

Standard statistical software such as Minitab have options to compare the means of more
than two dependent samples, such as when one repeats measures on single or double
factors. See Minitab instructions in How-To 7.6 about how to analyze a design of a single
factor with repeated measures.

How-To 7.4 (Z-test and t-test in Excel 2013)
You can run a t-test in Excel by using this function: =
𝑇 .𝑇 𝐸𝑆𝑇 (𝑠𝑎𝑚𝑝𝑙𝑒1, 𝑠𝑎𝑚𝑝𝑙𝑒2, 𝑡𝑎𝑖𝑙𝑠, 𝑡𝑦𝑝𝑒). In the tails option, you specify whether the
test is one or two-tailed. In the type option, you specify whether you are running a
paired t-test (1), a t-test with equal variances (2), or a t-test with unequal variances
(3). You can also run a t-test via the Data Analysis add-in. For that, open the
Data Analysis add-in, as shown in the snapshot portrayed in Figure 7.3 and select
the appropriate test (see the snapshot in Figure 7.4).

Figure 7.3: Excel 2013 Data Analysis add-in option

Figure 7.4: Z-test and t-test via Data Analysis add-in option in Excel 2013

If the Data Analysis add-in is not loaded, you can add it by clicking on File >Options
> Add-ins > Analysis ToolPak > Manage: Excel Add-in > Check the box of Analysis
ToolPak >OK.
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How-To 7.5 (Z-test and t-test in Minitab 18)
To conduct a Z-test or a t-test in Minitab 18, click on Stat>Basic Statistics and
select the appropriate test. See the snapshot portrayed in Figure 7.5.

Figure 7.5: Z-test and t-test options in Minitab 18

How-To 7.6 (Single factor with repeated measures in Minitab 18)
To conduct an analysis of a single factor design with repeated measures in Minitab
18, click on Stat > ANOVA > General Linear Model > Fit General Linear Model >
Select Factors > Select Responses > Click on Random/Nest >Factor Type >Ran-
dom >OK.

Example 7.2 (Hypothesis testing)
This example follows the case study and data presented in Example 4.1.

1. For demonstrations purposes, we conduct a hypothesis test to see if sample
# 1 and sample #2 in Table 4.1 were drawn from the same population. We
state our hypothesis as follows:

𝐻0 : 𝜇1 = 𝜇2 (7.33)
𝐻1 : 𝜇1 , 𝜇2 (7.34)

At 𝛼 = 0.05 and unknown variance, we use Equation 7.24 to obtain the test
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statistic 𝑡0 this way:

𝑡0 =
𝑥1 − 𝑥2

𝑠𝑝
√︁

1
𝑛1

+ 1
𝑛2

(7.35)

=
1.32− 2.61

0.36
√︁

1
5 +

1
5

(7.36)

= −5.61666444 (7.37)

We use Equation 7.25 to compute the value of 𝑠𝑝 as follows:

𝑠2𝑝 =
(𝑛1 − 1)𝑠21 + (𝑛2 − 1)𝑠22

𝑛1 +𝑛2 − 2
(7.38)

=
(5− 1)0.1612 + (5− 1)0.1032

5+5− 2
(7.39)

= 0.131875 (7.40)

So, 𝑠𝑝 =
√︁
𝑠2𝑝 =

√
0.131875 = 0.363145976 ≈ 0.36. With 𝑛1 + 𝑛2 − 2 = 5 +

5 − 2 = 8 and 𝛼/2 = 0.05/2 = 0.025. We obtain the critical value 𝑡0.025,8 in
Excel using = −𝑇 .𝐼𝑁𝑉 (0.025,8) = 2.306004135. Since |𝑡0| > 2.306004135,
we reject the null hypothesis. We could have reached the same conclusion
by computing the p-value in Excel as follows:

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 𝑇 .𝑇 𝐸𝑆𝑇 (𝐵3 : 𝐵3,𝐵4 : 𝐵4,2,2) (7.41)
= 0.0005 (7.42)

Since 𝑝 − 𝑣𝑎𝑙𝑢𝑒 < 𝛼 = 0.05, we once again reject the null hypothesis.

7.7 Comparing variances of two independent samples

We hypothesize that two samples (sample 1 and sample 2), with variances 𝑠21 and 𝑠22,
were drawn from two independent populations with equal variances, 𝜎2

1 and 𝜎2
2 . We

create a hypothesis test to validate our conjecture as follows:

𝐻0 : 𝜎
2
1 = 𝜎2

2 (7.43)
𝐻1 : 𝜎

2
1 , 𝜎

2
2 (7.44)

Using F-distribution, we obtain the test statistic this way:

𝐹0 =
𝑠21
𝑠22

(7.45)

The lower critical value is given by 𝐹1−𝛼/2,𝑛1−1,𝑛2−1 whereas the upper critical value is
given by 𝐹𝛼/2,𝑛1−1,𝑛2−1. Here, 𝑛1 − 1 and 𝑛2 − 1 are degrees of freedom of sample 1 and
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sample 2, respectively. If 𝐹0 > 𝐹𝛼/2,𝑛1−1,𝑛2−1 or 𝐹0 < 𝐹1−𝛼/2,𝑛1−1,𝑛2−1 we reject the null
hypothesis. To perform a one-sided test, we formulate 𝐻1 and 𝐹0 statistics this way:

𝐻1 : 𝜎
2
1 > 𝜎2

2 , 𝐹0 = 𝑠21/𝑠
2
2 (7.46)

𝐻1 : 𝜎
2
1 < 𝜎2

2 , 𝐹0 = 𝑠22/𝑠
2
1 (7.47)

For the case of 𝐻1 : 𝜎2
1 > 𝜎2

2 , we reject the null hypothesis when 𝐹0 > 𝐹𝛼,𝑛2−1,𝑛1−1. For
the case of 𝐻1 : 𝜎

2
1 < 𝜎2

2 , we reject the null hypothesis when 𝐹0 < 𝐹𝛼,𝑛1−1,𝑛2−1.

How-To 7.7 (F-test in Excel 2013)
To calculate the critical value of 𝐹𝛼, 𝑛1−1, 𝑛2−1 in Excel 2013, use this func-
tion = 𝐹.𝐼𝑁𝑉 .𝑅𝑇 (𝛼, 𝑛1 − 1, 𝑛2 − 1). You can estimate the p-value by =
𝐹.𝐷𝐼𝑆𝑇 .𝑅𝑇 (𝐹0, 𝑛1 − 1, 𝑛2 − 1). You can also conduct the F-test using the Data
Analysis add-in under the Data tab. Choose the option of F-test Two-Sample for
Variances.

How-To 7.8 (F-test in Minitab 18)
Click on Stat > Basic Statistics > 2 Variances. Review the snapshot in Figure 7.1.
Note that Minitab runs the test on equal standard deviations, but this will not alter
your conclusion.

7.8 ANOVA

ANOVA is a powerful statistical test that we use to examine the equality of the means
in more than two independent samples. We assume that the samples are normally dis-
tributed with equal variances. The two types of the ANOVA test that we consider here are
one-way ANOVA and two-way ANOVA. In both cases, we work with the sum of squares
(𝑆𝑆) to formulate the statistical tests of interest.

7.8.1 One-way ANOVA

In a one-way ANOVA test, we obtain the total sum of squares (𝑆𝑆𝑡𝑜𝑡𝑎𝑙) in the data as
follows:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (7.48)

The word 𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 is used to denote independent samples. The 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 term
represents the between samples variation, whereas the 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 term symbolizes the
within samples variation. Let’s assume that we have 𝑎 number of samples, each with
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size 𝑛. We determine the corresponding sum of squares as follows:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 =
𝑎∑︁

𝑖=1

𝑛∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦..)2 (7.49)

𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑛
𝑎∑︁

𝑖=1

(𝑦𝑖. − 𝑦..)2 (7.50)

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑎∑︁

𝑖=1

𝑛∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦𝑗.)2 (7.51)

where 𝑦𝑖𝑗 is the entry in row 𝑖 and column 𝑗, 𝑦.. is the overall mean of the data, 𝑦𝑖. is the
mean of row 𝑖, and 𝑦𝑗. is the mean of column 𝑗. The degrees of freedom (𝑑𝑓 ) are given
by:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑎𝑛− 1 (7.52)
𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑎− 1 (7.53)

𝑑𝑓𝑒𝑟𝑟𝑜𝑟 = 𝑎(𝑛− 1) (7.54)

It follows that:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 (7.55)

Using the sum of squares and the degrees of freedom, we obtain the mean squares (𝑀𝑆)
this way:

𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 =
𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠
(7.56)

𝑀𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑑𝑓𝑒𝑟𝑟𝑜𝑟

(7.57)

The 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 term estimates the variance in treatments. The 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 term is the
unbiased estimator of the variance of the model residuals in Equation 7.48 [43]. We use
the ratio between 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 and 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 to obtain the following F-test statistic:

𝐹0 =
𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟
(7.58)

A one-tailed critical value is given by:

𝐹𝛼, 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠, 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 ≡ 𝐹𝛼, 𝑎−1, 𝑎(𝑛−1) (7.59)

At the significance level 𝛼, we reject the null hypothesis when 𝐹0 > 𝐹𝛼, 𝑎−1, 𝑎(𝑛−1). Our
conclusion implies that at least one mean is different. The ANOVA test does not identify
the different mean in question.
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How-To 7.9 (P-value for the F-test in Excel 2013)
To estimate the p-value for the F-test in Equation 7.58, use =
𝐹.𝐷𝐼𝑆𝑇 .𝑅𝑇 (𝐹0, 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡, 𝑑𝑓𝑒𝑟𝑟𝑜𝑟).

7.8.2 Two-way ANOVA

In a two-way ANOVA test, we add a blocking variable 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 and 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 becomes:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (7.60)

The 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 term represents different blocks or conditions under which the sample
data were collected. If data were arranged in a table format, we could view treatments
as independent rows and blocks as independent columns. Given 𝑎 number of treatments
and 𝑏 number of blocks, we formulate the sum of squares of a two-way ANOVA this way:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 =
𝑎∑︁

𝑖=1

𝑏∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦..)2 (7.61)

𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑏
𝑎∑︁

𝑖=1

(𝑦𝑖. − 𝑦..)2 (7.62)

𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 = 𝑎
𝑏∑︁

𝑖=1

(𝑦.𝑗 − 𝑦..)2 (7.63)

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑎∑︁

𝑖=1

𝑏∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦𝑖. − 𝑦.𝑗 + 𝑦..)
2 (7.64)

≡ 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 − 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 − 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 (7.65)

As earlier, we can view 𝑦𝑖𝑗 as the entry in row 𝑖 and column 𝑗, 𝑦.. is the overall mean
of the data, 𝑦𝑖. is the mean of row 𝑖, and 𝑦𝑗. is the mean of column or block 𝑗. To obtain
the degrees of freedom (𝑑𝑓 ), we proceed as follows:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑎𝑏 − 1 (7.66)
𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = (𝑎− 1) (7.67)
𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 = (𝑏 − 1) (7.68)

𝑑𝑓𝑒𝑟𝑟𝑜𝑟 = (𝑎− 1)(𝑏 − 1) (7.69)

where

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 (7.70)

We summarize the two-way mean squares and the corresponding 𝐹0 statistics in Table
7.1.
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Table 7.1: Mean Squares and the 𝐹0 statistics of a two-way ANOVA test

Source of variation Mean Square 𝐹0

Treatments 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 =
𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟

Blocks 𝑀𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 =
𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔
𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔

𝑀𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔
𝑀𝑆𝑒𝑟𝑟𝑜𝑟

Error 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑑𝑓𝑒𝑟𝑟𝑜𝑟

Just like in a one-way ANOVA test, we draw conclusions about our hypothesis by
comparing the 𝐹0 statistic to the critical value. We could also use p-values to interpret
the significance of the test.

In some applications such as in designed experiments and gauge analysis, we can
further decompose 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 to include the term representing the interaction between
treatments and the blocking variables. With this new component, 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 becomes:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑆𝑆𝑖𝑛𝑡𝑒𝑟𝑎𝑐𝑡𝑖𝑜𝑛 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (7.71)

From the model in Equation 7.71, the degrees of freedom of the interaction term are given
by (𝑎−1)(𝑏−1). We obtain the test statistic by taking the ratio between 𝑀𝑆𝑖𝑛𝑡𝑒𝑟𝑎𝑐𝑡𝑖𝑜𝑛 and
𝑀𝑆𝑒𝑟𝑟𝑜𝑟 . The conclusion about the null hypothesis would be as before.

How-To 7.10 (ANOVA test in Minitab 18)
To run the ANOVA test in Minitab 18, click on Stat > ANOVA. For a one-way ANOVA
test, click on One-Way. For a two-way ANOVA test, click on the General Linear
Model. See the snapshot in Figure 7.6.
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Figure 7.6: Options for the ANOVA test in Minitab 18

How-To 7.11 (ANOVA test in Excel 2013)
Open the Data Analysis add-in. For a one-way ANOVA test, use the option of
Anova: Single Factor. For a two-way ANOVA test without replication, use Anova
Two-Factor Without Replication. When the sample data has replications, use
Anova: Two-Factor With Replication. See the snapshot in Figure 7.7.

Figure 7.7: Options for the ANOVA test in Excel 2013 using the Data Analysis
add-in
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Example 7.3 (ANOVA test and a linear regression model)
The operating room (OR) manager at Metropolis Hospital would like to test whether
there is a statistical difference in the OR time for the Laparoscopic Cholecystectomy
procedures by the physician. Additionally, the manager wants to assess whether
the OR location is a significant factor in the regression model since some of the ORs
still use old information technology (IT). The manager has hypothesized that there
is no difference in the average duration of the procedure either by the physicians or
the OR location.

Table 7.2: Averages of OR time for Laparoscopic Cholecystectomy procedures in
minutes, Metropolis Hospital, 2018

PhysicianA PhysicianB PhysicianC PhysicianD PhysicianE

3N 68 61 58 58 38
3S 72 69 59 63 41
4E 59 64 73 80 48
4W 75 79 77 70 60

As displayed in Table 7.2, the physicians under study are PhysicianA, PhysicianB,
PhysicianC, PhysicianD, and PhysicianE. For OR locations, the manager is
evaluating 3N, 3S, 4E, and 4W.

One-way ANOVA test results
Table 7.3 portrays one-way ANOVA test results for physicians. We obtained these
results using the Data Analysis add-in in Excel.

Table 7.3: One-Way ANOVA test for physicians

Anova: Single Factor

SUMMARY

Groups Count Sum Average Variance

PhysicianA 4 274 68.5 48.33333
PhysicianB 4 273 68.25 62.25
PhysicianC 4 267 66.75 93.58333
PhysicianD 4 271 67.75 90.91667
PhysicianE 4 187 46.75 95.58333

ANOVA

Source of Variation SS df MS F P-value F crit

Between Groups 1426.8 4 356.7 4.565273 0.013039 3.055568
Within Groups 1172 15 78.13333

Total 2598.8 19
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From the results in Table 7.3, we notice that the p-value of 0.01 is less than the
significance level 𝛼 = 0.05. Besides, we can see that 𝐹 > 𝐹𝑐𝑟𝑖𝑡. So, we reject
the null hypothesis that the mean of the operative time among physicians is the
same. Minitab yields similar statistical results with an added interval plot displayed
in Figure 7.8.

Figure 7.8: A one-way ANOVA interval plot for physicians in Minitab 18

From Figure 7.8, we can deduce that the operative time of PhysicanE is different
from that of other physicians, which probably is what has made the statistical test
significant. We can also run a one-way ANOVA test by location. Table 7.4 presents
results from the Data Analysis add-in in Excel.



Module 7. Tools for benchmarking quality 145

Table 7.4: One-Way ANOVA test results for locations

Anova: Single Factor

SUMMARY

Groups Count Sum Average Variance

3N 5 283 56.6 124.8
3S 5 304 60.8 148.2
4E 5 324 64.8 153.7
4W 5 361 72.2 57.7

ANOVA

Source of Variation SS df MS F P-value F crit

Between Groups 661.2 3 220.4 1.819983 0.184121 3.238872
Within Groups 1937.6 16 121.1

Total 2598.8 19

Given that the p-value in Table 7.4 is greater than the significance level 𝛼, we fail
to reject the null hypothesis. The corresponding Minitab interval plot is portrayed in
Figure 7.9

Figure 7.9: A one-way ANOVA interval plot for locations in Minitab 18

Next, we run a two-way ANOVA test to combine both the variables of physicians
and locations into one model. This approach will allow us to assess whether there
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is a difference in OR time by the physician, given location and vice-versa.

Two-way ANOVA results
Table 7.5 portrays two-way ANOVA test results from the Data Analysis add-in in
Excel.

Table 7.5: Excel Two-Way ANOVA test for physicians and locations

Anova: Two-Factor Without Replication

SUMMARY Count Sum Average Variance

3N 5 283 56.6 124.8
3S 5 304 60.8 148.2
4E 5 324 64.8 153.7
4W 5 361 72.2 57.7

PhysicianA 4 274 68.5 48.33333
PhysicianB 4 273 68.25 62.25
PhysicianC 4 267 66.75 93.58333
PhysicianD 4 271 67.75 90.91667
PhysicianE 4 187 46.75 95.58333

ANOVA

Source of Variation SS df MS F P-value F crit

Rows 661.2 3 220.4 5.17776 0.015894 3.490295
Columns 1426.8 4 356.7 8.379796 0.001819 3.259167
Error 510.8 12 42.56667

Total 2598.8 19

Based on the p-values in Table 7.5, we conclude that both the physician and loca-
tion are statistically significant. This time, we reject the hypotheses that the OR time
is the same by both physician and location. We recall that the one-way ANOVA test
previously indicated no significant difference in the OR time by the location. What
changed in the two-way ANOVA test is that the sum of square error decreased after
combining both variables, which in turn contributed to the increase in the test statis-
tics of both variables. As we have discussed before, every time we add variables to
the model, the sum of the square of the error will decrease. So, we must calculate
𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , instead of simply 𝑅2, to ascertain the goodness-of-fit of our model. We
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use Equation 5.21 and information from Table 7.5 to determine 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , as follows:

𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 = 1−

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 /(𝑛− 𝑝)
𝑆𝑆𝑡𝑜𝑡𝑎𝑙/(𝑛− 1)

(7.72)

= 1− 510.8/(12)
2598.8/(19)

(7.73)

= 0.688792263 (7.74)

In other words, we can say about 69% of the variation in the OR time can be
explained by the variation in both the physician and location variables.

To run a two-way ANOVA test in Minitab, we rearrange the data from Table 7.3 as
depicted in Table 7.6. Then, we fit a General Linear Model, as indicated in How-To
7.10.

Table 7.6: Reorganized data for a two-way ANOVA test in Minitab 18

Location Physician Data

3N PhysicianA 68
3N PhysicianB 61
3N PhysicianC 58
3N PhysicianD 58
3N PhysicianE 38
3S PhysicianA 72
3S PhysicianB 69
3S PhysicianC 59
3S PhysicianD 63
3S PhysicianE 41
4E PhysicianA 59
4E PhysicianB 64
4E PhysicianC 73
4E PhysicianD 80
4E PhysicianE 48
4W PhysicianA 75
4W PhysicianB 79
4W PhysicianC 77
4W PhysicianD 70
4W PhysicianE 60

Minitab yields similar ANOVA test results. Furthermore, Minitab provides us with
several graphical plots, as portrayed in Figure 7.10. The main effect plot in Sub-
figure 7.10a suggests that OR time is at the lowest level when 3N is used. This
subfigure also indicates that PhysicianE utilizes the least amount of OR time. The
interaction plot in Subfigure 7.10b shows variability in the means of operative times
by physician and location. From this subfigure, we deduce that 3N yields the lowest
operative time for most physicians except physicianA. Additionally, the lowest op-
erative time occurs when PhysicianE uses 3N. The greatest variability in operative
time seems to happen when physicians use 4E.
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Figure 7.10: Main effects and interaction plots

(a) (b)

Linear regression model
The following linear regression model resulted from Minitab’s two-way ANOVA test
results.

𝑂𝑅𝑡𝑖𝑚𝑒 = 77.10− 15.60𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_3𝑁 − 11.40𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_3𝑆
− 7.40𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_4𝐸 +0.0𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_4𝑊 +0.0𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐴
− 0.25𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐵− 1.75𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐶
− 0.75𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐷 − 21.75𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐸

We can use the coefficients of this regression model to infer how much effect
different variables have on the OR time. Minitab indicates that only the coefficients
of 𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_3𝑁 , 𝐿𝑜𝑐𝑎𝑡𝑖𝑜𝑛_3𝑆, and 𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛_𝑃 ℎ𝑦𝑠𝑖𝑐𝑖𝑎𝑛𝐸 are statistically signifi-
cant. Accordingly, we can say that for each additional unit of procedure performed
in the OR located at 3N, OR time decreases by 15.60 minutes on average when all
other variables are held constant. Likewise, for each additional unit of procedure
performed in the OR located at 3S, OR time decreases by 11.40 minutes on
average, and for each additional unit of procedure performed by PhysicianE, OR
time decreases by 21.75 minutes on average. In both cases, all other variables are
held constant.

Residual plots
The residual plots of our regression model are shown in Figure 7.11. Subfigure
7.11a indicates that the residuals points fall alongside the fitted line, thus suggest-
ing the normal distribution of the residuals. Moreover, the plot of the residuals
versus the fitted values in Subfigure 7.11b seems to portray random behaviors,
another confirmation of the normality of the residuals. Although, we do notice a
mild resemblance to a funnel-like shape, which may be an indication of unequal
variances. So, we cautiously conclude that our model is a good fit.



Module 7. Tools for benchmarking quality 149

Figure 7.11: Residual plots of the 𝑂𝑅𝑡𝑖𝑚𝑒 regression model

(a) Do points fit the line? (b) Are points random?

7.8.3 Repeatability and Reproducibility (R&R) Analysis

One common application of the ANOVA test during quality improvement projects involves
gauge analysis. Gauge analysis, also commonly referred to as Gauge R&R or Gage
R&R study, is an essential activity of quality improvement that we typically undertake in
the Measure and Analyze phases of DMAIC.

R&R

The main goal with 𝑅&𝑅 is to ensure that we do not introduce extra variability in quality
measures due to inconsistent data collection methods. Our task here is to calibrate our
gauge so that our measurements are repeatable and reproducible [43].

Definition 7.3 (Repeatability & Reproducibility)

1. Repeatability implies that measurements of the same unit taken under the
same conditions (e.g., same operator) are consistent.

2. Reproducibility implies that measurements of the same unit taken under
different conditions (e.g., different operators) are consistent.

The ANOVA model that applies to the gauge analysis includes the total sum of squares
structured as follows [43]:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑝𝑎𝑟𝑡𝑠 + 𝑆𝑆𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 + 𝑆𝑆𝑝𝑎𝑟𝑡𝑠 × 𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (7.75)

where parts are the units being measured and operators are individuals taking measure-
ments. The subscript of 𝑝𝑎𝑟𝑡𝑠 × 𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 indicates the interaction between 𝑝𝑎𝑟𝑡𝑠 and
𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠. The component of 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 that is due to the variation in parts is 𝑆𝑆𝑝𝑎𝑟𝑡𝑠, and
the component indicating variation in the gauge is given by [43]:

𝑆𝑆𝑔𝑎𝑢𝑔𝑒 = 𝑆𝑆𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 + 𝑆𝑆𝑝𝑎𝑟𝑡𝑠 × 𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (7.76)
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The sum of 𝑆𝑆𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 + 𝑆𝑆𝑝𝑎𝑟𝑡𝑠 × 𝑜𝑝𝑒𝑟𝑎𝑡𝑜𝑟𝑠 in Equation 7.76 captures variability due to the
lack of reproducibility of the measurements. The 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 term represents variability due
to the lack of repeatability of the measurements. It follows that the variability in the
gauge can be expressed this way:

𝑆𝑆𝑔𝑎𝑢𝑔𝑒 = 𝑆𝑆𝑟𝑒𝑝𝑟𝑜𝑑𝑢𝑐𝑖𝑏𝑖𝑙𝑖𝑡𝑦 + 𝑆𝑆𝑟𝑒𝑝𝑒𝑎𝑡𝑎𝑏𝑖𝑙𝑖𝑡𝑦 (7.77)

In variance units, the variability of the gauge looks as follows:

𝜎2
𝑔𝑎𝑢𝑔𝑒 = 𝜎2

𝑟𝑒𝑝𝑟𝑜𝑑𝑢𝑐𝑖𝑏𝑖𝑙𝑖𝑡𝑦 + 𝜎2
𝑟𝑒𝑝𝑒𝑎𝑡𝑎𝑏𝑖𝑙𝑖𝑡𝑦 (7.78)

The variance model of the total variance follows:

𝜎2
𝑡𝑜𝑡𝑎𝑙 = 𝜎2

𝑔𝑎𝑢𝑔𝑒 + 𝜎2
𝑝𝑎𝑟𝑡𝑠 (7.79)

During an R&R study, we attempt to calibrate our gauge to minimize 𝜎2
𝑔𝑎𝑢𝑔𝑒, which in turn

reduces the 1overall variability 𝜎2
𝑡𝑜𝑡𝑎𝑙 .

The 𝐶𝑝 ratio

We have previously discussed the 𝐶𝑝 ratio in Module 4. Besides measuring the pro-
cess capability, this ratio can also be utilized to evaluate the acceptability of the 𝑔𝑎𝑢𝑔𝑒
instrument. When inverted, the 𝐶𝑝 ratio looks this way:

𝑃 /𝑇 =
6𝜎𝑔𝑎𝑢𝑔𝑒

𝑈𝑆𝐿−𝐿𝑆𝐿
(7.80)

where 𝑃 /𝑇 stands for the precision-to-tolerance ratio and 𝜎𝑔𝑎𝑢𝑔𝑒 is obtained by taking
the square root of 𝜎2

𝑔𝑎𝑢𝑔𝑒 in Equation 7.78. In typical applications, 𝑃 /𝑇 ≤ 0.1 implies a
well-calibrated gauge instrument [43].

How-To 7.12 (Gage R&R Study in Minitab 18)
Minitab has the following three options for conducting the Gage R&R analysis:

1. Crossed: this option is used when every operator can measure every part.
In Minitab 18, go to: Stat > Quality Tools > Gage Study > Gage R&R Study
(Crossed).

2. Nested: this option is used when each operator is not able to measure all
parts. In Minitab 18, go to: Stat > Quality Tools > Gage Study > Gage R&R
Study (Nested).

3. Expanded: this option is used to assess the influence of more factors, be-
yond parts and operators. In Minitab 18, go to: Stat > Quality Tools > Gage
Study > Gage R&R Study (Expanded).



Module 7. Tools for benchmarking quality 151

Example 7.4 (R&R Study at Metropolis Hospital)
A quality manager at Metropolis Hospital would like to conduct a Gage R&R study
to assess the consistency in the measurements of the clinical test X. For this study,
twelve random patients and three random nurses volunteered to participate. Each
nurse took the measurements three times on each patient. The results are pre-
sented in Table 7.7.

Table 7.7: Measurements of the clinical text X at Metropolis Hospital

Patient Nurse1 Nurse2 Nurse3

# Test1 Test2 Test3 Test1 Test2 Test3 Test1 Test2 Test3

1 63 70 62 65 69 80 83 70 94
2 91 65 53 89 81 62 85 78 72
3 52 100 88 90 76 63 93 94 72
4 79 54 65 91 86 89 88 78 72
5 98 55 90 68 70 81 75 99 93
6 96 60 89 61 74 76 95 81 76
7 60 98 89 74 91 96 95 90 76
8 57 60 71 96 77 88 72 76 72
9 94 50 93 74 75 73 100 83 76
10 64 77 50 72 69 66 94 94 100
11 63 61 56 60 95 68 98 74 100
12 51 65 91 64 92 65 96 73 76

The manager rearranged the data, as illustrated in Table 7.8, and used Minitab 18
to conduct a crossed R&R analysis.

Table 7.8: Rearranged data for a crossed R&R analysis in Minitab 18

Patient Nurse Data

1 Nurse1 63
2 Nurse1 91
3 Nurse1 52
4 Nurse1 79
5 Nurse1 98
6 Nurse1 96
7 Nurse1 60
8 Nurse1 57
9 Nurse1 94
10 Nurse1 64
11 Nurse1 63
12 Nurse1 51
1 Nurse1 70
2 Nurse1 65

. . . . . . . . .
10 Nurse3 100
11 Nurse3 100
12 Nurse3 76
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To generate ANOVA results, click on Stat > Quality Tools > Gage Study > Gage
R&R Study (Crossed). In the pop-up box, fill in Part numbers (Patient), Operators
(Nurse), and Measurements (Data), as illustrated in Figure 7.12. Make sure the
ANOVA radio button is selected.

Figure 7.12: Options for a Gage R&R study in Minitab 18

Minitab numerical results are presented in Table 7.9. Graphical results are depicted
in Figure 7.13. The ANOVA results in Table 7.9 indicate that the factor of Nurse is
statistically significant, given the 𝑝-𝑣𝑎𝑙𝑢𝑒 < 0.05. The interaction between patient
and nurse (Patient*Nurse) is not statistically significant. The results of the Variance
Components suggest that repeatability is the primary source of variability and con-
tributed about 83% of the variance in the measurements. In other words, the nurses
are unable to repeat their measurements. We arrive at the same conclusion us-
ing the standard deviation units in the Gage Evaluation results. Furthermore, the
Component of Variation bar chart in Figure 7.13 suggests that almost 100% of
the variation is due to Gage R&R, with repeatability contributing most of the vari-
ability. The Patient*Nurse Interaction chart suggests that for any given patient,
there is noticeable inconsistency in the measurements (especially for patients 10
and 11), meaning that reproducibility is also a non-trivial factor in this study. The R
Chart by Nurse captures the process variability by the nurse. The results suggest
that the measurements of Nurse1 are the most inconsistent. Also, see how the
interquartile range of Nurse1 is the biggest in the Data by Nurse box plots. The
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Xbar Chart by Nurse shows a peculiar upward trend of the average of measure-
ments. We expected all measurements to behave randomly around ¯̄𝑋, but it seems
that the measurements of Nurse1 are mostly below average, whereas the measure-
ments of Nurse3 are, for the most part, above average. So, what can we conclude?
We can conclude that the test instrument should be calibrated, and nurses
retrained on taking and recording measurements of the clinical test X. This
solution should be iterated until the test measurements are all reproducible
and repeatable.

Table 7.9: Minitab Gage R&R ANOVA Results

Two-Way ANOVA Table With Interaction Variance Components
Source DF SS MS F P

Source VarComp
%Contribution

Patient 11 1310.1 119.1 0.6812 0.74 (of VarComp)

Nurse 2 3015.7 1507.8 8.624 0 Total Gage
R&R

214.525 100

Patient * Nurse 22 3846.5 174.84 0.98 0.5 Repeatability 177.573 82.78
Repeatability 72 12845 178.41 Reproducibility 36.952 17.22
Total 107 21018 Nurse 36.952 17.22
𝛼 to remove interaction term = 0.05 Part-To-Part 0 0

Total Variation 214.525 100

Two-Way ANOVA Table Without Interaction Gage Evaluation
Source DF SS MS F P

Source StdDev (SD)
Study Var %Study Var

Patient 11 1310.1 119.1 0.6707 0.76 (6 × SD) (%SV)

Nurse 2 3015.7 1507.8 8.4914 0 Total Gage
R&R

14.6467 87.88 100

Repeatability 94 16692 177.57 Repeatability 13.3257 79.9539 90.98
Total 107 21018 Reproducibility 6.0788 36.4729 41.5

Nurse 6.0788 36.4729 41.5
Part-To-Part 0 0 0
Total Variation 14.6467 87.88 100
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Figure 7.13: Minitab Gage R&R Report

7.9 Chi-square test

A chi-square test is a statistical technique that we use to validate the goodness-of-fit of
the hypothesized probability distribution of a given data set [57]. Within the context of
quality improvement, we can apply the chi-square test to compare the current process
performance to the expected standard.

7.9.1 One variable

To apply the chi-square test to compare the observed quality and the standard, we state
our hypothesis as follows:

𝐻0: there is no difference between the observed quality measures and the standard.

𝐻1: there is a difference between the observed quality measures and the standard.

We obtain the chi-square test statistic 𝜒2
0 as follows:

𝜒2
0 =

∑︁[︃
(𝑓0 − 𝑓𝑒)2

𝑓𝑒

]︃
(7.81)
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Here, 𝑓0 is a vector of the observed quality measures and 𝑓𝑒 is a vector of the expected
quality measures. The test critical value is given by 𝜒2

𝛼,𝑑𝑓 , where 𝛼 is the significance
level, and 𝑑𝑓 indicates the degrees of freedom. We determine the 𝑑𝑓 as follows:

𝑑𝑓 = (numbers of columns - 1)(numbers of rows - 1) (7.82)

If 𝜒2
0 > 𝜒2

𝛼,𝑑𝑓 , we reject the null hypothesis 𝐻0. Alternatively, we can reject 𝐻0, if the
p-value is less than the significance level 𝛼.

7.9.2 Two variables

When our process data consist of two distinct and nominally-scaled variables, we can
apply the chi-square test to assess the significance of the relationship between these
variables. In this case, it is easier to organize our data into a contingency table, with
one variable in the rows and the other in the columns. We state our hypothesis this way:

𝐻0: there is no relationship between two nominally-scaled variables in the contingency
table.

𝐻1: there is a relationship between two nominally-scaled variables in the contingency
table.

Each cell in the contingency table represents the observed value or 𝑓0. We obtain the
cell’s expected value 𝑓𝑒 as follows:

𝑓𝑒 =
(Row total)(Column total)

(Grand total)
(7.83)

The test statistic and degrees of freedom follow from Equations 7.81 and 7.82, respec-
tively. The decision rule remains as before. We reject 𝐻0 when 𝜒2

0 > 𝜒2
𝛼,𝑑𝑓 or when

𝑝-𝑣𝑎𝑙𝑢𝑒 < 𝛼.

How-To 7.13 (Chi-square test in Minitab 18)

1. To run the chi-square test for a single variable, click on Stat > Tables > Chi-
Square Goodness-of-Fit Test > input your data as shown in Figure 7.14 >
OK.
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Figure 7.14: Options for the chi-square test for a single variable in Minitab 18

2. To run the chi-square test for a contingency table, click on Stat > Tables >
Chi-Square Test for Association> In the drop-down menu, select Summarized
data in a two-way table > input your data as shown in Figure 7.15 > OK.

Figure 7.15: Options for the chi-square test for a contingency table in Minitab 18

How-To 7.14 (Chi-square test in Excel 2013)

1. To find the critical value 𝜒2
𝛼,𝑑𝑓 , use this function: = 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (𝛼,𝑑𝑓 )

2. To find the p-value of the chi-square test, use this function: =
𝐶𝐻𝐼𝑆𝑄.𝐷𝐼𝑆𝑇 .𝑅𝑇 (𝜒0,𝑑𝑓 )
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Example 7.5 (Chi-square test on a single variable )
Consider the data in Table 7.10, where the inpatient coding productivity rate is
recorded by Coder and Expected standard.

Table 7.10: Inpatient coding productivity rates

Coder Observed Expected

A 2.0 2.4
B 2.5 2.4
C 2.9 2.4
D 1.7 2.4
E 1.2 2.4
F 4.1 2.4

Your interest is to test whether there is a statistical difference between the observed
and the expected productivity rate. At the significance level of 𝛼 = 0.05 and 𝑑𝑓 = 5,
you found the critical value in Excel using 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (0.05,5) = 11.07. To
find the chi-square test statistic 𝜒2

0, you set up your Excel, as shown in Table 7.11.

Table 7.11: The Excel setup for the chi-square test of the data in Table 7.10

Coder Observed Expected (Observed - Expected)2/Expected

A 2.0 2.4 0.0667

B 2.5 2.4 0.0042

C 2.9 2.4 0.1042

D 1.7 2.4 0.2042

E 1.2 2.4 0.6

F 4.1 2.4 1.2042

𝜒2
0=

∑︀
𝑐𝑜𝑙𝑢𝑚𝑛 = 2.183

Given 𝜒2
0 < 𝜒2

𝛼,𝑑𝑓 you failed to reject the null hypothesis that there is no difference
between the observed and the expected coding productivity rates. Correspondingly,
the p-value is greater than 𝛼, as follows: = 𝐶𝐻𝐼𝑆𝑄.𝐷𝐼𝑆𝑇 .𝑅𝑇 (2.183,5) = 0.823 >
0.05. Minitab 18 produces similar results as shown in Figure 7.16.
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Figure 7.16: The chi-square test in Minitab 18 based on the data in Table 7.10

Example 7.6 (Chi-square test for a contingency table)
You audited 100 medical records and recorded documentation issues by the record
type, as shown in Table 7.12. You classified each record as an inpatient, outpa-
tient, or ancillary. You denoted issues by letters A (mixed messages), B (misuse
of copy and paste), C (incomplete information), and D (misplaced documentation)
[15]. Your interest is to test whether there is a relationship between the record type
and documentation issues. To do that, you perform a chi-square test.

Table 7.12: Documentation issues by the record type

A B C D

Inpatient 17 21 46 12

Outpatient 8 1 24 3

Ancillary 34 15 47 20

The chi-square test results from Minitab are displayed in Table 7.13.

Table 7.13: The chi-square test results from Minitab 18 based on data in Table 7.12

Chi-Square DF P-Value

Pearson 15.827 6 0.015
Likelihood Ratio 17.138 6 0.009

Given the p-values in this case, you reject the null hypothesis. In other
words, a relationship likely exists between the record type and documentation
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issues. To reproduce the Pearson p-value in Excel, proceed as follows: =
𝐶𝐻𝐼𝑆𝑄.𝐷𝐼𝑆𝑇 .𝑅𝑇 (15.827,6) = 0.015.

7.10 League tables, funnel charts, and ANOM

League tables, funnel charts, and the analysis of means (ANOM) are among many tools
that we can utilize to benchmark quality from different health care organizations.

7.10.1 A league table

A league table is one of the classical methods for benchmarking quality in health care.
With this technique, organizations are ranked and ordered from the highest to the lowest
performer [56]. The main criticism levied against this method is the failure to account for
the sample size and the confidence interval [56, 61]. Various other methods for ranking
health care organizations exist, such as quality report cards published by the federal [41]
and state governments [48]. Private organizations such as the Leapfrog Group [26] also
do publish various rankings of health care organizations.

Example 7.7 (Public report cards)
To view an example of public report cards concerning readmission rates of pneu-
monia patients in New York State (NYS), visit https://profiles.health.ny.
gov/hospital. Next, select Hospitals > Compare Hospitals. Under Select Do-
main Type, choose Readmission Within 30 Days. Under Select Measure, choose
Pneumonia Patients Readmission Within 30 Days. A chart that looks like Figure
7.17 will appear.

Figure 7.17: Readmission rates of pneumonia patients, within 30 days, NYS hos-
pitals. The x-axis represents hospitals, and the y-axis characterizes the percent
of readmission. Source: https://profiles.health.ny.gov/measures/view/
10083, Report Period: July 1, 2014, to June 30, 2017

To see how the rates and the ranking scores were calculated, click on the legend
link, which may take you on this web page: https://profiles.health.ny.gov/
hospital/pages/methodology. To download the data, click on the cloud symbol
with a downward arrow (see the snapshot in Figure 7.18).

https://profiles.health.ny.gov/hospital
https://profiles.health.ny.gov/hospital
https://profiles.health.ny.gov/measures/view/10083
https://profiles.health.ny.gov/measures/view/10083
https://profiles.health.ny.gov/hospital/pages/methodology
https://profiles.health.ny.gov/hospital/pages/methodology
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Figure 7.18: An option to download the NYS hospital compare data

7.10.2 Funnel charts

Like control charts, funnel charts are constructed using control limits and a center line. A
typical funnel chart tends to look like a 𝑝 chart and is structured as follows [55]:

𝑈𝐶𝐿 = 𝑝+𝐿

√︃
𝑝(1− 𝑝)

𝑛𝑖
(7.84)

𝐶𝐿 = 𝑝 (7.85)

𝐿𝐶𝐿 = 𝑝 −𝐿

√︃
𝑝(1− 𝑝)

𝑛𝑖
(7.86)

Here, 𝑝 is the target, 𝐿 is the number of standard deviations away from the centerline,
commonly chosen to create a 95% or 99.8% confidence interval [61]. The notation of 𝑛𝑖
signifies the sample size of organization 𝑖, for 𝑖 : 1,2, . . . , 𝑘, where 𝑘 is the total number of
organizations being compared. The acronyms UCL, CL, and LCL, stand for upper control
limit, centerline, and lower control limit respectively. If a point falls outside of a particular
limit, we conclude that the deviation of the corresponding sample number, away from the
target or the grand mean, is statistically significant. The only difference between a funnel
chart and a 𝑝 chart is that in the former, we have to sort samples in ascending order, a
practice that we do not adhere to in the latter. We will discuss more about a 𝑝 chart in
Module 9.

7.10.3 ANOM

ANOM, not to be confused with ANOVA, is a statistical technique that we can employ to
benchmark quality from several health care organizations. The main difference between
ANOVA and ANOM is that the former compares the equality of means, whereas the latter
compares each mean to the overall mean. Just like in funnel charts, the formulas for
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ANOM charts often look like those of a p-chart [55]. In Minitab 18, the formulas for the
binomial ANOM chart look like this [1]:

𝑈𝐷𝐿 = 𝑝+𝐿

√︂
𝑝(1− 𝑝)

𝑛
*
√︂

𝑘 − 1
𝑘

(7.87)

𝐿𝐷𝐿 = 𝑝 −𝐿
√︂

𝑝(1− 𝑝)
𝑛

*
√︂

𝑘 − 1
𝑘

(7.88)

Here, 𝑈𝐷𝐿 stands for upper decision limit and 𝐿𝐷𝐿 means lower decision limit. The
notation of 𝑛 symbolizes a constant sample size, and 𝑘 represents the number of orga-
nizations in the study. As before, 𝐿 represents the number of standard deviations away
from the centerline 𝑝. Minitab 18 determines 𝐿 as follows:

𝐿 = Φ−1(1−𝛼/(2 * 𝑘)) (7.89)

where * symbol characterizes multiplication and Φ(.) is the cumulative density function
of a standard normal. As before, 𝛼 is the given significance level. As in funnel charts,
if a point falls outside of a particular limit, we conclude that the corresponding sample is
statistically different from the target or the grand mean.

How-To 7.15 (Funnel charts in Excel 2013)
Excel does not have a built-in option for creating ANOM and funnel charts, but we
can manually program the respective formulas as we demonstrate in Example 7.8.

Example 7.8 (A funnel chart in Excel 2013)
The league table given in Table 7.14 depicts the ranking of 20 hospitals in Central
City, regarding the rates of pneumonia patients readmitted within 30 days of dis-
charge. The lower the rate, the better. The average readmission rate is 13.7%.
Hospitals that are above this average are marked in red. Table 7.15 demonstrates
the setup of an Excel spreadsheet for creating a funnel chart based on the data
in Table 7.14. In this setup, 𝐼𝐷 denotes the hospital ID column, 𝑛𝑖 symbolizes
the column of Pneumonia Discharges or sample size, 𝑥𝑖 represents the column of
Readmit with 30 days, and 𝑥𝑖/𝑛𝑖 represents to the 𝑅𝑎𝑡𝑒 column. We calculated the
average rate using 𝑝 =

∑︀𝑘
𝑖=1𝑥𝑖/𝑛𝑖 , where 𝑘 is the total number of hospitals. Before

plotting the funnel chart, we sorted Table 7.15 by the sample size 𝑛𝑖 . We applied
Equations 7.84 - 7.86 to create inner control limits (𝐿𝐶𝐿1 and 𝑈𝐶𝐿1 using 𝐿 = 2)
and outer control limits (𝐿𝐶𝐿2 and 𝑈𝐶𝐿2 using 𝐿 = 3). For example, we obtained
the value of 𝐿𝐶𝐿1 in cell 𝐸2 using = 𝐼2− 2 * 𝑆𝑄𝑅𝑇 (𝐼2 * (1− 𝐼2)/𝐵2) and the value
of 𝑈𝐶𝐿2 in cell 𝐻2 using = 𝐼2 + 3 * 𝑆𝑄𝑅𝑇 (𝐼2 * (1 − 𝐼2)/𝐵2). From Table 7.15, we
created a funnel chart by inserting line charts of columns D to I, as illustrated in
Figure 7.19. From this chart, we see that hospitals with IDs 3, 8, and 9 fail 𝑈𝐶𝐿2.
Also, we see that hospitals with IDs 7, 13, 17, and 18 fail 𝐿𝐶𝐿1.
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Figure 7.19: A funnel chart based on the data in Table 7.14
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Table 7.14: Pneumonia patients readmitted within 30 days of discharge in Central
City, 2018

Hospital ID Pneumonia Discharges Readmit with 30 days Rate Rank

13 80 2 2.5% 1

17 68 2 2.9% 2

18 98 4 4.1% 3

7 71 3 4.2% 4

19 90 6 6.7% 5

5 26 2 7.7% 6

16 76 7 9.2% 7

14 96 9 9.4% 8

4 43 5 11.6% 9

11 73 9 12.3% 10

15 128 19 14.8% 11

12 46 7 15.2% 12

6 96 15 15.6% 13

20 84 14 16.7% 14

10 118 20 16.9% 15

2 78 16 20.5% 16

1 32 8 25.0% 18

3 59 17 28.8% 17

8 88 28 31.8% 19

9 28 10 35.7% 20
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Table 7.15: A setup of an Excel spreadsheet for creating a funnel chart based on
the data in Table 7.14

A B C D E F G H I

1 𝐼𝐷 𝑛𝑖 𝑥𝑖 𝑥𝑖/𝑛𝑖 𝐿𝐶𝐿1 𝑈𝐶𝐿1 𝐿𝐶𝐿2 𝑈𝐶𝐿2 𝑝

2 5 26 2 7.7% 0.2% 27.2% -6.5% 34.0% 13.7%

3 9 28 10 35.7% 0.7% 26.7% -5.8% 33.2% 13.7%

4 1 32 8 25.0% 1.6% 25.9% -4.5% 32.0% 13.7%

5 4 43 5 11.6% 3.2% 24.2% -2.0% 29.5% 13.7%

6 12 46 7 15.2% 3.6% 23.9% -1.5% 29.0% 13.7%

7 3 59 17 28.8% 4.8% 22.7% 0.3% 27.2% 13.7%

8 17 68 2 2.9% 5.4% 22.1% 1.2% 26.3% 13.7%

9 7 71 3 4.2% 5.6% 21.9% 1.5% 26.0% 13.7%

10 11 73 9 12.3% 5.7% 21.8% 1.6% 25.8% 13.7%

11 16 76 7 9.2% 5.8% 21.6% 1.9% 25.6% 13.7%

12 2 78 16 20.5% 5.9% 21.5% 2.0% 25.4% 13.7%

13 13 80 2 2.5% 6.0% 21.4% 2.2% 25.3% 13.7%

14 20 84 14 16.7% 6.2% 21.2% 2.5% 25.0% 13.7%

15 8 88 28 31.8% 6.4% 21.1% 2.7% 24.7% 13.7%

16 19 90 6 6.7% 6.5% 21.0% 2.8% 24.6% 13.7%

17 14 96 9 9.4% 6.7% 20.8% 3.2% 24.3% 13.7%

18 6 96 15 15.6% 6.7% 20.8% 3.2% 24.3% 13.7%

19 18 98 4 4.1% 6.8% 20.7% 3.3% 24.2% 13.7%

20 10 118 20 16.9% 7.4% 20.1% 4.2% 23.2% 13.7%

21 15 128 19 14.8% 7.6% 19.8% 4.6% 22.9% 13.7%

In contrast to the hospital ranking in Table 7.14 where ten hospitals may be con-
sidered deficient since they are above the average, the funnel chart indicates that
only a few hospitals fail the control limits at 99.73% confidence interval. In typical
applications, the negative part of the funnel limits is set to zero; we plotted it here
only to demonstrate the funnel shape from which the name funnel chart is derived.

How-To 7.16 (ANOM chart in Minitab 18)
Click on 𝑆𝑡𝑎𝑡 > 𝐴𝑁𝑂𝑉𝐴 > Analysis of Means. Select your data for the Response
field. For binomial data, make sure you select Binomial. Minitab assumes a con-
stant sample size. Input the appropriate sample size in the designated area. See
an illustration in Figure 7.20.
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Figure 7.20: ANOM Options in Minitab 18

Figure 7.21: ANOM chart based on the readmission data in Table 7.14
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Example 7.9 (ANOM in Minitab 18)
For demonstration purposes, we used Minitab 18 to approximate an ANOM chart
related to the data in Table 7.14. Since Minitab assumes a constant sample size
for all subgroups, we chose the size of 100 and transformed all rates to relate to
this constant. For example, we changed the rate of 7.7%, in cell D2 of Table 7.15,
to 𝑅𝑂𝑈𝑁𝐷(7.7% * 100,0) = 8. In Minitab, we input 100 as the binomial constant
sample size. Figure 7.21 illustrates the resulting ANOM chart at 𝛼 = 0.0027. From
Figure 7.21, we observe that three points fall outside of the control limits. In both
the funnel and ANOM charts, the out-of-control points correspond to hospitals with
ID 9 (𝑛𝑖 = 28), ID 3 (𝑛𝑖 = 59), and ID 8 (𝑛𝑖 = 88). Assuming comparable processes,
we conclude that readmission rates in these hospitals are statistically different from
the overall mean rate of 14.7%, at the 99.73% confidence level.
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7.11 Check Your Understanding

1. A false alarm in the process is equivalent to:

(a) type I error

(b) type II error

2. When comparing the means in paired observations, we typically apply which test?

(a) t-test

(b) Z-test

(c) F-test

(d) Chi-square-test

3. The ratio between the two sample variances is likely to follow which distribution?

(a) normal distribution

(b) t-distribution

(c) F-distribution

(d) Chi-square distribution

4. Our null hypothesis says that 𝐻0 : 𝜎
2
1 = 𝜎2

2 . What statistic test are we likely to run?

(a) F-test

(b) t-Test

(c) Z-test

(d) Chi-square-test

5. When performing an ANOVA test, as the degrees of freedom in the error decrease,
we are likely to conclude that:

(a) There is no difference in the population means

(b) There is a difference in the population means

6. When performing a chi-square test from a contingency table, how do you obtain the
𝑓𝑒 value of a cell?

7. What statistical test can you apply to investigate the null hypothesis that there is no
difference between the observed and the expected quality performance?

8. Using Excel, verify the Chi-Square test results in Example 7.6. What was your
critical value?

9. Which of the following tools can you apply to rank health care organizations from
best to worst:
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(a) League tables

(b) Funnel charts

(c) ANOM charts

(d) ANOVA test

10. What can you conclude when a point falls outside of a UDL of an ANOM chart?

11. How does Minitab handle sample sizes for binomial data when creating ANOM
charts?

12. In what way does a funnel chart differ from a p-control chart?

13. At the confidence interval of 99.73%, what is the LDL of an ANOM chart with p =
0.10, the constant sample size is 100, and there are 10 health care organizations
in the study?

(a) 0.0123

(b) 0.0146

(c) 0.0253

(d) 0.0398

14. During an R&R study, we typically employ the following statistical test:

(a) ANOVA

(b) ANOM

(c) Chi-square

(d) Z

15. The variance of the gauge is estimated from which components of the total variation
(circle all that apply):

(a) Operators

(b) Operators*parts

(c) Error

(d) Parts

16. When an operator can measure every part, we select the following R&R option in
Minitab:

(a) Nested

(b) Crossed

(c) Expanded

(d) Comprehensive
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17. Your two-way ANOVA test results from Minitab indicates an 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 of the re-

gression model to be 13%. What does this percent signify about the statistical
significance of the factors in the model?

18. In a two-way ANOVA test, if the degrees of freedom of the blocking variable were
𝑏 − 1 and the degrees of freedom of the treatments were 𝑎− 1, what would be the
degrees of freedom of 𝑆𝑆𝑒𝑟𝑟𝑜𝑟?

19. You audited 100 records from your EHR system and found several quality issues
that you categorized, as shown in Table 7.16.

Table 7.16: The number of electronic records with data quality issues by category

Category #issues

Completeness 30

Currency 13

Accuracy 41

Concordance 18

(a) Based on Table 7.16, state your chi-square decision rule at 𝛼 = 0.05.

(b) From Table 7.16, if each category is expected to occur with probability 1/4,
what can you conclude about 𝐻0 : 𝑝 = 1/4 and 𝐻1 : 𝑝 , 1/4? Show your work.

20. You collected and categorized defects from a health informatics process, as shown
in Table 7.17.

Table 7.17: Health informatics defects

Department\Defect A B C D E

1 14 15 22 21 24

2 18 18 39 47 16

3 21 31 30 36 10

4 40 12 33 29 39

5 14 24 12 36 42

What can you conclude about the relationship between the department and the
type of defects? First, state the null hypothesis, and then apply the appropriate
decision rule to conclude about your hypothesis. You can use Excel or Minitab.

21. The quality manager at Metropolis Hospital has determined that nurse2 should not
have taken part in the R&R study presented in Example 7.4. Remove nurse2 from
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the study and rerun the R&R study in Minitab. Submit your Minitab file with the
interpretation of your statistical and graphical results.

22. After further analysis, it was determined that hospitals with the IDs of 3, 8, and 9
were not in the same statistical state as the rest of the hospitals. Remove these
hospitals from Table 7.14 and:

(a) create a new funnel chart in Excel.

(b) approximate your results using the ANOM technique in Minitab.

(c) estimate the 𝐶𝑝𝑢 ratio of the entire process given 𝑈𝑆𝐿 = 30%. What can you
conclude?

Submit both your Excel and Minitab files with the interpretation of your results.

23. The results from an R&R study showed a p-value for the gauge to be 0.02 at the
significance level of 0.05. All other p-values were above 0.05. This fact means that
the major source of variability in the measurements is coming from:

(a) Parts

(b) Operators

24. The following statistical test is used when conducting ANOVA:

(a) 𝐹

(b) 𝑡

(c) 𝑍

(d) 𝜒2

25. During an ANOVA test, you failed to reject 𝐻0 when it was false. You likely commit-
ted which type of error:

(a) Type I error

(b) Type II error



MODULE 8

Tools for improving the process

In this module, we review techniques for improving the process. The
major statistical methods that we consider relate to the design of exper-
iments (DOE). We also discuss Lean techniques to improve efficiency,
and Poka-yoke measures to mitigate adverse events. Other discussion
topics include the Swiss-cheese model and best practices for improving
data quality.

Key concepts and tools: Quality; Variability; Quality improvement; Process im-
provement; Data quality; Factorial design; DOE; Efficiency; Cycle time; Setup prob-
lems; Lean methods; ; Poka-yoke measures; 5S+1; Analysis of Variance (ANOVA);
Control charts

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for improving the process

2. Justify the need for designing experiments

3. Design experiments

4. Interpret ANOVA results from a DOE model

5. Discuss typical setup problems in service

6. Implement Lean solutions for efficiency

7. Survey data quality improvement techniques

8. Discuss the concept of the Swiss-cheese model

9. Advocate for poka-yoke measures

10. Manage quality improvement efforts

170
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8.1 Introduction

The Improve phase of DMAIC is probably the most challenging since we have to turn our
analysis into actions to achieve the project goals that we introduced in the Define phase.
To find feasible solutions, we may once again have to hold brainstorming sessions to
generate ideas for improvement. For common efficiency problems, we could implement
general Lean solutions to reduce the process cycle time. For solutions that require evalu-
ating different combinations of the process inputs, we employ the design of experiments
(DOE). Other process improvement concepts to consider include poka-yoke measures
and the Swiss cheese model to mitigate adverse events. In health care informatics, we
also must contemplate best practices and standards to improve data quality. In the end,
we must reduce variability in the process and verify our success using control charts.

8.2 DOE

8.2.1 Background

DOE is a statistical technique that we employ during the Improve phase of DMAIC to
attempt to reduce variability in the process. Two fundamental activities of DOE include the
experimentation of different process inputs and the comparison of outputs using methods
such as ANOVA. The goal is to select a statistically significant experiment that improves
quality. The concept of DOE was first introduced by a statistician named Ronald Fisher
in the 1920s, and this technique is widely applied in various other fields of study besides
quality improvement.

8.2.2 The procedure for DOE

The procedure for designing experiments follows [43]:

1. State the goal of running experiments: this step is probably the most critical
in DOE since unnecessary or incorrect investigations could imperil or slow down
quality improvement efforts. So, our goal for DOE should be unambiguous and
justifiable.

2. Determine the key inputs variables (also known as Factors) and the primary
output variable (also called Response): in this step, we investigate the settings
of all input variables that could potentially affect the output variable.

3. Design experiments: this phase, also referred to as the factorial design, in-
volves determining the order of experiments, the number of replicates, the number
of blocks, and the randomization techniques.

4. Run experiments: here, we run experiments and record the results according to
our factorial design.
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5. Analyze the results: in this step, we compare outputs using the ANOVA1 tech-
niques that we discussed in Module 7. Additionally, we use regression methods to
evaluate the amount of variation in the response that is explained by the inputs.

6. Decide on the course of action: lastly, we choose statistically significant settings
of the inputs (if any) to improve the process.

8.2.3 Factorial design

There are several approaches to designing experiments. The most common and probably
the simplest is the 2𝑘 design, where we only consider two settings of 𝑘 factors. That is,
for each factor, we investigate two possible levels that we designate as low (- or -1) or
high (+ or 1). For example, if 𝑘 = 2, we run 22 = 4 experiments (or trials) to account for
all possible combinations of the settings. Likewise, if 𝑘 = 3, we run 23 = 8 trials, and for
𝑘 = 4 we run 24 = 16 trials, and so on. It is apparent that as we increase the number
of factors, the number of trials increases exponentially, a practical dilemma that we later
discuss how to mitigate using a fractional factorial design.

Next, we provide details of 22 and 23 factorial designs.

A 22 factorial design

Let’s assume that our process has two main factors, A and B, and that each factor has
two levels, − and +. Table 8.1 presents the experiments to run for this design.

Table 8.1: Experiments in a 22 factorial design

Run# Output A B

1 (1) - -
2 𝑎 + -
3 𝑏 - +
4 𝑎𝑏 + +

The Run# column of Table 8.1 indicates the order of experiments. The Output column
symbolizes experimental results by the run. We use letter 𝑎 to denote the output when 𝐴
is set to + and 𝐵 is to −. We use letter 𝑏 to denote the output when 𝐵 is set to + and 𝐴 is
to −. Here, 𝑎𝑏 represents the output when both 𝐴 and 𝐵 are set to high (+), whereas (1)
symbolizes the output when both factors are set to low (−). We construct a regression
model from this factorial design as follows [43]:

𝑌 = 𝛽0 + 𝛽1𝐴+ 𝛽2𝐵+ 𝛽12𝐴𝐵+ 𝜖 (8.1)

where 𝐴, 𝐵, and 𝐴𝐵 are independent variables or regressors, 𝑌 is the dependent vari-
able, and 𝜖 is the regression error. We obtain the intercept coefficient 𝛽0 by taking the

1ANOVA: Analysis of Variance
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average of all runs. We determine other coefficient as follows:

𝛽1 =
𝐸1

2
; 𝛽2 =

𝐸2

2
; 𝛽12 =

𝐸12

2
(8.2)

where 𝐸1, 𝐸2, and 𝐸12 are the regression effects that we compute this way:

𝐸1 =
𝑎+ 𝑎𝑏 − 𝑏 − (1)

2𝑛
(8.3)

𝐸2 =
𝑏+ 𝑎𝑏 − 𝑎− (1)

2𝑛
(8.4)

𝐸12 =
𝑎𝑏+ (1)− 𝑎− 𝑏

2𝑛
(8.5)

We use 𝑛 to represent the number of replicates or simply the number of times we repeat
the experiments. The numerators in Equations 8.3-8.5 are referred to as contrasts.
Consequently, we can write any given effect 𝐸 in terms of its contrast, as follows [43]:

𝐸 =
𝑐𝑜𝑛𝑡𝑟𝑎𝑠𝑡

𝑛2𝑘−1
(8.6)

Furthermore, we can formulate the sum of squares (𝑆𝑆) of each factor this way:

𝑆𝑆 =
(𝑐𝑜𝑛𝑡𝑟𝑎𝑠𝑡)2

𝑛2𝑘
(8.7)

Following from the ANOVA discussion in Module 7, we can decompose the total sum of
squares of our factorial design this way:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝐴 + 𝑆𝑆𝐵 + 𝑆𝑆𝐴𝐵 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (8.8)

=
𝑛𝑎∑︁
𝑖=1

𝑛𝑏∑︁
𝑗=1

𝑛∑︁
𝑘=1

(𝑦𝑖𝑗𝑘 − 𝑦...)2 (8.9)

Here, 𝑛𝑎 is the number of settings of factor 𝐴, 𝑛𝑏 is the number of settings of factor 𝐵, 𝑦𝑖𝑗𝑘
is a particular value of a run in cell 𝑖𝑗 of replicate 𝑘, and 𝑦... is the average of all runs. In a
22 design, 𝑛𝑎 = 𝑛𝑏 = 2. The degrees of freedom (𝑑𝑓 ) of 𝐴, 𝐵, 𝐴𝐵, and the 𝑒𝑟𝑟𝑜𝑟 term are
respectively given by (𝑛𝑎−1), (𝑛𝑏 −1), (𝑛𝑎−1)(𝑛𝑏 −1), and 𝑛𝑎𝑛𝑏(𝑛−1). The total number
of degrees of freedom equals 𝑛𝑎𝑛𝑏𝑛− 1 [43]. As before, we determine the mean square
(𝑀𝑆) like this:

𝑀𝑆 =
𝑆𝑆
𝑑𝑓

(8.10)

We obtain the test statistic (𝐹0) of any regressor as follows:

𝐹0 =
𝑀𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑜𝑟
𝑀𝑆𝑒𝑟𝑟𝑜𝑟

(8.11)

As before, if 𝐹0 is greater than the critical value of the 𝐹-distribution (at some given con-
fidence level 𝛼), or when 𝑝-𝑣𝑎𝑙𝑢𝑒 ≤ 𝛼, we conclude that the related effect is statistically
significant.
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A 23 factorial design

In a 23 factorial design, we have three variables A, B, and C that we set according to
Table 8.2.

Table 8.2: Experiments in a 23 factorial design

Run# Output A B C

1 (1) - - -
2 𝑎 + - -
3 𝑏 - + -
4 𝑎𝑏 + + -
5 𝑐 - - +
6 𝑎𝑐 + - +
7 𝑏𝑐 - + +
8 𝑎𝑏𝑐 + + +

We estimate the effects of this design as follows [43]:

𝐸1 =
𝑎+ 𝑎𝑏+ 𝑎𝑐+ 𝑎𝑏𝑐 − 𝑏 − 𝑐 − 𝑏𝑐 − (1)

4𝑛
(8.12)

𝐸2 =
𝑏+ 𝑎𝑏+ 𝑏𝑐+ 𝑎𝑏𝑐 − 𝑎− 𝑐 − 𝑎𝑐 − (1)

4𝑛
(8.13)

𝐸3 =
𝑐+ 𝑎𝑐+ 𝑏𝑐+ 𝑎𝑏𝑐 − 𝑎− 𝑏 − 𝑎𝑏 − (1)

4𝑛
(8.14)

𝐸12 =
𝑎𝑏+ (1) + 𝑎𝑏𝑐+ 𝑐 − 𝑏 − 𝑎− 𝑏𝑐 − 𝑎𝑐

4𝑛
(8.15)

𝐸13 =
𝑎𝑐+ (1) + 𝑎𝑏𝑐+ 𝑏 − 𝑎− 𝑐 − 𝑎𝑏 − 𝑏𝑐

4𝑛
(8.16)

𝐸23 =
𝑏𝑐+ (1) + 𝑎𝑏𝑐+ 𝑎− 𝑏 − 𝑐 − 𝑎𝑐

4𝑛
(8.17)

𝐸123 =
𝑎𝑏𝑐 − 𝑏𝑐 − 𝑎𝑐+ 𝑐 − 𝑎𝑏+ 𝑏+ 𝑎− (1)

4𝑛
(8.18)

The corresponding regression equation looks this way:

𝑌 = 𝛽0 + 𝛽1𝐴+ 𝛽2𝐵+ 𝛽3𝐶 + 𝛽12𝐴𝐵+ 𝛽13𝐴𝐶 + 𝛽23𝐵𝐶 + 𝛽123𝐴𝐵𝐶 + 𝜖 (8.19)

As earlier, we obtain the coefficient 𝛽0 by taking the overall average of all runs. We
determine other coefficients as follows: 𝛽1 = 𝐸1/2, 𝛽2 = 𝐸2/2, 𝛽3 = 𝐸3/2, 𝛽12 = 𝐸12/2,
𝛽13 = 𝐸13/2, 𝛽23 = 𝐸23/2, and 𝛽123 = 𝐸123/2. Like in the 22 design, we can use the
contrasts to estimate the sum of squares and apply the 𝐹 test to assess the statistical
significance of each regressor.

2𝑘 fractional factorial design

As the number of factors increases, the number of runs grows exponentially. A fractional
factorial design can help mitigate this predicament. A general formulation of such design
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is as follows:

2𝑘−𝑝 (8.20)

where 𝑝 is a constant that we choose to allow for the estimation of the main effects and
some two-way interactions. For example, a 2𝑘−1 fractional design implies that, instead of
running all 2𝑘 experiments, we only run half of them.

Example 8.1 (1/2 fractional factorial design)
A process has three factors 𝐴, 𝐵, and 𝐶, and the manager does not have resources
and time to run all 23 = 8 trials. After applying the 1/2 fractional factorial design,
the manager has decided to run 23−1 = 22 = 4 trials where 𝐴𝐵𝐶 is positive. In
other words, the manager will run experiments when the product of the signs in a
row is positive. In reference to Table 8.2, runs 2, 3, 5, and 8 qualify for this design.
Alternatively, the manager could run trials where the product of the signs in a row
is negative. This design corresponds to runs 1, 4, 6, and 7 in Table 8.2.

How-To 8.1 (Factorial design in Minitab 18)
Click on Stat > DOE >Factorial >Create Factorial Design > Number of factors
>Designs >1/2 fraction >OK. See the snapshot in Figure 8.1.

Figure 8.1: A 1/2 fractional factorial design of a 23 model in Minitab 18. To run all
23 = 8 trials, you would have to click on Full factorial in the Designs window.
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8.2.4 Other considerations of factorial designs

Center points

The factorial designs that we have considered so far assume linearity. In a situation
where linearity does not hold, center points can be added to account for non-linearity
effects.

Blocking

We employ the blocking option when we have to run experiments under different condi-
tions, such as when we have to run experiments on different work shifts. For example,
in a 22 factorial design with three replicates, we can run the first set of experiments on
the first shift, the second set of experiments on the second shift, and the third set of
experiments on the third shift. The three shifts here indicate the number of blocks.

No significant factor

When no effect is statistically significant, we construct a probability plot and then look for
points that seem to fall far from the fitted line. Factors corresponding to these points are
likely influential is some way. In such instances, we can hypothesize that these outlier
points are significant. By pulling the sum of squares of the rest of the factors into the
error term, we can apply the F-distribution to test our hypothesis [43].

How-To 8.2 (Center points, replicates, and blocks in Minitab 18)
Minitab has an option to add center points as portrayed in Figure 8.2.

Figure 8.2: Center points in Minitab 18 for a 1/2 fractional design.

See the snapshot in Figure 8.3 for an illustration of the options for replicates and
blocks in Minitab 18.
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Figure 8.3: Options for replicates and blocks in Minitab 18

Example 8.2 (Factorial design in a HIM department, scenario 1)
The director of the health informatics department (HIM) at Metropolis Hospital is a
member of the revenue cycle steering committee. Last week, this committee was
brainstorming about different ways of decreasing the number of unbilled accounts.
The HIM manager suggested working with physicians to reduce the cycle time of
coding queries a. The committee endorsed this idea, and the HIM manager was
put in charge of the plan.

To get started, the HIM manager designed experiments, as portrayed in Ta-
ble 8.3. The objective was to find a query technique that physicians could respond
to the fastest.

Table 8.3: The design of experiments for the medical query process

Source of query Low High

Coders (A) Electronic query (-1) Paper query (1)

CDIb team (B) Clinical floor (-1) Call office (1)

The manager ran experiments per specifications in Table 8.4.

Table 8.4: The order of runs

Run Output A B

1 (1) -1 -1
2 a 1 -1
3 b -1 1
4 ab 1 1

Moreover, the manager replicated the experiments 4 times (𝑅1, . . . ,𝑅4). The results,
which are the averages of the cycle time in hours, are recorded in Table 8.5.
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Table 8.5: Experimental results from the medical query process

Run Output A B R1 R2 R3 R4 Total

1 (1) -1 -1 31 34 30 33 128
2 a 1 -1 32 21 37 29 119
3 b -1 1 43 30 76 80 229
4 ab 1 1 31 100 27 99 257

To help the manager analyze these results in Minitab, follow these steps:

1. Open Minitab and design a 22 experiment with four replicates. To do this,
click on Stat > DOE > Factorial > Create Factorial Design. Keep the default
settings. After clicking on the Designs tab, change the number of replicates
to 4. No center or blocks are considered here.

2. Create a Response column and input the data from Table 8.5 as illustrated in
the snapshot in Figure 8.4. Make sure you match the signs correctly.

Figure 8.4: Recording Table 8.5 experimental results in Minitab 18
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3. To create a cubic plot of your design, click on Stat > DOE > Factorial > Cube
plot, and your graph should look as depicted in Figure 8.5. The boxed num-
bers in the corners of this figure represent averages of runs in each row, or
simply the total column divided by 4. For example, 32 (in the left lower corner)
was obtained by 128/4 = 32.

Figure 8.5: A Minitab cubic plot of Table 8.5 experimental results

From the cubic plot in Figure 8.5, we can conclude that when 𝐵 is set to low
(-1), the average query response time changes very little when A is varied
(32 versus 29.75). The same conclusion appears to be true when B is set to
high (1), and A is varied; 57.25 is not that far from 64.25. In other words, the
setting of A has little effect in this experiment. The only setting that seems to
matter is that of B. Notice that when A is kept constant, varying B yields very
different results. To test the statistical significance of the setting of B, we need
to run ANOVA.

4. To view the ANOVA test and other factorial results, click on Stat > DOE >
Factorial >> Analyze Factorial Design, then select the response column. Click
on the Graphs tab and ensure that the Pareto chart and the Normal plot are
selected. You can view additional factorial plots by clicking on Stat > DOE >
Factorial > Factorial plots > OK. Your factorial plots may look like the charts
displayed in Figure 8.6.
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Figure 8.6: Factorial plots from Minitab 18 based on the experimental results in
Table 8.5

(a) Pareto chart (b) Normal plot

(c) Main Effects plot (d) Interaction plot

From Subfigure 8.6a, we can conclude that factor B is statistically significant
at the significance level of 𝛼 = 0.05. Our conclusion is based on the fact that
the vertical red dotted reference line (2.179) is crossing the B bar [35]. We
can reach the same conclusion by also looking at the Normal plot in Subfig-
ure 8.6b, where Minitab identified factor B as being significant. The ANOVA
results in Table 8.6 confirm that factor 𝐵 is indeed statistically significant since
the p-value is less than 𝛼 = 0.05.

5. To determine the best settings of the new query process, we refer to Subfig-
ure 8.6c. We ignore Subfigure 8.6d since there is no statistically significant
interaction between factors A and B (the lines don’t cross). From Subfigure
8.6c, it is evident that the average cycle time is minimized when B is set to
-1. From Table 8.3, we appreciate that the setting of B =-1 corresponds to
having the CDI team query physicians on clinical floors. So, the conclusion is
that moving forward, the CDI team will handle all medical queries on the
clinical floors. All other forms of queries are not likely to make much
difference.
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Table 8.6: ANOVA test results from Minitab 18 based on the experimental data in
Table 8.5

Source DF Adj SS Adj MS F-Value P-Value

Model 3 3678.2 1226.06 2.12 0.151
Linear 2 3592.6 1796.31 3.11 0.082
A 1 22.6 22.56 0.04 0.847
B 1 3570.1 3570.06 6.17 0.029
2-Way Interactions 1 85.6 85.56 0.15 0.707
A*B 1 85.6 85.56 0.15 0.707
Error 12 6938.2 578.19
Total 15 10616.4

A Minitab regression model related to this case follows.

𝑌 = 45.81+1.19𝐴+14.94𝐵+2.31𝐴 *𝐵 (8.21)

We can manually recreate this model using Equations 8.1 - 8.5 as follows:

𝛽0 = 𝑎𝑣𝑒𝑟𝑎𝑔𝑒(𝑟𝑢𝑛𝑠) = 45.8125 (8.22)

𝐸1 =
119+257− 229− 128

2 * 4
=

19
2 * 4

= 2.375 (8.23)

𝐸2 =
229+257− 119− 128

2 * 4
=

239
2 * 4

= 29.875 (8.24)

𝐸12 =
257+128− 119− 229

2 * 4
=

37
2 * 4

= 4.625 (8.25)

Subsequently, we obtain:

𝑌 = 45.8125+
2.375
2

𝐴+
29.875

2
𝐵+

4.625
2

𝐴𝐵+ 𝜖 (8.26)

= 45.81+1.19𝐴+14.94𝐵+2.31𝐴 *𝐵+ 𝜖 (8.27)

Holding all other factors constant, the interpretation of this regression model is that
increasing B by one unit will decrease Y by 14.94 hours, since when B is set to -1,
we get 14.94* -1 = -14.94. We should mention that, despite that the 𝑅− 𝑠𝑞(𝑎𝑑𝑗) of
this regression model is only 18.31%, this does not negate the fact that factor B is
still statistically significant.

aMedical query: a process of asking a medical provider to clarify clinical documentation in health
records to promote compliant documentation [49]

bCDI: clinical documentation improvement

Remark: When the interaction of factors is statistically significant, it does not matter whether
individual factors in the interaction are statistically significant or not. Only the interaction factor is
considered when setting the new process.
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Example 8.3 (Factorial design in a HIM department, scenario 2)
Following from Example 8.2, let’s assume that the experimental results were instead
as presented in Table 8.7.

Table 8.7: New experimental results of the medical query process

Run Output A B R1 R2 R3 R4 Total

1 (1) -1 -1 31 34 30 33 128
2 a 1 -1 32 21 17 20 90
3 b -1 1 30 12 25 22 89
4 ab 1 1 31 100 27 99 257

Minitab graphical results corresponding to this new scenario are portrayed in Figure
8.7. From these findings, we can conclude that the interaction between factors A
and B is statistically significant. As previously remarked about significant interaction
terms, in this case, we must set both factors A and B simultaneously to minimize
𝑌 . From Subfigure 8.7d, the best setting is A set to low (-1), and B set to high
(1). That is, coders will submit an electronic version of the query, and the CDI
team will call the physician’s office about the same query.

Figure 8.7: Factorial plots based on the new experimental results in Table 8.7

(a) Pareto chart (b) Normal plot

(c) Main effects plot (d) Interaction plot
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8.3 Lean tools

The primary goal of Lean is to make processes more efficient by eliminating wasteful or
non-value added (NVA) activities that increase cycle time.

8.3.1 The cycle time problem

Examples of non-value added activities that increase cycle time include the following
setup problems [24]:

1. Learning curves which occur when we have to perform new tasks or functions that
we rarely do.

2. Interruptions which happen when we multitask or when we stop what we were
doing to track information or wait for approvals. Interruptions not only increase cycle
time but also create opportunities for storage errors, a recipe for nonconforming
services.

3. Batch processing such as when we let work accumulate to a certain level before
we take action. This practice has the potential for increasing cycle time by delaying
the start of the next task in the process.

Other process issues that tend to increase cycle time include [24]:

1. Overprocessing, which occurs when we try to add more value to service or a
product more than the customer requires (e.g., excessive inspection, approvals,
and handoffs).

2. Avoidable transportation and motions, which include instances of people physi-
cally or virtually moving to look for, collect, or deliver materials. Another example is
when people perform needless computer keystrokes and tasks.

3. Overproduction, too much inventory, and excess in work-in-process (WIP),
which, by Little’s law [38], increase cycle time.

8.3.2 Potential solutions

Learning curves

We expect learning curves to decrease in the long run. So, if we created a scatter plot
of the learning curve over time, we should observe negatively sloped or exponentially
decaying values. We can test the significance of this decay statistically [61]. Failure
to detect any significant decrease may be a sign of a poor process or lack of required
skills to perform the tasks under consideration. Possible solutions include redesigning
the process to reduce complexity, increasing training, or assigning difficult tasks to
highly-skilled employees.
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To eliminate interruptions, we should attempt offloading preparatory work by com-
pleting interruptive tasks outside of the main process. We should also try to automate
tasks that computers could do better. Jobs that we cannot offload or automate should be
as lean as possible with no batch processing unless required.

Example 8.4 (Offloading in medical coding and abstracting process)
There is an opportunity for offloading medical abstractinga when this task is com-
bined with the main function of medical coding b. One way to structure such of-
floading is by implementing at least one of the following routines:

1. Automate the abstracting task such as in the electronic health records (EHR)
system

2. Have someone else, besides the coder, do the abstracting job.

3. Have all the information that needs abstracting ready for the coder before
coding (e.g., information printed out or in one location in the EHR)

Offloading the abstracting task is likely to decrease the mental setup and coding
storage errors due to multi-tasking.

aMedical abstracting is a process in health information management (HIM) for reporting the
patient’s administrative information such as the discharge disposition and specific quality measures.

bMedical coding is a process of HIM that involves codifying medical diagnoses and procedures
into alphanumerical codes using national and international standards.

Overprocessing

To solve the issue of overprocessing, we should examine all handoffs, inspections, and
rework to ensure that they are necessary. Suitably, we should empower employees to
perform tasks without needing too many approvals.

Unnecessary transportation

Lean approaches to solving the issues of unnecessary transportation and motions in-
clude rearranging the workspace to match the flow of work. Additionally, we should
redesign computer user interfaces to make them more friendly. We could further stream-
line the workflow by anticipating the needs of the user and running computer subrou-
tines offline to produce needed information on demand [24]. Another effective solution
for avoiding unnecessary movement and motions is 5S+1, which entails cleaning our
workspace. The primary goal of 5S +1 is reducing the time that we spend looking for
materials and information. The principal components of 5S +1 include[24]:

1. Sort: cataloging materials into the categories of the needed to the unneeded.

2. Straighten: arranging materials in familiar places.

3. Shine: keeping the workstation clean.
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4. Standardize: maintaining the first 3S’s

5. Sustain: having a continuous discipline to preserving the workspace procedures.

6. Safety: removing all hazardous materials from the workspace.

Overproduction, too much inventory, and excess WIP

Queueing theory can help regulate the rates of production, inventory, and WIP. One
caveat is that queueing methods tend to be more technical, unlike standard lean solu-
tions, and may require specialized mathematical training to implement them correctly.
But, there are well-known queueing results that we can implement with little efforts, such
as:

1. Pooling: by cross-training employees, so when demand is high, we have enough
resources to address the surge in demand [27].

2. Triaging: by sorting jobs into various levels of urgency and processing times. We
could minimize the overall cycle time by first processing jobs that require the least
amount of time [27].

3. Optimal staffing by allocating enough resources to meet the demand [47, 46, 30].

8.4 Data quality tools

One of the major roles of a health informatician is promoting data quality by creating and
managing an effective information system. At the minimum, the following design should
be enforced to ensure the quality of health care data [61]:

1. A single point of data collection at the point of entry to minimize redundancy
and increase the accuracy and completeness of the data.

2. Standards for merging data from multiple sources for reporting purposes. Ex-
amples include definitions of common classes of outcomes, common metrics, stan-
dard analytical methods, and patient registries.

3. Safeguards to ensure security and confidentiality of patient data such as im-
plementing the provisions of HIPAA2

Some of the necessary steps to improving data quality in any information system
include [28]:

1. Conducting regular audits to detect nonconforming practices of data capture and
use.

2HIPAA: Health Insurance Portability and Accountability Act



186 8.5. Prevention tools

2. Establishing an information governance structure in the organization and get-
ting everyone committed to quality data.

3. Improving data capture controls since when poor data are captured, only poor
data could be made available for decision making (e.g., GIGO3).

4. Keeping up with modern data management principles

5. Involving executives and proving to them the value of data quality

8.5 Prevention tools

There are no better quality improvement techniques than the ones that prevent quality
problems from happening in the first place.

8.5.1 Poka-Yoke measures

Poka-yoke4 measures are mistake-proofing safeguards that we put in place to mitigate
the occurrence of adverse events. In general, it is difficult to come up with such mea-
sures since one cannot anticipate all future sources of quality problems. The collective
ingenuity of process stakeholders, experts, and the public is a must. The website of the
Agency for Healthcare Research and Quality (AHRQ) [3] https://archive.ahrq.gov/
professionals/quality-patient-safety/patient-safety-resources/resources/

mistakeproof/index.html has several examples of error-proofing measures in health
care. One of these examples is a Computerized Physician Order Entry (CPOE) system
to mitigate medication errors [34].

8.5.2 Swiss-cheese model

Many quality problems, especially complex ones, are not amenable to poka-yoke pre-
vention measures. For such issues, we should at least apply the Swiss cheese model
by creating several layers of checkpoints to attempt to catch and fix any anomalies [55].
We must align the Swiss cheese layers correctly so that an anomaly that we missed at
the previous inspection, we find it at the next checkpoint. Of course, despite our best ef-
forts, some quality issues will slip through, which justifies the need for continuous quality
improvement.

8.6 Control charts

Control charts are tools that we typically use to monitor a process. But, these tools
are also critical in improving the process. A typical control chart has a centerline (CL),

3GIGO: garbage-in, garbage-out
4Poka-yoke: a Japanese word that is widely used in Lean circles to indicate mistake-proofing or error-

proofing

https://archive.ahrq.gov/professionals/quality-patient-safety/patient-safety-resources/resources/mistakeproof/index.html
https://archive.ahrq.gov/professionals/quality-patient-safety/patient-safety-resources/resources/mistakeproof/index.html
https://archive.ahrq.gov/professionals/quality-patient-safety/patient-safety-resources/resources/mistakeproof/index.html
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an upper control limit (UCL), and a lower control limit (LCL). We monitor a process to
ensure that it stays within the control limits. An easy way to interpret control charts is
to look for points that fall outside of the limits since these points indicate samples with
possible assignable causes for out-of-control behaviors. As we discuss more in Module 9,
by removing assignable causes, variability decreases, which in turn improves the
process [43]. Indeed, a process with no special cause variation needs no improvement.
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8.7 Check your understanding

1. At which phase of DMAIC should we implement the poka-yoke measures?

2. During your DOE analysis, you found the effect of factor X to be 10. What is the
related coefficient of regression?

(a) 5

(b) 10

(c) 15

(d) 20

3. An ANOVA test from designed experiments shows the following results:

Table 8.8

Source SS DF MS F P

A 15 1 15 1.5 0.5

B 80 2 40 4 0.01

A*B 30 2 15 1.5 0.1

Error 180 18 10 1

Total 305 23

(a) What can you conclude about DOE results in Table 8.8?

(b) Based on this table, how many replicates were there? Hint: think in terms of
the degrees of freedom and the levels of a factor

4. Consider the experimental results in Table 8.9.

Table 8.9

Run Output A B R1 R2 R3 R4 R5

1 (1) - - 100 83 77 74 71
2 a + - 70 44 53 48 58
3 b - + 31 36 28 36 26
4 ab + + 98 73 45 50 58

Using this data,

(a) Run DOE analysis in Minitab

(b) Recreate your regression model in Excel
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(c) What settings are you going to adopt for the new process?

(d) What concerns do the residuals plots reveal?

(e) Attach both your Excel and Minitab files along with the interpretation of the:

i. ANOVA results
ii. Pareto, Normal, Main Effects, and Interaction plots
iii. Regression model

5. From your DOE study with three main factors (A, B, and C), you found A, B, A*B,
and A*B*C to be statistically significant. The new process should be redesigned
based on the settings of:

(a) factor A only

(b) factor B only

(c) factor A*B only

(d) factor A*B*C only

(e) None of the above

6. From your DOE analysis, you found no statistically significant factor. What typi-
cal graphical tool can you utilize to spot factors that may still be significant after
adjusting the error term?

(a) Scatter plot

(b) Normal plot

(c) Main effect plot

(d) Interaction plot

7. Your original factorial design was 24. If you decided to run a 1/2 fractional design
instead, how many experiments would you run?

(a) 4

(b) 8

(c) 16

(d) 32

8. A more general form of a fractional factorial design with two levels is:

(a) 2

(b) 2𝑘

(c) 2𝑘−1

(d) 2𝑘−𝑝

9. Given 𝑆𝑆𝐴 = [𝑎+ 𝑎𝑏 − 𝑏 − (1)]2/4𝑛, what is the contrast?
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10. What is the main purpose of 5S +1?

11. Why is the Swiss cheese model applicable for quality improvement in health care
informatics?

12. When do we apply DOE tools, and why?

13. Queueing theory is applied in quality improvement to help address which type of
process issue?

(a) Overproduction

(b) Overprocessing

(c) Learning curves

(d) Interruptions

14. Eliminating unnecessary approvals and signatures will likely help us reduce
NVA time due to:

(a) Overproduction

(b) Overprocessing

(c) Learning curves

(d) Interruptions

15. Assigning difficult tasks to highly-skilled employees will likely help us mitigate
NVA time due to

(a) Overproduction

(b) Overprocessing

(c) Learning curves

(d) Interruptions

16. Offloading will probably help us reduce NVA time due to:

(a) Overproduction

(b) Overprocessing

(c) Learning curves

(d) Interruptions

17. Always keeping the workstation clean relates to which element of 5S +1?

(a) Sort

(b) Straighten

(c) Shine

(d) Standardize
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18. Which tool is likely to help us best manage a queue from a sudden spike in de-
mand?

(a) Pooling

(b) Triaging

(c) Offloading

(d) 5S+1

19. Triaging and prioritizing shorter processing time jobs is likely to help us minimize
the:

(a) Lead time

(b) Completion rate

(c) Arrival rate

(d) NVA time

20. From your DOE analysis, you found the interaction between factors A and B to be
statistically significant, and your new process will involve the simultaneous setting
of A = -1 and B = +1. If your regression equation was as follows:

𝑌 = 10+7𝐴+3𝐵− 17𝐴𝐵

what can you conclude about the coefficients of the model?



MODULE 9

Tools for monitoring and controlling the process

In this module, we review techniques for monitoring and controlling a
process. Some of the tools that we consider include control and run
charts. We also discuss the implementation strategies of control charts
and the design of an out-of-control action plan (OCAP) to regulate the
future process. For software, we utilize Minitab and Excel.

Key concepts and tools: Shewhart model; Control charts; Run charts; Out-of-
control behaviors; Assignable causes; Sensitizing rules; Special cause variation;
Common cause variation; Sample size and frequency; Average run length (ARL);
Phases of control charts; Variable charts; Attribute charts; OCAP; Dashboards

Major objectives
After studying this module, you will be able to:

1. Define key concepts and tools for monitoring and controlling a process

2. Justify the need for monitoring variability in the process

3. Explain the Shewhart control chart model

4. Implement ImR and p control charts

5. Implement run charts

6. Differentiate the phases of chart application

7. Identify assignable causes in the process

8. Implement dashboards

9. Create an OCAP

10. Advocate for quality improvement using control charts

192
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9.1 Introduction

After we have improved and stabilized our process, we proceed to the Control phase
of DMAIC, where we implement monitoring measures to detect any new out-of-control
behaviors in the process. Some of the tools that we employ include control and run
charts. During this phase, we also create an OCAP and a transfer plan of the process.

9.2 Control charts

Control charts are essential tools of SPC1 that we utilize to monitor and improve quality.
There are two main types of control charts (Shewhart and time-weighted) that we im-
plement in two phases. In phase I, we implement Shewhart charts to detect big shifts
in the process. Phase I is essentially the period when we attempt to stabilize the process
(e.g., during the Improve phase of DMAIC). In phase II, we implement time-weighted
charts to monitor small shifts in the process (e.g., during the Control phase of DMAIC).
Although, we may still be able to employ Shewhart charts in phase II using rules known
as sensitizing, as we demonstrate later. The three common types of time-weighted con-
trol charts that do not discuss further here are Cumulative Sum (CUSUM), Exponentially
Weighted Moving Average (EWMA), and Moving Average (MA) [43]. In this module, we
only consider the application of Shewhart control charts.

9.2.1 The Shewhart model

Walter A. Shewhart is credited for introducing the concept of control charts in the 1920s
while working at Bell Labs [43]. As summarized in Box 9.1, the Shewhart’s model of
a control chart has three main components: an upper control limit (𝑈𝐶𝐿), a centerline
(𝐶𝐿), and a lower control limit (𝐿𝐶𝐿).

Box 9.1 Shewhart’s model of control charts

The construct of a Shewhart control chart is as follows:

𝑈𝐶𝐿 = 𝜇𝑤 +𝐿𝜎𝑤 (9.1)
𝐶𝐿 = 𝜇𝑤 (9.2)

𝐿𝐶𝐿 = 𝜇𝑤 −𝐿𝜎𝑤 (9.3)

where 𝑤 is the statistic of interest. Here, 𝜇𝑤 and 𝜎𝑤 symbolize the mean and
standard deviation of 𝑤, respectively. Letter 𝐿 denotes the distance measured in
standard deviation units from 𝐶𝐿 to 𝐿𝐶𝐿 or 𝑈𝐶𝐿 [43].

Control charts built following Box 9.1 are referred to as Shewhart control charts.

1SPC: Statistical Process Control
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9.2.2 How do Shewhart control charts work?

An analogy that is often used to describe the mechanics of a Shewhart control chart is
that of hypothesis testing (review Module 7). For demonstration purposes, let’s consider
the following hypothesis of a normally distributed process:

𝐻0 : 𝜇 = 𝜇0 (9.4)
𝐻1 : 𝜇 , 𝜇0 (9.5)

Here, 𝜇 is the process mean and 𝜇0 is the hypothesized mean that we estimated from
the process samples. The standard deviation 𝜎 is given, otherwise, we are able to obtain
its unbiased estimator from the process samples. If 𝑥𝑖 is the mean of sample 𝑖 of this
process, the following test statistic 𝐿 applies to the hypothesis under consideration:

𝐿 =
𝑥𝑖 −𝜇0
𝜎/
√
𝑛

(9.6)

where 𝑛 is the sample size. We obtain the confidence interval of the process mean 𝜇 in
terms of 𝑥𝑖 as follows:

𝜇0 −𝐿
𝜎
√
𝑛
≤ 𝑥𝑖 ≤ 𝜇0 +𝐿

𝜎
√
𝑛

(9.7)

We can think of the lower limit of the confidence interval in Equation 9.7 as 𝐿𝐶𝐿, the upper
limit as 𝑈𝐶𝐿, and 𝜇0 as 𝐶𝐿. If 𝑥𝑖 falls in this interval, then 𝑥𝑖 ≈ 𝜇0 and we conclude that
sample 𝑖 is in control. If 𝑥𝑖 , 𝜇0, 𝑥𝑖 will fall outside of the confidence interval, which will
lead us to reject 𝐻0. Accordingly, we will conclude that the process is out-of-control
or has special cause variation at that particular sample number. Failure to reject 𝐻0
at any sample number, is equivalent to saying that the process is in statistical control,
or simply that the process only exhibits common cause variation. By common cause
variation, we imply that the process behaves randomly within the control limits.

9.2.3 Implementing Shewhart control charts

Shewhart control charts are effective at improving quality if they are implemented cor-
rectly. For example, before implementing control charts, we must decide on how big the
sample sizes must be and how frequently sampling should be done. Besides, we must
understand how to choose distance 𝐿 and know how to detect out-of-control behaviors.

Sampling

Adequate sample sizes and the frequency of sampling are required for a successful
application of control charts. In general, we need at least 25 samples to construct a
control chart. The larger the sample sizes, the easier it is to detect small shifts in the
process. If obtaining large samples is not feasible, we try to take small samples but dot
it more frequently. In this effort, we must ensure rational subgroups to maximize the
between samples differences while minimizing the within-sample differences. Doing so
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will promote the independence of the samples, an assumption that we often make when
creating Shewhart control charts. An appropriate partition of the time-ordered samples
is critical in minimizing the dependence of the subgroups [43]. In general, sampling
only from units produced since the last subgroup, or from units produced under similar
conditions, will help ensure rational subgroups [43].

Choosing 𝐿

As indicated earlier, letter 𝐿 in a Shewhart control chart denotes the distance, in standard
deviation units, from the centerline to the control limit. It is customary to choose 𝐿 = 3,
but depending on the application, this setting may be different. For example, in the type
of control charts known as risk-adjusted, the limits are typically set to 𝐿 < 3 [61]. Why
should we care about where we set the control limits? We should care because different
settings of 𝐿 may lead to different conclusions about the following hypothesis:

𝐻0 : process in control (9.8)
𝐻1 : process not in control (9.9)

As it can be observed in the confidence interval in Equation 9.7, if 𝐿 is too big, meaning
too far from 𝐶𝐿, 𝑥𝑖 is more likely to fall within limits. This outcome increases the probability
𝛽 for Type II error, meaning that we are likely to fail to reject 𝐻0 when it is false. In
contrast, if 𝐿 is too small, 𝑥𝑖 is more likely to fall outside of the limits, which increases the
probability 𝛼 of Type I error where we reject 𝐻0 when it is true. We can think of type I
error as a false alarm in a stable process [43, 61]. Both type I and II errors affect how we
measure the performance of control charts. For example, using the probability of type I
error 𝛼, we can construct the control chart performance measure referred to as average
run length (ARL), as follows:

𝐴𝑅𝐿𝛼 =
1
𝛼

(9.10)

The 𝐴𝑅𝐿𝛼 measure also known as in-control ARL or 𝐴𝑅𝐿0, allows us to determine the
expected number of samples until a false alarm occurs in a stable process. In a normally
distributed process with 𝐿 = 3, the probability of a point falling either outside of 𝐿𝐶𝐿 or
𝑈𝐶𝐿 is given by 1−0.9973 = 0.0027. This implies that 𝐴𝑅𝐿𝛼 = 1/0.0027 ≈ 370. Hence,
we can expect a false alarm at every 370𝑡ℎ sample, if the process has not shifted. If the
process mean has shifted, we gauge the process performance using the 𝐴𝑅𝐿𝛽 measure
that we obtain like this:

𝐴𝑅𝐿𝛽 =
1

1− 𝛽
(9.11)

As previously noted, 𝛽 is the probability of type II error, and, as discussed in Module 7,
1−𝛽 is the power test that expresses the probability of correctly rejecting 𝐻0. The 𝐴𝑅𝐿𝛽
measure in Equation 9.11 is also referred to as out-of-control ARL or 𝐴𝑅𝐿1. This statistic
expresses the expected number of samples to detect a mean shift of 𝑘𝜎 in the process.
In practice, we want to be able to detect a shift in the process as soon as it happens. We
can accomplish this by increasing the sample size 𝑛 since that decreases 𝛽 [43].
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Sensitizing rules

We have previously noted that when all sample statistics of interest fall within the control
limits, the process is in statistical control. We want to underscore that this conclusion
is true only when points fall within the control limits randomly. Otherwise, if a particu-
lar pattern exists, out-of-control behaviors are likely due to small shifts in the process.
One way to detect such shifts is to employ specialized rubrics referred to as sensitizing
rules, as exemplified in How-To 9.1. It is important to emphasize that these rules are not
universal. Another way to detect small shifts in the process is by utilizing time-weighted
control charts.

How-To 9.1 (Sensitizing rules in Minitab 18)
For each control chart, Minitab 18 displays applicable sensitizing rules. To access
these rules, click on Chart options > Tests. See Figure 9.1 for an example of sensi-
tizing rules of an 𝐼𝑚𝑅 control chart.

Figure 9.1: Sensitizing rules of an 𝐼𝑚𝑅 control chart in Minitab 18

Example 9.1 (Special cause variation)
Figure 9.2 shows an example of a control chart with out-of-control behaviors since
at sample #5, a point fell outside of 𝐿𝐶𝐿.
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Figure 9.2: A control chart with one type of special cause variation
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After applying the sensitizing rules, Figure 9.3 further indicates that this process
has special cause variation at samples 35 and 36, given that 2 out of 3 consecutive
points are between the second and third standard deviation limits on the same side.

Figure 9.3: A control chart with two types of special cause variation
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9.2.4 How to improve a process using Shewhart control charts?

A process with out-of-control behaviors is unstable. To stabilize the process, we must
attempt to assign a reason to the special cause and try to rectify it. When the cause is
assignable and rectifiable, we remove the out-of-control sample from the process and
recalculate the centerline and control limits. By removing assignable causes, variabil-
ity decreases, which in turn improves the process [43]. A process with no special
cause variation needs no improvement. But, one could still decide to reduce common
cause variation, which amounts to creating a new process [43].
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Remark: Control charts only tell us about the samples that are out-of-control but say nothing
about the actual reasons for out-of-control behaviors. Assigning causes and fixing particular
sources of the special cause variation requires good knowledge of the process, and a well-tuned
understanding of how to apply various quality improvement tools, including Lean methods and
designed experiments.

How-To 9.2 (Omitting samples in Minitab 18)
To remove an assignable cause, click on Chart Options tab of a control chart >
Estimate > Enter the sample number(s) to be omitted. See the snapshot in Figure
9.4.

Figure 9.4: Omitting samples with assignable causes in Minitab 18

Note: After omitting a sample number, Minitab 18 calculates a new centerline and
also adjusts control limits, but, depending on setting in Minitab, the omitted sample
may still be visible on the chart.

Example 9.2 (Assignable special cause variation)
A medical coding manager at Metropolis Hospital monitors the daily processing time
of inpatient records. The control chart indicates that the sample from last Monday
was out-of-control. After brainstorming with coders and the IT staff, the manager
realized that the reason for out-of-control behaviors was encoder updates that over-
wrote some coding data on that day. Since the manager knows the reason for the
out-of-control behaviors (that is, the manager assigned the cause), the sample from
last Monday will be omitted, and the centerline and control limits recalculated. By
removing the out-of-control sample, variability will decrease in the process control
chart.

Example 9.3 (Common cause variation)
The office manager at Metropolis Radiology Center uses control charts to monitor
the average coding time for outpatient records. No special variation causes have
been noticed, but still, the manager would like to reduce common cause variation
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by creating a new process based on computer-assisted coding (CAC) technology.
The manager believes that the new process will minimize variability by improving
the consistency of coding. The manager will need new control charts to monitor the
new process.

9.2.5 The types of Shewhart’s control charts

The two common categories of Shewhart’s control charts are variable and attribute. We
use variable charts when a process generates continuous independent data. Typical
variable charts include 𝐼𝑚𝑅, 𝑋𝑏𝑎𝑟𝑅, and 𝑋𝑏𝑎𝑟𝑆. We employ 𝐼𝑚𝑅 charts when the
sample size 𝑛 = 1. We apply 𝑋𝑏𝑎𝑟𝑅 charts when 1 < 𝑛 ≤ 10. When 𝑛 > 10, we use
𝑋𝑏𝑎𝑟𝑆 charts. The normal distribution is typically assumed in all variable charts. We
apply attribute charts when a process generates independent discrete data. Typical
attribute charts include 𝑝, 𝑛𝑝, 𝑐, 𝑢, 𝑔, and ℎ. The 𝑝 chart relates to the Bernoulli random
variable. The 𝑛𝑝 chart relates to the binomial random variable. The 𝑐 and 𝑢 assume the
Poisson random variable. The 𝑔 and ℎ charts presume the geometric random variable.

In this module, we only demonstrate how to build 𝐼𝑚𝑅 and 𝑝 charts. These charts
are likely to be sufficient when monitoring basic processes in health care informatics. For
the reader interested in learning how to construct other types of Shewhart charts, as well
as time-weighted charts, see a separate book that we have on the application methods
of control charts in health care.

9.2.6 ImR charts

We use 𝐼𝑚𝑅 control charts, also symbolized as 𝐼-𝑀𝑅, to monitor a process when the
sample size 𝑛 = 1. The part of 𝐼 monitors individual observations, whereas the part
of 𝑀𝑅, which stands for moving range, monitors variability in the process. We denote
observation 𝑥 in sample 𝑖 as 𝑥𝑖 and calculate the average 𝑥 of all observations 𝑚 like
this:

𝑥 =
1
𝑚

𝑚∑︁
𝑖=1

𝑥𝑖 (9.12)

We determine 𝑀𝑅 between two successive observations. As such, MR between 𝑥𝑖 and
𝑥𝑖−1 is given by:

𝑀𝑅𝑖 = |𝑥𝑖 − 𝑥𝑖−1| (9.13)

for 𝑖 : 2, . . . ,𝑚, where the |.| symbol signifies the absolute value. We calculate the average
of moving ranges, 𝑀𝑅 as follows:

𝑀𝑅 =
1

𝑚− 1

𝑚∑︁
𝑖=2

𝑀𝑅𝑖 (9.14)
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We estimate the variability in the process this way:

𝜎 ≈ 𝜎 =
𝑀𝑅
𝑑2

(9.15)

where, from Appendix Table 1, 𝑑2 = 1.128 when 𝑛 = 2, since we determine 𝑀𝑅 using
two observations. Box 9.2 summarizes the formulas for 𝐼𝑚𝑅 control charts.

Box 9.2 Formulas for 𝐼𝑚𝑅 control charts when 𝐿 = 3

The formulas for 𝐼𝑚𝑅 charts are as follows:

𝐼 chart 𝑀𝑅 chart

𝑈𝐶𝐿 𝑥+3
𝑀𝑅
𝑑2

𝐷4𝑀𝑅

𝐶𝐿 𝑥 𝑀𝑅

𝐿𝐶𝐿 𝑥 − 3𝑀𝑅
𝑑2

𝐷3𝑀𝑅

Here, 𝑥 is the overall mean of observations. We obtain parameters 𝑑2, 𝐷3, and 𝐷4
in Appendix Table 1 when 𝑛 = 2. Since we can’t have negative observations, when
𝐿𝐶𝐿 < 0, we set 𝐿𝐶𝐿 = 0.

How-To 9.3 (𝐼-𝑀𝑅 charts in Minitab 18)
To construct 𝐼𝑚𝑅 charts in Minitab 18, click on Stat > Control Charts > Variable
Control Charts for Individuals > I-MR > Select your data > OK. See the snapshot in
Figure 9.5.

Figure 9.5: Options for 𝐼-𝑀𝑅 control charts in Minitab 18
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How-To 9.4 (𝐼-𝑀𝑅 charts in Excel 2013)
Excel does not have a built-in option to create 𝐼 −𝑀𝑅 charts, but we can man-
ually program the formulas from Box 9.2 in a spreadsheet, as we demonstrate in
Example 9.4.

Example 9.4 (𝐼-𝑀𝑅 charts)
The lab manager at Metropolis Hospital is interested in monitoring the turn around
time (TAT) of “stat” potassium orders for each patient. A shorter TAT is preferred
since potassium levels are required before patients could be taken off the heart/lung
bypass machine in the cardiac unit [50]. To set up preliminary 𝐼𝑚𝑅 control charts,
the manager collected 30 random samples, as portrayed in Table 9.1.

Table 9.1: TAT, in minutes (X), of “stat” potassium orders at Metropolis Hospital

Sample# 𝑋 Sample# 𝑋

1 27 16 29
2 32 17 31
3 54 18 47
4 27 19 40
5 31 20 31
6 40 21 37
7 45 22 27
8 20 23 26
9 33 24 40
10 41 25 33
11 30 26 70
12 44 27 45
13 24 28 29
14 22 29 44
15 33 30 43

To help the manager construct the appropriate control chart, we start by consulting
Appendix Table 1 for 𝑛 = 2 and obtain 𝑑2 = 1.128, 𝐷3 = 0, and 𝐷4 = 3.267. Next,
we set up our spreadsheet, as portrayed in Figure 9.6.
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Figure 9.6: A setup of 𝐼-𝑀𝑅 control charts in Excel based on the data in Table 9.1

To create the 𝐼-𝑀𝑅 charts, we follow these steps:

Step 1: From the setup in Figure 9.6, we have column B containing individual ob-
servations that we monitor in the 𝐼 chart. We also use this column to deter-
mine the moving ranges (𝑀𝑅).

Step 2: We obtain the 𝑀𝑅 values per Equations 9.13 and 9.14. For example, we
calculated the 𝑀𝑅 value in cell C4 using = 𝐴𝐵𝑆(𝐵3−𝐵4). We dragged down
this formula to populate the rest of the values. Furthermore, we obtained 𝑀𝑅
value in cell M7 using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐶4 : 𝐶32).

Step 3: In this step, we calculate the 𝑋 value. We obtained the value in cell M6
using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵3 : 𝐵32).

Step 4: To construct the control limits, we apply the formulas in Box 9.2. For ex-
ample, we obtained the 𝑈𝐶𝐿 value in cell 𝐷3 by = 𝑅𝑂𝑈𝑁𝐷($𝑀$6 + 3 *
($𝑀$7/$𝑀$3),2) and obtained the 𝐿𝐶𝐿 value in cell 𝐽3 by = $𝑀$4 * $𝑀$7.
The 𝐶𝐿 value in cell E3 follows from = 𝑅𝑂𝑈𝑁𝐷($𝑀$6,2). We use the
𝑅𝑂𝑈𝑁𝐷(𝑥,2) function to round 𝑥 to two decimal places. The $ sign in Excel
formulas allows us to drag down the formula and easily populate the rest of
the values while keeping cells with the $ sign constant.

Step 5: In this final step, we insert line charts of columns D-F to create the 𝐼 chart
and line charts of columns H-J to create the 𝑀𝑅 chart.
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Figure 9.7 portrays 𝐼-𝑀𝑅 charts that we created by following the instructions in
How-To 9.3.

Figure 9.7: 𝐼-𝑀𝑅 control charts created in Minitab using the data from Table 9.1

From any of these sets of 𝐼-𝑀𝑅 charts, we appreciate that the 𝐼 chart exhibits
out-of-control behavior at sample 26. The 𝑀𝑅 chart does not show any special
cause variation, but it is also clear that sample 26 is too close to 𝑈𝐶𝐿. To improve
this process, the manager needs to investigate sample 26 and remove any sources
of variability. After assigning the causes and fixing the problems, the manager
can follow the instructions in How-To 9.2 to omit sample 36, which will result in
a decrease in the variability of the process. For example, after trying this, you will
notice that in the 𝐼-𝑐ℎ𝑎𝑟𝑡, 𝑈𝐶𝐿 will decrease from 67.56 to 62.77 and 𝐿𝐶𝐿 will move
up from 4.1 to 6.54. In the 𝑀𝑅-𝑐ℎ𝑎𝑟𝑡, 𝑈𝐶𝐿 will decrease from 38.98 to 34.54. In
both cases, the mean values will also decrease. As the new control charts will be
stable, after omitting sample 26, the manager will be able to use the revised charts
to monitor the future process.

9.2.7 A p chart

We use a 𝑝 chart to monitor the fraction of defective units in the process. A 𝑝 chart is
based on the Bernoulli random variable given by:

𝑝(𝑥) =

⎧⎪⎪⎨⎪⎪⎩𝑝 𝑥 = 1
1− 𝑝 𝑥 = 0

(9.16)
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where 𝑝 is the probability of an event under study. If a randomly selected unit is defective,
𝑥 = 1, otherwise 𝑥 = 0. The mean 𝜇 and the standard deviation 𝜎 of the Bernoulli
random variable are given by:

𝜇 = 𝑝 (9.17)

𝜎 =
√︀
𝑝(1− 𝑝) (9.18)

Since we generally don’t know 𝑝, we estimate it from the process samples via the method
of the maximum likelihood estimator(MLE). To demonstrate, let’s suppose that we took 𝑚
number of samples with each sample 𝑖 having a constant size 𝑛. If 𝐷𝑖 is the number of
defective units is sample 𝑖, the MLE estimator of 𝑝 is given by �̄� as follows:

�̄� =
∑︀𝑚

𝑖=1𝐷𝑖

𝑚𝑛
(9.19)

When the sample size is variable, we obtain �̄� like this:

�̄� =
∑︀𝑚

𝑖=1𝐷𝑖∑︀𝑚
𝑖=1𝑛𝑖

(9.20)

Following from the central limit theorem, we obtain the standard deviation of the sample
mean like this:

𝜎�̄� =

√︂
�̄�(1− �̄�)

𝑛
(9.21)

Box 9.3 summarizes the formulas for creating a 𝑝 chart.
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Box 9.3 The formulas for a 𝑝 chart when 𝐿 = 3

When the standard of 𝑝 is given, we apply these formulas:

UCL 𝑝+3

√︂
𝑝(1− 𝑝)

𝑛

CL 𝑝

LCL 𝑝 − 3
√︂

𝑝(1− 𝑝)
𝑛

When no standard is given, we apply the following formulas:

UCL �̄�+3

√︂
�̄�(1− �̄�)

𝑛

CL �̄�

LCL �̄� − 3
√︂

�̄�(1− �̄�)
𝑛

In each sample 𝑖, we monitor the fraction of defective units �̂�𝑖 = 𝐷𝑖/𝑛, when the
sample size is constant. When the sample size varies, we monitor �̂�𝑖 = 𝐷𝑖/𝑛𝑖 in
each sample. The �̄� statistic is obtained per Equation 9.19 or 9.20.

Remark (LCL > 0): It is common practice to set the LCL value 𝑥 to max(0,𝑥) since negative
defective units don’t make sense. This approach generally works well, but it has a downside
since all negative values are treated the same. In other words, we may never know when the
process has a very small fraction of defective units since all we may observe is LCL = 0. To
remedy this problem, we choose the sample size 𝑛 so that LCL is always positive. To do that, we
proceed as follows:

�̄� −𝐿
√︂

�̄�(1− �̄�)
𝑛

= 0 (9.22)

−𝐿
√︂

�̄�(1− �̄�)
𝑛

= −�̄� (9.23)⎛⎜⎜⎜⎜⎜⎝−𝐿
√︂

�̄�(1− �̄�)
𝑛

⎞⎟⎟⎟⎟⎟⎠
2

= (−�̄�)2 (9.24)

𝐿2�̄�(1− �̄�)
𝑛

= �̄�2 (9.25)

𝐿2�̄�(1− �̄�)
�̄�2

= 𝑛 (9.26)

𝐿2(1− �̄�)
�̄�

= 𝑛 (9.27)



206 9.2. Control charts

So, to ensure that 𝐿𝐶𝐿 > 0, we must choose 𝑛 such that:

𝑛 ≥
⌈︃
𝐿2(1− �̄�)

�̄�

⌉︃
(9.28)

where ⌈.⌉ is a ceiling function.
Alternatively, we could monitor standardized values given by:

𝑍𝑖 =
�̂�𝑖 − 𝑝√︁
𝑝(1−𝑝)

𝑛𝑖

𝑖 = 1,2, . . . ,𝑚 (9.29)

where 𝑈𝐶𝐿 = 𝐿, 𝐶𝐿 = 0, and 𝐿𝐶𝐿 = −𝐿. We recall that �̂�𝑖 is the fraction of defective units in
sample 𝑖 and 𝑛𝑖 is the corresponding sample size.

How-To 9.5 (A 𝑝 chart in Excel 2013)
Excel does not have a built-in option to create a 𝑝 chart, but we can manually pro-
gram the formulas from Box 9.3 in a spreadsheet, as we demonstrate in Example
9.5.

How-To 9.6 (A 𝑝 chart Minitab 18)
To construct a 𝑝 chart in Minitab 18, click on Stat > Control Charts > Attribute
Charts > Select 𝑃 . . . > Select your data > Input the sample size or the column of
sample sizes>OK. See the snapshot in Figure 9.8.

Figure 9.8: Options for a p chart in Minitab 18

Example 9.5 (A 𝑝 chart)
The HIMa manager at Metropolis Hospital sits on the revenue cycle steering com-
mittee. At the last week’s meeting, it was decided to start monitoring billing denials
by the department. The HIM manager was charged with monitoring denials due to
medical coding errors. Table 9.2 presents the monthly denial data for the last 30
months. The column of 𝐷𝑒𝑛𝑖𝑎𝑙𝑠 represents the variable sample size of all denials,
and the 𝐶𝑜𝑑𝑖𝑛𝑔 column contains the number of denials due to medical coding er-
rors.
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Table 9.2: Denials related to medical coding errors at Metropolis Hospital

Sample# Denials Coding Sample# Denials Coding

1 36 4 16 38 5
2 39 2 17 20 5
3 22 7 18 49 4
4 44 5 19 39 6
5 22 5 20 46 6
6 45 2 21 45 5
7 33 6 22 37 5
8 21 6 23 42 2
9 37 7 24 45 7
10 40 3 25 30 4
11 41 2 26 38 2
12 27 7 27 24 9
13 34 8 28 27 3
14 23 4 29 32 2
15 27 7 30 48 6

The manager has decided to apply the 𝑝 chart to monitor the process. Using
Python, the manager programmed the formulas in Box 9.3, when 𝑝 is not given,
and produced the chart in Figure 9.9. This 𝑝 chart exhibits out-of-control behav-
iors at sample 27. To improve the process, the manager needs to find and fix all the
causes of special variation in this sample. Subsequently, sample 27 can be omitted,
and a new control chart created to continue to monitor the process. This procedure
should be iterated until no more out-of-control behaviors exist in the process.

Figure 9.9: A 𝑝 chart based on the data in Table 9.2
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Next, we demonstrate how you can reproduce this 𝑝 chart in Excel. We also include
instructions about how you can create a corresponding Z chart for standardized
values.
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1. First set up your spreadsheet, as illustrated in Figure 9.10.

Figure 9.10: A setup of Excel to create the 𝑝 and 𝑍 charts based on the data in
Table 9.2

A B C D E F G H I J

1 Denials Coding phat Zi LCL CL UCL Parameters

2 36 4 0.11 -0.52 0 0.14 0.31 pbar 0.14

3 39 2 0.05 -1.62 0 0.14 0.31

4 22 7 0.32 2.43 0 0.14 0.36

5 44 5 0.11 -0.57 0 0.14 0.3

6 22 5 0.23 1.22 0 0.14 0.36

7 45 2 0.04 -1.93 0 0.14 0.3

8 33 6 0.18 0.66 0 0.14 0.32

9 21 6 0.29 1.98 0 0.14 0.37

10 37 7 0.19 0.88 0 0.14 0.31

11 40 3 0.08 -1.09 0 0.14 0.3

12 41 2 0.05 -1.66 0 0.14 0.3

13 27 7 0.26 1.8 0 0.14 0.34

14 34 8 0.24 1.68 0 0.14 0.32

15 23 4 0.17 0.41 0 0.14 0.36

16 27 7 0.26 1.8 0 0.14 0.34

17 38 5 0.13 -0.18 0 0.14 0.31

18 20 5 0.25 1.42 0 0.14 0.37

19 49 4 0.08 -1.21 0 0.14 0.29

20 39 6 0.15 0.18 0 0.14 0.31

21 46 6 0.13 -0.2 0 0.14 0.29

22 45 5 0.11 -0.58 0 0.14 0.3

23 37 5 0.14 0 0 0.14 0.31

24 42 2 0.05 -1.68 0 0.14 0.3

25 45 7 0.16 0.39 0 0.14 0.3

26 30 4 0.13 -0.16 0 0.14 0.33

27 38 2 0.05 -1.6 0 0.14 0.31

28 24 9 0.38 3.39 0 0.14 0.35

29 27 3 0.11 -0.45 0 0.14 0.34

30 32 2 0.06 -1.3 0 0.14 0.32

31 48 6 0.13 -0.2 0 0.14 0.29
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2. Determine the �̄� value in cell 𝐽2 as indicated in Equation 9.20, as follows:
= 𝑅𝑂𝑈𝑁𝐷(𝑆𝑈𝑀(𝐵2 : 𝐵31)/𝑆𝑈𝑀(𝐴2 : 𝐴31),2).

3. Calculate the �̂�𝑖 statistic for each month 𝑖 using this ratio: 𝐶𝑜𝑑𝑖𝑛𝑔/𝐷𝑒𝑛𝑖𝑎𝑙𝑠.
For example, the value in cell 𝐶2 was obtained by = 𝑅𝑂𝑈𝑁𝐷(𝐵2/𝐴2,2). You
can drag down this formula to populate the rest of the values.

4. Create control limits when no standards are given, as indicated in Box 9.3. For
example, the value of LCL in cell 𝐸2 was calculated using = 𝑀𝐴𝑋(0,$𝐽$2−
3 * 𝑆𝑄𝑅𝑇 ($𝐽$2 * (1− $𝐽$2)/𝐴2)). The value of CL in cell 𝐹2 was obtained by
= $𝐽$2. The value of UCL in cell 𝐺2 was determined using = 𝑅𝑂𝑈𝑁𝐷($𝐽$2+
3 * 𝑆𝑄𝑅𝑇 ($𝐽$2 * (1− $𝐽$2)/𝐴2),2).

5. To create the p chart, insert line charts for columns C, E, F, and G.

6. You can also create a standardized 𝑍 chart. Use Equation 9.29 to calculate
the statistic to be monitored, 𝑍𝑖 . For example, the value of 𝑍𝑖 in cell 𝐷2 was
obtained by = 𝑅𝑂𝑈𝑁𝐷((𝐶2−$𝐽$2)/𝑆𝑄𝑅𝑇 ($𝐽$2*(1−$𝐽$2)/𝐴2),2). You can
also drag down this formula to populate the rest of the values.

To reproduce the 𝑝 chart in Minitab, follow the instructions in How-To 9.6.
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aHIM: Health Information Management

9.3 Run charts

9.3.1 A general concept

Run charts are like control charts but without limits. Moreover, the centerline in the run
charts is typically the median of the data, not the mean. While, whenever possible, we
should utilize control charts to monitor processes, using run charts has its advantages
such as the simpler setup. Also, in run charts, we do not have to assume any particular
probability distribution, meaning that we could use these tools to monitor any process.
The major downside of run charts is that the interpretation requires a bit more effort
since there is no easy way to tell that a particular sample is out-of-control. Figure 9.11
portrays an example of a run chart that relates to the control chart in Figure 9.3.

Figure 9.11: An example of a run chart based on the chart in Figure 9.2
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From the control chart in Figure 9.3 , we have previously concluded that there were
two areas of special cause variation due to a point falling outside of LCL and a violation of
one of the sensitizing rules since 2 out of 3 consecutive points were between the second
and third standard deviation limits on the same side. Now the question at hand is that
since there are no limits in the run chart in Figure 9.11, how do we go about detecting
out-of-control behaviors?

9.3.2 Interpreting run charts

We detect out-of-control behaviors in run charts by finding instances of non-randomness
in the process. We utilize two techniques to accomplish this task: visual examination
and statistical run tests.
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Visual examination

We can use a visual examination to detect special cause variation in run charts by apply-
ing the following rules [51]:

1. Seven or more points on the same side of the median signify a likely shift in the
process.

2. Seven or more points that are either increasing or decreasing indicate a trend in
the process.

We can also visually detect other likely special causes, such as a cluster of points and
zig-zag or oscillation behaviors. To test the significance of these out-of-control behav-
iors, we apply statistical run tests.

Run tests

We conduct statistical run tests to determine the significance of non-randomness in the
process. Our null hypothesis is that the sequence of the process measurements is ran-
dom. Run tests work for both the metric and non-metric data. For our purposes, a
sequence of groups of data points that are above (run-ups +) or below (run-downs -)
the centerline constitute non-metric data. In contrast, a sequence of successive numeri-
cal differences in the process constitutes metric data. We define the term run as follows:

Definition 9.1 (Run) A run is a sequence of identical signs (+ or −) until a different
sign occurs or the series terminates [57].

To construct a run test, we assume that there are 𝑅 total number of runs in the data,
given by:

𝑅 = 𝑦1 + 𝑦2 (9.30)

where 𝑦1 is the number of run-ups and 𝑦2 is the number of run-downs. We use 𝑛1 to
symbolize the total count of points in the set 𝑦1 and 𝑛2 to denote the total count of points
in the set 𝑦2. We calculate 𝑝(𝑦1, 𝑦2), the probability of obtaining exactly 𝑦1 runs and 𝑦2
runs this way [61]:

𝑝(𝑦1, 𝑦2) =

(︀𝑛1−1
𝑦1−1

)︀(︀𝑛2−1
𝑦2−1

)︀(︀𝑛1+𝑛2
𝑛1

)︀ (9.31)

We obtain the probability of 𝑅 being less or equal to some value 𝑘, that is 𝑝(𝑅 ≤ 𝑘)
by adding together the probabilities of different combinations of 𝑦1 and 𝑦2 that produce
𝑦1 + 𝑦2 ≤ 𝑘. We use 𝑝(𝑅 ≤ 𝑘) to establish the confidence interval for 𝑅. If 𝑅 falls outside
of our interval, we reject the null hypothesis, which implies that out-of-control behaviors
exist. For small sample sizes of 𝑛1 and 𝑛2, we can establish the confidence interval of 𝑅
by consulting reference tables of run statistics that are often found in standard statistical
textbooks (e.g., see Wackerly et al. (2007)[57]). As 𝑛1 and 𝑛2 get larger (e.g., when
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both 𝑛1 and 𝑛2 are greater than 10), we assume a normal distribution and establish the
confidence interval as follows [57]:

𝐸(𝑅)− |𝑍 |
√︀
𝑉 (𝑅) ≤ 𝑅 ≤ 𝐸(𝑅) + |𝑍 |

√︀
𝑉 (𝑅) (9.32)

where 𝑍 is a standard value given by:

𝑍 =
𝑅−𝐸(𝑅)√︀

𝑉 (𝑅)
(9.33)

Here, 𝐸(𝑅) symbolizes the expectation of runs, and 𝑉 (𝑅) represents the variance of runs.
When the process generates non-metric data, we obtain 𝐸(𝑅) and 𝑉 (𝑅) this way [61]:

𝐸(𝑅) =
2𝑛1𝑛2

𝑛
+1 (9.34)

𝑉 (𝑅) =
2𝑛1𝑛2(2𝑛1𝑛2 −𝑛)

(𝑛− 1)𝑛2
(9.35)

where 𝑛 is the total number of observations given. For metric data, we approximate 𝐸(𝑅)
and 𝑉 (𝑅) as follows [61]:

𝐸(𝑅) ≈ 2𝑛− 1
3

(9.36)

𝑉 (𝑅) ≈ 16𝑛− 29
90

(9.37)

Interpretation

When 𝑅 < 𝐸(𝑅)−|𝑍 |
√︀
𝑉 (𝑅), we have too few runs, whereas 𝑅 > 𝐸(𝑅)+|𝑍 |

√︀
𝑉 (𝑅) implies

that we have too many runs. In general, having too many or too few runs is indicative
of non-randomness in the process data [57]. In non-metric data, having too few runs
signals the tendency of the data to cluster above or below the centerline. The result of
too many runs implies zig-zag behaviors, which may mean a mixture of two processes.
It follows that [42]:

(p-value for mixtures) + (p-value for clustering) = 1 (9.38)

For metric data, having too few runs implies the tendency of the data to form trends
above or below the centerline. Having too many runs suggests that oscillation behav-
iors exist in the process. It is given that [42]:

(p-value for trends) + (p-value for oscillation) = 1 (9.39)
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How-To 9.7 (Run charts in Minitab 18)
Click on Stat > Quality Tools> Run Chart > check the single column radio option >
select your data > Input the subgroup size > Plot subgroup medians > OK.

Figure 9.12: The options for run charts in Minitab 18

How-To 9.8 (Run charts in Excel 2013)
Excel does not have a built-in option to create run charts, but we can manually
program the given formulas as we demonstrate in Examples 9.6 - 9.8.

Example 9.6 (Binary process data)
Metropolis Hospital monitors patient satisfaction. On the survey questionnaire, pa-
tients are asked whether they are satisfied (Y) or not satisfied (N) with their hospital
stay. The following is the sequence of the responses from the most recent ten
discharges:

𝑌 ,𝑌 ,𝑁 ,𝑌 ,𝑁 ,𝑁,𝑌 ,𝑌 ,𝑁 ,𝑌 (9.40)

The officials at Metropolis Hospital have asked us to help answer the question of
whether these responses are random. To answer this question, we begin by enu-
merating the runs in the data as follows:

𝑌 ,𝑌⏟ ⏞ 
R1

,

R2⏞ ⏟ 
𝑁 , 𝑌⏟ ⏞ 

R3

,

R4⏞ ⏟ 
𝑁,𝑁 , 𝑌 ,𝑌⏟ ⏞ 

R5

,

R6⏞ ⏟ 
𝑁 , 𝑌⏟ ⏞ 

R7

(9.41)

Expression 9.41 indicates that we have 7 runs meaning that 𝑅 = 7. We represent
run-downs (𝑅1,𝑅3,𝑅5, and 𝑅7) with 𝑦1. We notice that the number of data points
in 𝑦1 corresponds to 𝑛1 = 6. We represent run-ups (𝑅2,𝑅4, and 𝑅6) with 𝑦2 where
𝑛2 = 4. By consulting reference tables of runs, when 𝑛1 = 6 and 𝑛2 = 4, we estab-
lish the confidence interval of 𝑝(𝑅 ≤ 2 = 0.010) and 𝑝(𝑅 > 8) = 1−𝑝(𝑅 ≤ 8) = 0.024.
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Given that 𝑅 = 7 falls within this confidence interval, we fail to reject the null hy-
pothesis that the sequence of patient responses is random.

Example 9.7 (Non-metric data from run charts)
We revisit the run chart depicted in Figure 9.11 and attempt to identify out-of-control
behaviors in this chart. We start by counting the number of runs above and below
the median, as we illustrate in Figure 9.13.

Figure 9.13: Counting the number of runs in the chart portrayed in Figure 9.11

From Figure 9.13, we identify 9 run-ups with 20 data points. We represent this
information with 𝑦1 = 9 and 𝑛1 = 20. Coincidentally, the information for run-downs
is identical as follows: 𝑦2 = 9 and 𝑛2 = 20. The total number of runs is given by
𝑅 = 𝑦1 + 𝑦2 = 9 + 9 = 18. We use Equations 9.33 - 9.35 to construct the following
confidence interval:

𝐸(𝑅) = 21 (9.42)
𝑉 (𝑅) = 9.74 (9.43)
|𝑍 | = 1.96 (9.44)

15 ≤ 𝑅 ≤ 27 (9.45)

We set the significance level to 𝛼 = 0.05. Given that 𝑅 = 18 falls within the resulting
confidence interval, we fail to reject the null hypothesis that this sequence is
random. We compute the corresponding p-value for clustering as follows:

𝑝-𝑣𝑎𝑙𝑢𝑒 ≡Θ−1(𝑍0) = 0.168 (9.46)

where 𝑍0 is the test statistic obtained this way:

𝑍0 =
18− 21
√
9.74

= −0.96108 (9.47)

Since 𝑝-𝑣𝑎𝑙𝑢𝑒 > 0.05, we reject the null hypothesis that the process does not have
clusters. The p-value for mixtures is given by 1− 0.168 = 0.832, which leads us to
conclude that there is no statistically significant process mixtures in this example.
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Example 9.8 (Metric data from run charts)
Let us revisit Example 9.7, but this time investigate the randomness in the sequence
of successive numerical differences using the data in Table 9.3.

Table 9.3: Data related to the run chart in Figure 9.13

Sample Data Sample Data

1 66.36 21 33.92
2 36.08 22 48.2
3 45.72 23 31.2
4 69.2 24 36.24
5 5.0 25 52.0
6 21.64 26 71.6
7 42.56 27 63.92
8 19.56 28 32.92
9 44.12 29 25.52
10 51.0 30 27.0
11 59.84 31 28.88
12 51.28 32 43.16
13 13.36 33 61.04
14 63.24 34 47.36
15 41.4 35 26.32
16 47.32 36 14.84
17 48.0 37 13.04
18 71.96 38 64.12
19 30.72 39 66.24
20 21.04 40 11.96

We begin by determining the signs of the running differences, as illustrated in Table
9.4. This table has two derived columns. We use the column of 𝑆𝐼𝐺𝑁 to track
the signs of the differences and the column of 𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 to identify runs.
For example, we determined the sign in cell B3 using the 𝑆𝐼𝐺𝑁 () function in Excel
as follows: 𝑆𝐼𝐺𝑁 (36.08 − 66.36) = −. Likewise, we obtained the sign in cell B4
this way: 𝑆𝐼𝐺𝑁 (45.72− 36.08) = +. To automate this procedure, we encoded the
following formula in cell B3:

= 𝐼𝐹(𝑆𝐼𝐺𝑁 (𝐴3−𝐴2) = 1,” + ”,”− ”) (9.48)

Next, we dragged down this formula to populate the rest of the signs. In the
𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 column, we encoded 1 if a run existed per Definition 9.1. For
example, the value of 1 in cell C3 was obtained using 𝐼𝐹(𝐵4 = 𝐵5,0,1). Dragging
down this formula allowed us to populate the rest of the values. The sum of the
𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 column gave us the total number of runs 𝑅. To find the number in
the run-ups (+) or 𝑛1, we used this formula:

= 𝐶𝑂𝑈𝑁𝑇 𝐼𝐹(𝐵3 : 𝐵41,” + ”) (9.49)

Correspondingly, we found the number of the run-downs(-) or 𝑛2 like this:

= 𝐶𝑂𝑈𝑁𝑇 𝐼𝐹(𝐵3 : 𝐵41,”− ”) (9.50)
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In the end, we determined that 𝑅 = 19, 𝑛1 = 22, and 𝑛2 = 17.

Table 9.4: A spreadsheet setup for creating run tests of the data in Table 9.3

A B C

1 Data SIGN COUNT SIGN

2 66.36

3 36.08 - 1

4 45.72 + 0

5 69.2 + 1

6 5.0 - 1

7 21.64 + 0

8 42.56 + 1

9 19.56 - 1

10 44.12 + 0

11 51.0 + 1

. . . . . . . . . . . .

Finally, we applied the formulas in Equations 9.33, 9.36, and 9.37 to find:

𝐸(𝑅) = 26.3 (9.51)
𝑉 (𝑅) = 6.78 (9.52)
|𝑍 | = 1.96 (9.53)

21.2 ≤ 𝑅 ≤ 31.4 (9.54)

Since 𝑅 = 19 falls outside of the confidence interval, we reject the null hypothesis
at the significance level of 0.05. Additionally, since 𝑅 < 𝐸(𝑅) − |𝑍 |

√︀
𝑉 (𝑅), that is

19 < 21.2, we conclude that a trend is likely in the process. To estimate the 𝑝-
𝑣𝑎𝑙𝑢𝑒 for the trend, we proceed this way:

𝑍0 =
19− 26.3
√
6.78

= −2.814 (9.55)

We obtain the probability of interest this way:

𝑝-𝑣𝑎𝑙𝑢𝑒 ≡Θ−1(𝑍0) = 0.002 (9.56)

Since 𝑝-𝑣𝑎𝑙𝑢𝑒 < 0.05, we reject the null hypothesis that there is no trend in the
data. We obtain the 𝑝-𝑣𝑎𝑙𝑢𝑒 for oscillation by 1 − 0.002 = 0.998. Since 𝑝-𝑣𝑎𝑙𝑢𝑒
> 0.05, we conclude that no statistically significant oscillation exists in this process.
By following instructions in How-To 9.7, we reproduced similar results in Minitab, as
portrayed in Figure 9.14. We used a subgroup of size 1.
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Figure 9.14: The run chart in Minitab based on the data in Table 9.3

The boxed area in Figure 9.14 shows sequences that exhibit trend-like behaviors.
As noted earlier, unlike control charts, run charts don’t allow us to pinpoint special
cause variation to a particular sample number.

9.4 Out-of-control action plan (OCAP)

Once we have improved and stabilized the process, we move to the Control period of
DMAIC, where we implement phase II control charts to monitor small-shifts in process.
But, no process stays stable forever. Over time, out-of-control behaviors will arise again,
even when our improvement safeguards remain in place. We must not only be able to
monitor and detect new out-of-control behaviors but also must have a plan of action to
address any rising new problems and false-alarms. We refer to such a plan as OCAP
and implement it during the Control period of DMAIC. We typically organize an OCAP
document as a flow chart with two primary components: checkpoints, which are deci-
sion nodes for detecting special cause variation, and terminators, which are plausible
corrective actions [43]. We illustrate with a generic example in Figure 9.15.

Example 9.9 (OCAP)
You are a member of a quality team at Central City Hospital. This hospital has
just finished improving the order entry process using a computerized order entry
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(CPOE) system. Your team is now working on the control phase of DMAIC by writ-
ing an OCAP document for monitoring the daily mean response of orders in the
process. Your final document is shown in Figure 9.15. The owner of the new pro-
cess will use this document to detect and attempt to correct out-of-control behaviors
in the 𝐼𝑚𝑅 chart.

Figure 9.15: A generic OCAP document about a CPOE process at Central City
Hospital

Out-of-control
Plan

After fixing any out-of-control issue, reset the control chart

A point 
outside of the control  

limits?

Average time: Check with IT to see if any CPOE system issues such as 
updates and tickets have been logged. Work with IT to fix the issues. 

Range time: Check to see if there are new users in the system. Work with 
clinical managers to provide appropriate training.

Trend or 
zig-zag 

Behavior in Shewhart 
charts

Trend: Check to see if there were recent changes in the clinical ordering 
protocols or policies. Also, check for recent changes in admissions.

Other  
types of assignable 

causes?

Zig-zag: Check to see if there were different types of providers possibly 
requiring different sets of orders.

Check for possible data entry errors. Edit and fix any issues. Provide 
training to new users and/or work with IT or the vendor to fix any data or 
reset the system to optimal settings.

Do
assignable 

causes 
persist?

Contact the quality improvement team

Shift: check to see if the process has consistently drifted away from the 
original target. Go back to the sample when the process started to drift 
away from the target and verify any changes in clinical protocols or 
system settings.

No

No

No

No

Yes

Yes

Yes

Yes

9.5 Dashboards

Besides the OCAP document, we also must have a mechanism for visualizing the process
performance. One of the tools that apply for this purpose is a dashboard. The latter is a
collection of data visualization tools that we assemble to display a few key indicators of
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the process graphically. When selecting visuals to put on a dashboard, we must ensure
that the intended audience can interpret the presented information. Depending on the
software we use, we should also give the owner an option to drill down the data to gain
insights into the performance at the basic unit of the process [60]. We show an example
of a dashboard in Box 9.4. All graphics shown there can easily be created using Excel or
specialized software such as Minitab or QIMacros [54].

Box 9.4 An informatics process, Central City Hospital, January 2019

(a) Quality issue by source: Jan 2019 (b) Quality issue by type: Jan, 2019
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(c) Monthly control chart of the weighted number of IT events up to Jan 2019
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9.6 Transitioning the process back to the owner

If we were an outside team working on the quality improvement project, we would have
to hand the process back to the owner during the Control phase of DMAIC. As part of
the transition, the owner must agree to the OCAP of the new process [24]. Furthermore,
we must create a report for the owner detailing all that we have accomplished, including
a record of any quality gains and any cost savings that we have achieved. This kind of
documentation is particularly important for executives who make decisions about funding
quality improvement projects. Finally, we must create tools (e.g., dashboards) to allow all
stakeholders to be part of monitoring the performance of the new process.
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9.7 Check Your Understanding

1. If we want to monitor the average coding time per record, what type of control charts
are we likely to use?

(a) Variable control charts

(b) Attribute control charts

2. Given individual observations, which of the following control charts are we likely to
use to monitor variability?

(a) 𝑀𝑅

(b) 𝑅

(c) 𝑆

(d) 𝑆2

3. Removing ——– results in the creation of a new process.

(a) special cause variation from an existing process

(b) common cause variation from an existing process

4. When there are at least eight consecutive points on the same side of the centerline
of a control chart, we likely have ——

(a) a shift in the process.

(b) zig-zag behaviors in the process.

(c) trend behaviors in the process.

(d) oscillation behaviors in the process.

5. 𝐴𝑅𝐿𝛼 in a stable and normally distributed process with L = 2 is about:

(a) 3

(b) 10

(c) 20

(d) 370

6. The 𝑔 chart is related to which random variable?

(a) Geometric

(b) Poisson

(c) Binomial

(d) Normal
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7. From the operating curves, we are likely to observe that as the sample size in-
creases,

(a) 𝛼 decreases

(b) 𝛽 decreases

(c) 𝛼 increases

(d) 𝛽 increases

8. How are we likely to monitor a process with variable data for individual observa-
tions?

(a) Using 𝐼𝑚𝑅 charts

(b) Using 𝑋𝑏𝑎𝑟𝑅 charts

(c) Using 𝑋𝑏𝑎𝑟𝑆 charts

(d) Using 𝑝 charts

9. The 𝐼𝑚𝑅 chart is related to which random variable?

(a) Geometric

(b) Poisson

(c) Binomial

(d) Normal

10. Your hypothesis is as follows:

𝐻0 : the process in control
𝐻1 : the process not in control

You noticed that a point fell outside of the control limits and concluded that a special
cause variation existed. Your conclusion was equivalent to:

(a) rejecting the null hypothesis.

(b) failing to reject the null hypothesis.

11. Sensitizing rules are mainly applied to detect ——

(a) large shifts in the process.

(b) small shifts in the process.

12. The person credited with introducing control charts is —–

(a) Deming.

(b) Juran.

(c) Ishikawa.
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(d) Shewhart.

13. 𝐴𝑅𝐿𝛽 is also referred to as ——

(a) in-control 𝐴𝑅𝐿.

(b) out-of-control 𝐴𝑅𝐿.

14. In a 𝑝 chart with L = 3 and �̄� = 0.5, what is the minimum number of samples to
collect to ensure that LCL >0?

(a) 7

(b) 8

(c) 9

(d) 10

15. To monitor the rate of critical alert overrides in a clinical system, we are likely to use
which of the following control charts?

(a) 𝑐

(b) 𝑔

(c) 𝑝

(d) 𝑢

16. To monitor the number of surgeries on the wrong patients in a typical hospital, we
are more likely to use which set of the following control charts?

(a) 𝑝 and 𝑛𝑝

(b) 𝑐 and 𝑢

(c) 𝑔 and ℎ

(d) 𝑥 and 𝑠

17. The 𝑐 chart is related to which random variable?

(a) Geometric

(b) Poisson

(c) Binomial

(d) Normal

18. Too many runs in a 𝑟𝑢𝑛 chart of non-metric data indicate the tendency of the pro-
cess to —–

(a) zig-zag.

(b) oscillate.

(c) cluster.
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(d) trend.

19. A trend in a 𝑟𝑢𝑛 chart is defined as —– or more points that are either increasing or
decreasing.

(a) five

(b) seven

(c) fourteen

(d) twenty-one

20. After analyzing the sequence of the differences in the metric data of a 𝑟𝑢𝑛 chart,
you found too many runs. This likely indicates the presence of —– in the process.

(a) a trend

(b) an oscillation

(c) a cluster

(d) a shift

21. You were creating a 𝑟𝑢𝑛 chart using non-metric data and found that 𝑛1 for run-ups
was 14, and 𝑛2 for run-downs was 14. What was your 𝑉 (𝑅)?

(a) 1.96

(b) 6.74

(c) 11.03

(d) 14.00

22. To detect small shifts in a process, it is recommended to use —–

(a) Shewhart control charts.

(b) time-weighted control charts.

(c) run charts.

(d) operating-characteristic curves.

23. Table 9.5 presents data about the time to administration of pain medication to emer-
gency department (ED) patients with broken bones at Metropolis Hospital. Tracking
and reporting this information is required by CMS as one of its mandated quality
measures about timely and effective care [17].

(a) Using Excel and Minitab, create a run chart

(b) Use the same dataset to create 𝐼𝑚𝑅 charts.

(c) Compare and contrast your results. What can you conclude?
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Table 9.5: Time to administration of pain medication to ED patients with broken bones at
Metropolis Hospital

Patient# Angle Patient# Angle

1 42 21 40
2 46 22 47
3 17 23 47
4 25 24 9
5 41 25 44
6 38 26 24
7 23 27 8
8 55 28 23
9 28 29 36

10 12 30 55
11 14 31 63
12 26 32 60
13 28 33 53
14 32 34 26
15 11 35 26
16 53 36 13
17 20 37 11
18 5 38 8
19 8 39 29
20 15 40 75
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24. The manager of the ED at Metropolis Hospital would like to monitor and control the
number of patients leaving without being seen (LWBS). Table 9.6 presents samples
collected on weekdays. Implement appropriate control charts to monitor the rate
and the number of LWBS. If any point falls outside of the limits, remove it, and
recreate the charts. Repeat this procedure until the process is stable.

(a) What can you conclude?

(b) How would this process perform against the LWBS target of 2.5%?

Table 9.6: Weekday samples of LWBS in the ED at Metropolis Hospital, 2018

Sample# Visits LWBS Sample# Visits LWBS

1 221 7 31 182 5
2 217 10 32 245 3
3 201 9 33 197 8
4 200 6 34 239 7
5 247 4 35 204 6
6 231 7 36 213 4
7 243 5 37 180 5
8 240 7 38 208 11
9 246 7 39 231 7

10 225 4 40 195 6
11 247 9 41 201 7
12 202 4 42 230 4
13 233 7 43 203 7
14 216 8 44 236 8
15 215 5 45 191 6
16 224 4 46 230 9
17 220 6 47 234 8
18 201 4 48 229 3
19 198 8 49 231 9
20 225 8 50 224 3
21 250 7 51 226 4
22 245 9 52 201 3
23 225 9 53 249 7
24 225 8 54 225 8
25 209 7 55 181 8
26 237 8 56 216 7
27 181 7 57 220 6
28 196 6 58 249 16
29 183 6 59 216 4
30 233 9 60 184 6

25. Table 9.7 presents the frequency of the monthly overrides of critical alerts in the
CPOE system at Metro City Hospital.

(a) Using Excel, create the corresponding run chart. What out-of-control behav-
iors can you visually detect?
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(b) Calculate run statistics and appropriate confidence intervals in Excel using
𝛼 = 0.05. What can you conclude about the hypothesis of the process being
stable? Explain.

(c) Create an appropriate control chart.

(d) Compare and contrast the results from your control chart and run charts. What
can you conclude?

Table 9.7: Critical alert overrides in the CPOE system at Metro City Hospital, 2015-2019

Month #Overrides Month #Overrides

1 42 21 40
2 46 22 47
3 17 23 47
4 25 24 9
5 41 25 44
6 38 26 24
7 23 27 8
8 55 28 23
9 28 29 36

10 12 30 55
11 14 31 63
12 26 32 60
13 28 33 53
14 32 34 26
15 11 35 26
16 53 36 13
17 20 37 11
18 5 38 8
19 8 39 29
20 15 40 75
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Table 1: Factors for Constructing Variable Control Charts

Chart for
Averages

Chart for standard deviations Chart for Ranges

Factors forControl Limits
Factors for:

Factors for CL Factors for Control LimitsCL Control Limits

𝑛
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

𝐴
2.121
1.732
1.500
1.342
1.225
1.134
1.061
1.000
0.949
0.905
0.866
0.832
0.802
0.775
0.750
0.728
0.707
0.688
0.671
0.655
0.640
0.626
0.612
0.600

𝐴2
1.880
1.023
0.729
0.577
0.483
0.419
0.373
0.337
0.308
0.285
0.266
0.249
0.235
0.223
0.212
0.203
0.194
0.187
0.180
0.173
0.167
0.162
0.157
0.153

𝐴3
2.659
1.954
1.628
1.427
1.287
1.182
1.099
1.032
0.975
0.927
0.886
0.850
0.817
0.789
0.763
0.739
0.718
0.698
0.680
0.663
0.647
0.633
0.619
0.606

𝑐4
0.7979
0.8862
0.9213
0.9400
0.9515
0.9594
0.9650
0.9693
0.9727
0.9754
0.9776
0.9794
0.9810
0.9823
0.9835
0.9845
0.9854
0.9862
0.9869
0.9876
0.9882
0.9887
0.9892
0.9896

𝐵3
0
0
0
0
0.030
0.118
0.185
0.239
0.284
0.321
0.354
0.382
0.406
0.428
0.448
0.466
0.482
0.497
0.510
0.523
0.534
0.545
0.555
0.565

𝐵4
3.267
2.568
2.266
2.089
1.970
1.882
1.815
1.761
1.716
1.679
1.646
1.618
1.594
1.572
1.552
1.534
1.518
1.503
1.490
1.477
1.466
1.455
1.445
1.435

𝐵5
0
0
0
0
0.029
0.113
0.179
0.232
0.276
0.313
0.346
0.374
0.399
0.421
0.440
0.458
0.475
0.490
0.504
0.516
0.528
0.539
0.549
0.559

𝐵6
2.606
2.276
2.088
1.964
1.874
1.806
1.751
1.707
1.669
1.637
1.610
1.585
1.563
1.544
1.526
1.511
1.496
1.483
1.470
1.459
1.448
1.438
1.429
1.420

𝑑2
1.128
1.693
2.059
2.326
2.534
2.704
2.847
2.970
3.078
3.173
3.258
3.336
3.407
3.472
3.532
3.588
3.640
3.689
3.735
3.778
3.819
3.858
3.895
3.931

1/𝑑2
0.8862
0.5908
0.4857
0.4299
0.3946
0.3698
0.3512
0.3367
0.3249
0.3152
0.3069
0.2998
0.2935
0.2880
0.2831
0.2787
0.2747
0.2711
0.2677
0.2647
0.2618
0.2592
0.2567
0.2544

𝑑3
0.852
0.888
0.879
0.864
0.848
0.833
0.819
0.807
0.797
0.787
0.778
0.770
0.763
0.756
0.750
0.744
0.738
0.733
0.728
0.724
0.719
0.715
0.712
0.708

𝐷1
0
0
0
0
0
0.206
0.389
0.548
0.688
0.813
0.924
1.026
1.119
1.204
1.283
1.357
1.425
1.490
1.550
1.607
1.661
1.712
1.761
1.807

𝐷2
3.686
4.357
4.697
4.918
5.078
5.203
5.306
5.392
5.467
5.533
5.593
5.646
5.695
5.739
5.781
5.819
5.855
5.888
5.920
5.950
5.978
6.004
6.030
6.055

𝐷3
0
0
0
0
0
0.076
0.137
0.184
0.223
0.256
0.284
0.307
0.328
0.347
0.363
0.378
0.392
0.404
0.415
0.425
0.435
0.444
0.452
0.460

𝐷4
3.266
2.574
2.281
2.114
2.003
1.924
1.863
1.816
1.777
1.744
1.716
1.693
1.672
1.653
1.637
1.622
1.608
1.596
1.585
1.575
1.565
1.556
1.548
1.540

For 𝑛 > 25:

𝐴 =
3
√
𝑛

𝑐4 ≈
4(𝑛− 1)
4𝑛− 3

𝐴3 =
𝐴
𝑐4

𝐵3 = 1− 3

𝑐4
√︀
2(𝑛− 1)

𝐵4 = 1+
3

𝑐4
√︀
2(𝑛− 1)

𝐵5 = 𝑐4 −
3

2(𝑛− 1)

𝐵6 = 𝑐4 +
3

2(𝑛− 1)

For 𝑛 ≤ 25 see Table 1.
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